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1.0  Introduction

The main function of the remote access maintenance position (RAMP) is to perform
maintenance on other Traffic Operator Position System Intelligent Workstation Subsy
(TOPS IWS) positions to which it is connected. The RAMP functionality is intended 
use by operating company personnel at customer sites and Nortel Networks person
who provide support for IWS operations.

The user is assumed to have basic knowledge of DOS and Microsoft Windows. In gen
information about other vendors’ tools is not duplicated in this document.

1.1  RAMP tools

The RAMP provides access to the tools listed below:

• Dial-up networking: A RAMP can dial in and connect to an on-ring RAMP eve
though it is not on the same network with a Microsoft Windows XP Profession
dial-up networking GUI.

• Trace: A RAMP can monitor activities of an IWS position and the applications
running on it, remotely.

• Logs: The user can access log information on previous or current problems
occurring on IWS positions.

• Profile: A RAMP can provide access to the profile tool for detailed information
each IWS position on the LAN and information on RAMP-compliant software
applications running on the position.

• Print screen capture: The operator can capture and print screen displays of c
processing.

• Manual file transfer: The user can transfer files between the RAMP and the o
IWS positions using Windows Explorer.

• Software distribution (SWD): The user can distribute IWS software and datafi
files between the RAMP and other IWS positions

• Schedule manager: The user can set up software distributions to occur at late
specified times.

• Access to SWD script editor: The user can create and edit IWS software
distribution script files to use with the software distribution tool

• Access to the provisioning tool: The user can create and edit datafill for IWS
positions. The datafill can be .INI files, table (.TBL) files and language (.LNG)
files.

• Access to KeyBind: The user can assign a specific action to a specific key at 
IWS position. KeyBind can also be used to validate keyboard datafill.

• Reboot: The user can reboot other IWS positions from the RAMP

1.2  RAMP configurations

A RAMP can be configured to perform solely as a maintenance position, or as both 
general operator position and a maintenance position. A RAMP can be part of an IW
cluster, or it can perform maintenance from a remote site. In any case, each RAMP 
DMS-100 Family TOPS IWS RAMP and Provisioning User’s Guide  IWS 17.1



16

sition

d a
t to an
installed with IWS base software and is able to act as the dedicated maintenance po
of an IWS cluster.

1.2.1  On-ring RAMP

In Figure 1, the RAMP is a part of the IWS cluster. In this configuration, the RAMP is
generally referred to as on-ring.

FIGURE 1. On-ring RAMP

1.2.2  Standalone RAMP

In Figure 2, a RAMP is shown that is not a part of the IWS cluster. This RAMP, calle
standalone RAMP, uses a switch/modem bank and a dedicated phone line to connec
on-ring RAMP. The on-ring RAMP is shown connected to options such as a printer.

FIGURE 2. Standalone RAMP
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1.2.3  RAMP controlling a remote LAN

In Figure 3, the RAMP is attached to a remote cluster through a commercial router
network. The IWS base software is not active on this RAMP, which is referred to as 
ring.

FIGURE 3. RAMP controlling a remote LAN

1.3  Accessing the RAMP display

While another IWS application is running, you can access the RAMP window by pres
Alt +Tab.

You can enable theAlt +Tab key combination on an IWS position by setting an
environmental variable called alttab to 1.

To other routers
or LANs

TCP/IP

TCP/IP

TCP/IP

Router

off-ring RAMP
(No IWS base
software running)

on-ring RAMP
(IWS base
software running)

Ethernet hub

Ethernet hub

IWS positions on
an ethernet LAN

IWS positions on
an ethernet LAN
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Refer to Chapter 5 of theTOPS IWS Base Platform User’s Guide, 297-2251-010, for
information on enabling the Alt +Tab key combination.

If you are configuring a RAMP to control a remote IWS cluster, you must deactivate 
IWS base software on that position. Use the following steps:

1. Reboot the position.

2. Press and hold theCtrl  key as the position boots, so it will display the Windows
XP Professional desktop.

3. Select the Start button.

4. From the Start menu, select Program, TOPS IWS, and then RAMP.

1.4  Use of TOPS IWS keyboard

The following sections describes basic keystrokes and menus for accomplishing tas
the RAMP, SWD editor, provisioning, and KeyBind utility tools.

The following conventions are used:

• A plus sign (+) between key names indicates that the keys are pressed
simultaneously (for example,Alt +Esc).

• A comma (,) between two key names indicates that the keys are pressed
sequentially (for example,Alt , space bar means pressAlt , then press the space
bar).

For location of keys on the PC keyboard, see Figure 4. For detailed information on
keystrokes, refer to supporting Microsoft documentation.

FIGURE 4. Sample layout for PC keyboard
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1.5  Using the mouse

Some users of the RAMP may find it helpful to set up a mouse to help carry out
maintenance tasks.

If you do use a mouse, you may experience an occasional loss of focus. Clicking the
mouse in certain areas causes the active window to gray out and lose focus. If focus i
Softkeys do not respond, and any keyboard keystrokes associated with the window m
inactivated. To regain focus, move the cursor over the window where you were work
and click the mouse. You should also be aware that it is possible to use the mouse t
and paste.
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2.0  RAMP
The following sections describe the tools and functions that can be accessed by sel
one of the RAMP menu options.

2.1  File menu
The File menu provides options to open a file and exit the RAMP application. If you 
working with a standalone RAMP (an IWS position that is configured as a RAMP an
not running IWS base), you can also connect to another RAMP or a local or remote
network.

2.1.1  RAMP-to-RAMP connections

A RAMP on one IWS position cluster can be connected to a RAMP on another clust
exercise control over it and perform maintenance. To establish this connection, the
controlling RAMP must know the IP address or host name of the other RAMP. Once
connected, the following happens at the controlled RAMP.

• A message displays to indicate it is controlled by a remote RAMP.
• The controlled RAMP sends information about its IWS position cluster layout

defined by the MPXNET.INI file) to the controlling RAMP. This information an
the site name of the other RAMP display at the controlling RAMP.

• Menu options are not available, and enabled tracing stops.
• Profiling activity halts and all profiling windows disappear from the screen. Lo

are still received and stored.

When maintenance is complete, the RAMPs can be disconnected by closing the sta
window at the controlling RAMP. Another connection to another RAMP can be made

To establish a connection between a standalone RAMP and another RAMP, do the
following steps.

1. From the menu bar on the standalone RAMP, select File and Connections to
display the IWS Site Connections dialog box. (See Figure 5.)
DMS-100 Family TOPS IWS RAMP and Provisioning User’s Guide  IWS 17.1
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FIGURE 5. WS Site Connections dialog box

2. Select a site from the list in the dialog box, then select Connect. To add a site
section 2.1.1.1.

Once a connection to the target site is established, the LAN Status window
displays to show the current status of the LAN at the target site. Remote
maintenance can then be performed on any position at the target site.

3. To close the connection, select Close.

2.1.1.1  Use of IWS Site Connections dialog box command buttons

In addition to the Connect and Close command buttons, you can select Remove, Mo
and Add in the Site Connections dialog box.

Remove Select Remove to delete the highlighted site connection definition f
the list. You are prompted for confirmation before the removal.

If you try to remove a site that has a scheduled task in progress, a
message box displays to indicate that removal is not allowed. If the
has a pending scheduled task, a message box displays so that you
choose to cancel or proceed with the removal.

Modify Select Modify to edit the highlighted site connection definition.

If you try to modify a site that has a scheduled task in progress, a
message box displays to indicate that modification is not allowed. If
site has a pending scheduled task, a message box displays so tha
must choose to cancel or proceed with the modification.

Add Select Add to create a new site connection definition.

In the IWS Site Name field, enter a site name. The name can be up
20 alphanumeric characters. The text in this field displays in the IW
Site List when the definition is applied.

Enter an IP address in the IP Address field.
297-2251-015 Standard 14.04 February 2004
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You can also enter a dial-up connection name for the site in the Dial
Networking Connection Name field. The default name, DIRECT
CONNECT, does not make a site connection.

When the dialog box expands to show the additional section to add or modify site
connections, only Close, Apply, and Cancel are enabled.

2.1.2  RAMP standalone dial-up connection

The RAMP dial-up connection enables a PC equipped with Windows XP Professiona
configured as a standalone RAMP to dial in to an on-ring RAMP and perform
maintenance to the LAN where the on-ring RAMP resides. All the functionalities of a
off-ring RAMP are supported when a standalone RAMP is used. Refer to section “Dia
networking tool” on page 31 for a discussion of dial-up networking.

2.1.3  Modify or add a connection definition

To modify or add a connection definition, do the following steps.

1. From the RAMP menu bar, select File and Connections to display the IWS S
Connections dialog box. (See Figure 5 on page 22.)

2. Select Add or Modify to display the expanded IWS Site Connections dialog b

3. Select the IWS Site Name field and enter a site name.

The name can be up to 20 alphanumeric characters. The text in this field disp
in the IWS Site List when the definition is applied.

4. Select the IP Address field and enter an IP address.

The format for an IP address is nnn.nnn.nnn.nnn where “nnn” is a 1–3 digit
number; for example, 76.802.5.23.

5. Optionally, select the Dial-up Networking Connection Name box and choose 
dial-up connection name for the site. The default name, DIRECT CONNECT, d
not make a site connection.

Note: Multiple sites can be associated with the same connection name.

6. Select Apply.

The following occur:

• For a new site definition, the site name is added to the IWS site list.

• For a modified site connection definition, the modified information is upda
according to your entries.

• If an entry is made in the Dial-up Networking Connection Name box, a
connection to an on-ring RAMP is made.

If the site name or IP address are not specified or incorrectly specified, an err
window displays.
DMS-100 Family TOPS IWS RAMP and Provisioning User’s Guide  IWS 17.1
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Alternatively, you can select Cancel to close the dialog box without adding or modify
site connections.

2.1.4  RAMP-to-RAMP connection failures

When a connection failure occurs between RAMPs, error messages such as those s
below display momentarily in the connection field in the status bar:

• “Remote RAMP is not responding!”

The following are troubleshooting suggestions when the remote RAMP does 
respond:

— IP address is incorrect

— the routers are not powered up

— there are other network problems

• “Remote RAMP is in maintenance state”

— When the target RAMP is in the process of file transfer, the RAMP does n
return the status of its local configuration and a connection cannot be ma

• “Remote RAMP is not an On-Ring RAMP”

— The target RAMP must be an on-ring RAMP.

2.1.5  RAMP-to-RAMP disconnect

To disconnect one RAMP from another, close the LAN status window by selecting F
from the menu bar, and Close from the drop-down list.

2.2  Tools menu
RAMP tools are accessible through the tools menu as shown in Figure 6. RAMP tool
described in detail in the following chapters.

FIGURE 6. Tools menu
297-2251-015 Standard 14.04 February 2004
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2.3  Options menu
Use the Options menu to configure the RAMP for detail level of status messages and
interval. (See Figure 7.)

The RAMP obtains the status of the LAN by pinging (calling) the other positions. Wh
ping is set to Off (the default), the RAMP cannot obtain information from any position
and tracing, profiling, and file transfer functionalities are disabled. You can set the pi
interval to determine the frequency at which the LAN status window is refreshed.

FIGURE 7. Options menu with RAMP Configuration chosen

When the Logs window is opened (from the Tools menu), a second choice becomes
available in the Options menu drop-down box. You can toggle a Sound option on or 
with the space bar. (See Figure 8.) When sound is toggled On, you will hear a beep
the RAMP receives a log.

FIGURE 8. Options menu with sound toggled on
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2.4  Window menu
The window menu is used in conjunction with observation windows. It contains a list
options followed by listings of active observation windows.

FIGURE 9. Window menu

The options shown vary according to which observation window is active. In Figure 9
page 26, the open observation windows are LAN status, logs, and trace. The checkm
preceding the trace window listing indicates that this window is currently active.

The following options are found in the window menu:

• The Output to Window option displays any new messages that arrive in an ac
observation window. This option is not used when the LAN status window is
active.

• The Refresh Window option refreshes the display of an active observation win
with any new messages that arrive while the Output to Window option is off. T
option is not used when the LAN status window is active.

• The Clear option removes the contents of an active observation window from
display. This option is not used when the LAN Status window is active.

• The Close All option closes all observation windows. When an observation
window is closed, tracing is turned off automatically. Before each window is
closed, you are prompted to save the contents.
297-2251-015 Standard 14.04 February 2004
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2.4.1  LAN Status window

FIGURE 10. LAN Status window

The LAN Status window has a control menu box, a title bar, and a minimize button. W
minimized, the LAN Status window is reduced to an icon in the main RAMP window.
cannot be maximized. This window contains the following information.

• number of clusters on the LAN
• a graphical display of positions on the LAN. This display shows:

— position types (general, gateway, RAMP)

— status of each position (RES, not RES, not communicating)

— position IDs

The following section explains position types, status, and IDs in more detail.

2.4.1.1  Position type, status, and ID

Following are enlarged graphical displays of IWS position type, status, and ID as they
displayed in the LAN status window.
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FIGURE 11. Position type, status, and ID

• The three IWS position types displayed include:

— gateway–for communicating with the DMS switch. All DMS information fo
each position on the LAN is passed through the gateway positions. The
gateway position has the same capabilities as a general operator position

— RAMP–for performing maintenance on other general positions. A RAMP c
also function as a general position.

— general–a regular operator position.

• The position status information includes:

— “RES” (green dot)–indicates the position is in a reset state in the DMS swi
and is communicating with the RAMP.

— “not RES” (yellow dot)–indicates the position is not in a reset state in the DM
switch but is communicating with the RAMP.

— “not communicating” (red dot)–indicates that the position is not
communicating with the RAMP.

Note: If RAMP pinging functionality is set to Off, all position icons show a
red light and no information for position type or status displays.

• The position ID shows in the lower portion of the graphic. An example of an ID
number is D562 as shown in Figure 11. “D” indicates the position has
communication with the DMS switch. The three-digit number signifies the ID
number specified in the DMS switch for that position. The ID is also specified
file MPXNET.INI. If the position is not communicating with the DMS switch, a
“L” shows in place of a “D,” followed by a LAN position number. For example,
see position L2 in Figure 10, “LAN Status window,” on page 27.

position ID

color dot
indicates status
of position

DMS gateway graphic

RAMP graphic

general
position graphic
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2.5  RAMP status bar
The status bar, found at the bottom of the main RAMP window, consists of five fields
provide the following information. (See Figure 12.)

• connection field–When the RAMP is connected to another RAMP at another 
this field provides the name of the other site.

• capture field–If an observation window is currently being captured to a file, th
field contains the word “capture.”

• schedule field–Display in this field is in red when a schedule is in progress. It i
black when a schedule is pending. Otherwise, the field is empty.

• ping field–This field displays a moving bar as positions on the LAN respond t
RAMP ping messages. This field also contains the word “Ping” as long as ping
is on.

• log count field–This field contains the number of logs received since the RAM
application started. The log count resets to 0 when it reaches 9999 or when t
connection between a RAMP and a remote site closes.

FIGURE 12. RAMP status bar

connection field capture field
ping field

log count field

schedule field
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3.0  Dial-up networking tool

The RAMP dial-up networking tool enables a PC equipped with Windows XP
Professional and configured as a standalone RAMP to dial in to an on-ring RAMP a
perform maintenance on the LAN where the on-ring RAMP resides. All the functionali
of an off-ring RAMP are supported when a standalone RAMP is used. Follow the ste
below to create a dial-up configuration:

1. In the main RAMP window, select Tools from the menu bar.

2. Select DialUpNetworking from the drop-down list. This box shows the curren
defined dial-up networking connections. (See Figure 13.)

FIGURE 13. Dial-Up Networking display

3. Select Make New Connection, and enter a name for the site you are dialing i

Note: A name can be shared among multiple sites.

4. In the “Select a modem” box, choose your modem from the pull-down list.

5. Select Next to proceed to the next box. Enter the area code, telephone numbe
country code of the site.

6. Select Next to proceed to the final screen and select Finish to complete the cre
of the dial-up connection.

To modify an existing dial-up connection definition, select a connection in the Windo
Dial-up Networking connections dialog box, then select Properties from the File men

To remove an existing dial-up connection definition, select a connection in the Windo
Dial-up Networking connections dialog box, then select Delete from the File menu.

When you attempt to make a connection with the dial-up feature, you are prompted 
enter a user name and a password. You have the option to save these entries.

39th St. Station

Swannoa St.

Make new
connection

NRP-25 Station

College Pt.
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4.0  Tracing tool

The RAMP tracing tool is used in cases when the exact activity of a position needs t
monitored. For example, you can monitor OPP activity between a position and the D
switch, or API activity between the IWS base application and another application.

This tool can also trace messages remotely at each position. Knowledge of OPP an
messaging is required to interpret the data. Position performance can be affected whe
tool is activated.

At least one position must be communicating with the RAMP before the tracing optio
can be selected from the tools menu. Otherwise, a warning displays.

4.1  Trace Setup dialog box

The Trace Setup dialog box (see Figure 14) contains smaller boxes for selection of
available positions, available applications, and trace options.
prefigure

FIGURE 14. Trace Setup dialog box

• The Available Positions box lists:

— the positions that are communicating with the RAMP

— the DMS position ID if the position is communicating with the DMS switch

— question marks instead of DMS position ID if the position is not
communicating with the DMS switch

— the network cluster and position number in parentheses

• The Available Applications box lists the applications running on the position th
you selected in the Available Positions box.

• The Trace Options box lists what can be traced according to the position sele
in the Available Applications box and the application selected in the Available
DMS-100 Family TOPS IWS RAMP and Provisioning User’s Guide  IWS 17.1
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Applications box.

To start tracing, use the following steps.

1. Select the position you want to trace in the Available Positions box. Only one
position can be selected at a time.

2. Select the application you want to trace in the Available Applications box. On
one application can be selected at a time. For example, IWS BASE is selecte
Figure 14.

3. Select the options to be traced in the Trace Options box. More than one type
data can be traced.

4. Select OK to start tracing.

Tracing can be canceled any time by pressing theEsc key.

A trace observation window displays while tracing is in process. See Figure 15.

If you choose to trace another position or application, another trace window displays.
theCtrl,Tab  key combination to move among the windows. The windows can be res
and scrolled vertically.

While a trace observation window displays, the File menu provides standard Window
options to execute trace-related actions.

FIGURE 15. Trace file menu

While tracing is in process, it can be stopped by selecting the stop-trace option in th
Options menu. A stop-trace box displays as shown in Figure 16.

The messages available for selection in this box depend on the application specified
tracing. You can stop tracing a message by checking or unchecking the associated 

To terminate all tracing, select option Stop All Tracing on This Position.
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To exit, select Cancel or Done.

FIGURE 16. Stop Tracing box

4.2  OIA tracing

When the OIA application is selected for tracing, a message appears in the observa
window indicating that messages are being stored in a file located on the position sel
for tracing. Once this file reaches 100 Kb in size, tracing stops and the file is closed.
name of this file is shown in the RAMP observation window. (See Figure 17.) The RA
file transfer tool can be used to transfer the message file from the selected position 
RAMP.

FIGURE 17. IWS OIA application message window
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5.0  Logs tracing tool

The logs tracing tool collects all logs produced by all IWS positions on the LAN. It is us
to check previous and current problems on positions.

To turn logs tracing on, select the Logs option from the Tools menu. Logs are captur
from all positions and displayed in an observation window. (See Figure 18.) The windo
title bar indicates the type of information being displayed. You can scroll up or down,
minimize or maximize the window.

To enable the RAMP to collect logs, each position on the IWS LAN must assign the
RAMP to the correct node. This assignment is datafilled in the MPXNET.INI file, which
discussed in section 13.3, "MPXNET provisioning," on page 115.

Logs are stored in an ASCII file named MPXLOGS.DAT. This file has a maximum size
500 Kb. When the log file exceeds the maximum size, it is copied to an archive file na
MPXLOGS.ARC and a new MPXLOGS.DAT file is created. When a current log file i
archived, any existing archive file is deleted. Both the log file and the log file archive
stored in the IWS logs directory, C:\MPXLOGS.

A log has the following format:

<Alarm> <LogID> <Date> <Time> <Application>
SEQNO <AAAA:BBBB> POSID <CC:DD> Cluster <EE> IP Address <address>
Log from File: <file(Line no)>
<Log Text>

The above fields are defined as follows:

Alarm A blank field indicates an informational alarm.

An asterisk (*) indicates a minor alarm.

Two asterisks (**) indicate a major alarm that requires
action to correct the problem.

Three asterisks (***) indicate a critical alarm that
requires immediate action to correct the problem.

Three question marks (???) indicate this field is not
filled in by the application vendor.

LogID This field identifies the log. The ID can be up to eight
characters. The format YYYXXXX is used, where
YYY defines the application and XXXX is a number o
the log. For example, BAS0001 is a log created by th
IWS base application.

Date This field contains the date the log is generated. The
format YYYY MMM DD is used, where YYYY is the
year, MMM is the month, and DD is the day.

Time This field contains the time the log is generated. The
format HH:MM:SS:HS is used, where HH is the hour,
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MM is the minute, SS is the second, and HS is the
hundredth second. This field can contain question mar
(??) if the position time has not been synchronized w
the DMS switch time.

Application This field names the IWS application that created the
log.

SEQNO AAAA:BBBB This field contains the sequence number of the log. T
format AAAA:BBBB is used, where AAAA is the
sequence number of all logs created since the log
application started, and BBBB is the sequence numb
of the position that created the log.

POSIDCC:DD This field contains the position ID. The format CC:DD
is used, where CC is the position number within the
cluster (from the MPXNET.INI file) and DD is the DMS
position ID. This field can contain question marks (??)
the position has not been returned to service by the
DMS switch.

ClusterEE This field contains the cluster number found in the
MPXNET.INI file.

IP Addressaddress This field contains the IP address of the position that
created the log.

Log from file:file (Line no) This field contains the code module that creates the l
and the line number of the line in the code module.

Log Text This is the text content of the log.

FIGURE 18. Logs observation window

2000
POSID
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When the logs observation window displays, the file menu (see Figure 19) can be use
the following actions.

FIGURE 19. File menu

Open–This option opens existing text files including log files. The default logs
is MPXLOGS.DAT in the C:\MPXLOGS directory. If the file is too large for
RAMP to open, use a Windows application such as Wordpad to view the file.

Save–This option saves a log file.

Save As–This option specifies the name for a file to be saved. It is also be us

Print–This option prints the contents in the logs observation window.

Capture to File–This option is not available when a log observation window is
open since the Save option can be used to retain the log file content.

Close–This option closes an observation window.

Exit–This option terminates the RAMP application.
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6.0  Profile tool

The RAMP profile tool provides information and enables you to change certain
parameters for various applications loaded on the IWS position. To activate this tool
the following.

1. Make sure at least one position is communicating with the RAMP.

2. From the tools menu in the main RAMP window, select Profile.

The Position Profile dialog box displays. (See Figure 20.)

FIGURE 20. Position Profile dialog box

If a position is communicating with the DMS switch, the position ID displays. If
position is not communicating with the DMS switch, question marks display
instead of the ID. Network cluster and position number of a position display in
parentheses. The Profile Information area in this box shows more information
specific position.

Note: If no position is communicating with the RAMP when the profile option i
selected, a warning displays.

3. Select a position to be profiled. You can select only one position to be profiled
time.

4. Select Applications.

The Applications Profile dialog box (see Figure 21) shows a list of application
running on the position in the Available Applications box. Information about
various parameters that configure the selected application shows in the Para
Name box.
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FIGURE 21. Applications Profile dialog box

5. You can modify the value of a parameter by selecting Modify. Only paramete
with read/write attributes can be modified.

FIGURE 22. Application Parameter Modification dialog box

You can enter a new name, type, and value for the selected parameter. (See
Figure 22.) Then select Set. The new entries are passed to the selected appl
through the RAMP API.

6. You can print the parameter names, attributes, and values by selecting Print.

7. Select Close to exit the dialog box.
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7.0  Screen capture file printing tool

The screen capture file printing tool allows an operator to print screen displays captu
during call processing. Screen captures are for problem reporting purposes. (SeeTOPS
IWS Base HMI Application Guide, 297-2511-013, for information on capturing call scree
displays.)

Screen captures are saved in files in directory SCRNCAPT at the operator position.
screen capture generates a log that can be displayed in the logs observation window
RAMP. To collect screen capture files from the operator positions to a common locatio
the RAMP (the recommended location is C:\RAMP\SCRNCAPT directory), use the
RAMP File Transfer tool.

To print the screen capture files from the C:\RAMP\SCRNCAPT directory,

1. Select the PrintScreenCapture option from the RAMP tools menu to display t
Print Screen Capture dialog box. (See Figure 23.)

FIGURE 23. Print Screen Capture dialog box

2. Select the file you wish to print.

For these files, the file name format is DDHHMMSS.BMP, where DD = day, HH
hour, MM = minutes, and SS = seconds. BMP is the file extension.

08124802.bmp
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3. Select Open. A dialog box displays to show the available printers. (See Figure
Select the desired on and press the OK button. If the file you selected is not a
bitmap file, an error message displays.

Use the Windows XP Professional Add Printer wizard (found in Settings -
Printers) to define a printer for the RAMP.

FIGURE 24. Print Bitmap dialog box
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8.0  File transfer tool

The RAMP file transfer tool is used to transfer files between the RAMP and other IW
positions. Both file transfer options (manual and software distribution) are accessed
the Tools menu. (See Figure 25.)

FIGURE 25. File Transfer option

8.1  Manual file transfer

The RAMP manual file transfer uses Windows Explorer as the interface to the Windo
file manager.

8.1.1  Manual file transfer considerations

Before using the RAMP manual file transfer, note the following considerations:

• Both the RAMP and the target positions must have Windows XP Professiona
installed. Consequently, this file transfer capability is not compatible with any
release prior to IWS release 17.0.

• Installing a mouse provides the easiest way to work with manual file transfer 
the RAMP.

• The computer name of the IWS target position must match its IP address. To
determine the IP dress, go to the Start Menu, Settings, and then Network
Connections. Double click on the Local Area Connection. When this window
appears, double click on the Internet Protocol (TCP/IP).

To verify the computer name, go to the Start Menu, Settings, and then System
window. Select the Computer Name tab. In the “Full Computer name” line, m
sure the computer name uses the format nnxnnnxnnnxnnn, where “nn” is a
segment of the IP address, and “x” replaces the period (.). Thus an IWS posi
with the IP address 47.192.6.131 must have a computer name of 47x192x6x

• Files cannot be transferred unless file sharing is enabled.
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• Be alert for potential datafill issues in any file you transfer. Especially with the
mpxini.ini, mpxnet.ini, and host files, if you transfer a file containing generic
default datafill, and do not replace the default datafill with your customized
datafill, you may have problems operating IWS at the target position.

8.1.2  Implementing manual file transfer

The following section describes the steps to implement manual file transfer.

1. From the Tools menu of RAMP, select File Transfer and Manual Transfer.

The Specify Position dialog box displays. (See Figure 26.)

FIGURE 26. Specify Position dialog box

2. Use the arrow keys and spacebar to select and highlight one position to receiv
transferred files.

3. Select OK.

The RAMP communicates with the IWS base software on the target position to
up the position to handle file transfers. The RAMP verifies whether the positio
in a state to receive files. If communication with a target position fails or the tar
position is not in a state to receive files, a message displays to indicate the pro

Once file transfer communication between the RAMP and the target position 
established, two file boxes display on the RAMP screen. The left-side box cont
the files on the RAMP and the right-side box contains the files on the target
position. (See Figure 27.)

The target position displays the message “Position Maintenance: File Transfe
Progress” until the transfer is complete.

Position ???? - (0,0)
Position ???? - (0,1)
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FIGURE 27. File boxes of the RAMP and target position

4. In the RAMP file box, select the file you want to transfer and move it to the desi
location on the target position. This completes the procedure for manual file
transfer.

8.2  Software distribution

Software applications and datafill can be transferred from the RAMP to other operat
positions using the software distribution tool.

There are two types of software distribution: immediate and scheduled. An immedia
distribution transfers files at the time you implement the distribution. A scheduled
distribution transfers files at a later date or time through the schedule manager. (See
“Schedule manager” on page 71.)

Either immediate or scheduled distribution can be done

• from a local RAMP

• from a remote or standalone RAMP to one or more sites

• with multiple software distribution configuration sets
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8.2.1  Software distribution configurations

A software distribution configuration consists of a list of target positions to which a lis
files are to be transferred. A configuration is defined when you select one or more
positions, one or more script files, and one or both check options in the Files To Tra
box.

The list of target operator positions is based on the available positions at the site conn
to the RAMP. The software distribution scripts contain the files available to be transfe
to the target positions. The selection of types of files to transfer includes application
software and datafill.

Because IWS positions can have different applications loaded depending on position
or purpose, the Define Software Distribution Configurations dialog box allows multip
configurations to be specified for distribution. These configurations can be saved tog
in a software distribution configuration set. Refer to section 8.2.2 on page 50.

If it is necessary to transfer a specific set of files not already shown in an existing softw
distribution script list, custom files can be created. For example, if you want to transf
application datafill that has been pre-configured and saved in a special directory, yo
create a new script file and save it into a configuration. Refer to section 10.3, “Creat
SWD script files.”

Create a configuration by following these steps:

1. From the Tools menu in the main RAMP window, select File Transfer, then se
Software Distribution.

The Software Distribution dialog box displays the alphabetical list of software
distribution configuration sets currently saved on the RAMP. (See Figure 28.)

FIGURE 28. Software Distribution dialog box

2. From the Software Distribution dialog box, select New.
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The Define Software Distribution Configuration dialog box displays. No positio
or scripts are selected, both boxes in the Files to Transfer frame are checked
“Untitled” displays in the title bar. (See Figure 29.)

FIGURE 29. Define Software Distribution Configurations dialog box

3. In the Available Positions box, select the appropriate target positions individu
or use the Select All Positions button. If you use the Select All Positions butto
you must click in the list on the RAMP position at which you are working, to d
select it and remove it from the list of positions to which you are distributing
software.

4. In the Software Distribution Scripts list box, select the software distribution scri
you want to use. This is the point at which you must indicate whether you are
distributing software from one RAMP to another RAMP or from a RAMP to a
general operator position.

5. In the Files To Transfer box, select the types of files (Application Software,
Application Datafill, or both) to transfer.

Note: The default scripts listed in the Software Distribution Scripts box contain
both software files and datafill files, but these file types are not transferred
automatically. Your checkmarks in the Files To Transfer box control which typ
of files in the scripts are sent to the positions.

6. Select Save Config to save the configuration.

Save Config saves the configuration in system memory. You must make selec
in all the boxes (steps 3, 4, and 5) before you select Save Config. Otherwise,
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error message displays. The Save Config button can also be used to save an
existing configuration that you have modified.

When a new configuration is successfully saved, the configuration number in its sequ
displays in black in the upper left corner of the dialog box. For example, in Configura
2 of 3, 2 indicates the number of the new configuration and 3 indicates the total numb
configurations in the set. You can select Prev or Next to display other configurations in
set.

Instead of selecting New in the Software Distribution window, you can modify an exist
configuration. In this case, choose a configuration set to work with and then select O
The positions and scripts, the appropriate options in the “Files To Transfer” box, and
title of the chosen software distribution configuration display. To modify this
configuration, select New Config and follow steps 2–6. When a new configuration is
added, the configuration list is renumbered accordingly.

A software distribution configuration can be removed as follows:

1. In the Define Software Distribution Configuration dialog box, select the
configuration you want to delete by using the Prev or Next button.

2. Select Delete Config.

A dialog box displays for you to confirm the deletion. Once the deletion is
confirmed, the selected configuration is removed and the configuration list
renumbered.

8.2.2  Software distribution configuration sets

You may wish to configure the order in which applications and files are received at t
target positions, possibly to preserve site datafill or to ensure that the Windows XP
Professional operating system is installed before the position receives a software loa
IWS release 11 or later. You can ensure this order by saving the configurations you cr
into a set. Select either Save Set, Save Set As, or Close. Each selection displays a 
Configuration Set box with a field for the name of the software distribution configura
set.

If you have modified an existing set (if you selected Open in the Software Distributio
dialog box), you can select Save Set As to name the modified set. If you select Clos
message displays to ask you if you wish to save the new configuration set. You can 
Yes or No to close the Define Software Distribution Configurations box, or Cancel to k
the box open.

To remove a software distribution configuration set,

1. In the Software Distribution dialog box, select the configuration set you want 
delete.

2. Select Delete.

If the set chosen for deletion is included in a schedule, a message box displays to ind
this. A dialog box displays for you to confirm the deletion. Once the deletion is confirm
the selected configuration set is removed.
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8.2.2.1  Software distribution configuration set characteristics

A software distribution configuration set has the following characteristics:

• A software distribution configuration set may be portable from a current releas
a future one. This portability is valid if the LAN configurations and software
distribution scripts are the same in the current and future releases.

If any software distribution scripts in the set are renamed or removed, or if the
are changes in an IWS LAN configuration, the portability is no longer valid.

• When you edit or delete a configuration set, the RAMP checks whether that
particular set is scheduled for software distribution. If it is, you are prompted fo
confirmation. Transfer failure can occur under the following conditions:

— distribution scheduled for a deleted set

— invalid changes in LAN configuration

— missing configurations in a configuration set

• When a file transfer fails at a position, that position is not rebooted regardless
the rebooting choice made prior to the transfer.

• Files to be transferred to a particular position must be included in one
configuration set and not separately specified in multiple sets. When a position
a failed file transfer, the position cannot accept the transfer from the subsequ
configuration set. This is because the position is not rebooted, regardless of a
prior request to reboot it upon completion of the transfer. You can later reboo
from the RAMP by selecting the Reboot option from the Tools menu in the m
RAMP window.

• Once you have created a configuration set, you can implement immediate file
transfer. Files are transferred to the site currently connected to the RAMP. Th
true even if the site currently connected to the RAMP is different from the one t
was connected when the set was created. One configuration set can be used
more than one site as long as the sites have the same LAN configuration. Wh
you are working from an off-ring RAMP, you must first send the files to an on-ri
RAMP. From there, you can transfer them to the other positions on the ring. Y
cannot send the host file from the off-ring RAMP, because it is different for the
ring RAMP. To send files from an off-ring RAMP, you must turn off the IWS
software at that position, go to the Windows desktop, and use the RAMP
application from there (the off-ring RAMP) to connect to the other RAMP (the o
ring RAMP). After you have made contact with the on-ring RAMP, you can
initiate file transfer.

8.2.3  Managing datafill during a RAMP software transfer

When the RAMP is used to update positions with a new IWS software release, care
be taken to prevent the default IWS datafill files in the new load from overwriting the
existing customized datafill files. The default IWS datafill files are not likely to work a
given site, and they could prevent the IWS position from coming back into service af
the completion of the RAMP transfer.
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This section describes two possible methods to ensure that the proper datafill remai
when the RAMP transfer is complete. Be aware that, no matter which method you cho
some hand-management of the datafill files will be required.

8.2.3.1  Before you upgrade

Before starting to transfer files,alwaysmake backup versions of all datafill files. This is a
critical step to safeguard your datafill against any errors that might happen during th
software distribution transfer. The key files to back up are the language, table, host, 
initialization files, as well as the base platform executable, mpxbase.exe. For a deta
explanation of how to back up files, and guidelines on which files to back up, refer to
TOPS IWS Base Platform User’s Guide, 297-2251-010.

Also, as part of preparing for software distribution transfer, research the changes tha
have affected files between your old release of IWS and the new one. These change
documented release by release in the Revisions section ofTOPS IWS Base Platform
User’s Guide, 297-2251-010. Between releases, old files might have been deleted or
modified, and new files might have been added. Your decision about how to manage
datafill might be affected by the number and nature of those changes.

8.2.3.2  Updating files manually

When a datafill file that you have customized is changed by a new release, you mus
manually enter your customizations into the updated file. You can use the provisioni
tool to move your customized datafill line by line into the new version of the file. If yo
don’t make these changes, the new file will contain only the default generic datafill.

In order to update a file manually, you must have access to the old version of the file
comparison. If you chose the preserve datafill option when you upgraded the RAMP,
will have preserved the old version of the file and given it the file extension .iws. Look
this extension to determine which is the old version of the file.

You can use the provisioning tool to open both versions of the file at once, in order to
the old one as you enter the changes in the new one. You might choose instead to w
from a printout of the old file, or to load a floppy diskette containing the old file onto yo
A drive and open the file in a window beside your provisioning tool session.

If you are proficient in DOS or in Windows Notepad, you can use them to copy lines fr
one file to another. If you do this, however, you must take great care not to corrupt the
The advantage of using the provisioning tool is that it protects you against making da
errors that could cause problems with the file.

8.2.3.3  Software distribution example: method A

The default scripts listed in the Software Distribution Scripts box contain both softwa
files and datafill files, but these file types are not transferred automatically. Your
checkmarks in the Files To Transfer box control which types of files in the scripts are
to the positions.
297-2251-015 Standard 14.04 February 2004



53

, but
user

les to

ation
 are
and

 all
tially,
 files

the
ration

ition

sure
The method used in this example involves a software upgrade from IWS11 to IWS13
the same principles apply when upgrading to the current release. In this example, the
has customized many datafill files for IWS11 and wants to keep those customized fi
use in IWS13.

The user creates a configuration set containing two configurations. The first configur
includes all the application software and the default datafill files. (The default scripts
selected in the Software Distribution Scripts list box, and both Application Software 
Application Datafill are checked in the Files To Transfer box.)

The second configuration, which uses scripts written with the Script Editor, contains
the customized datafill files. Because the RAMP processes the configurations sequen
the customized datafill files in the second configuration overwrite the generic datafill
in the first configuration. After both configurations have been transferred, the target
positions may be rebooted.

Note: It is very important not to reboot the IWS positions until both configurations in 
set have been transferred. If the configurations were transferred as separate configu
sets, with the positions rebooted in between, vital identifying data in the host and
mpxnet.ini files would be lost when the generic datafill overwrote it, and the RAMP
position would no longer recognize the target IWS positions.

Table 1 lists typical IWS11 datafill files that might be on a target general operator pos
before the RAMP of new software and datafill.

TABLE 1. Before the software distribution transfer

Note that four of these files (mpxnet.ini, xkboard.tbl, posmsa.lng, and hosts) contain
customized IWS11 datafill.

For the first configuration, the Application Datafill checkbox in the Define Software
Distribution Configurations window is selected (with the checkmark displayed) to en
that all the datafill files for IWS13 are transferred.

Table 2 shows the datafill files on the target IWS position after the first configuration
transfer.

File Contents

ntoa.lng Default IWS11 datafill

mpxnet.ini Customized IWS11 datafill

xkboard.tbl Customized IWS11 datafill

posmsa.lng Customized IWS11 datafill

hosts Customized IWS11 datafill
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TABLE 2. After the first configuration transfer

For the sake of this example, note that a new file was added in IWS13 that did not ex
IWS11. (In reality, IWS13 contains no new files.)

In the second configuration, the user wants to restore the datafill customizations tha
would otherwise be lost in the four customized files (mpxnet.ini, xkboard.tbl, posmsa.
and hosts). Therefore, the customized IWS11 versions of these files are listed in the
second configuration.

The Revision section ofTOPS IWS Base Platform User’s Guide, 297-2251-010, however,
shows that the posmsa.lng file was affected by Nortel Networks changes added in IW
Therefore, using the provisioning tool, the user mustmanually apply the customizations
from the IWS11 version to the IWS13 version of the file on the RAMP. Then the new
updated IWS13 file must be included in the second configuration, instead of the old
IWS11 customized version.

In addition, the user decides to change the default values that came in the new file o
RAMP. So the second configuration must include the new file as well.

Table 3 lists the datafill files on the target IWS position after the second configuratio
transfer.

TABLE 3. After the second configuration transfer

At this point, both configurations in the configuration set have been transferred to th
target IWS positions and the resulting datafill is correct for the user’s site. Dependin
the rebooting choice the user made before file transfer began, the system may now 
the target positions.

File Contents

ntoa.lng Default IWS13 datafill

mpxnet.ini Default IWS13 datafill

xkboard.tbl Default IWS13 datafill

posmsa.lng Default IWS13 datafill

hosts Default IWS13 datafill

newfile Default IWS13 datafill -- new to IWS13

File Contents

ntoa.lng Default IWS13 datafill

mpxnet.ini Customized IWS13 datafill

xkboard.tbl Customized IWS13 datafill

posmsa.lng Customized IWS13 datafill -- IWS11 customizations added to IWS13

hosts Customized IWS13 datafill

newfile Customized IWS13 datafill -- new to IWS13
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8.2.3.4  Summary: configuring method A

1. Study section 10.0, “Software Distribution Script Editor Tool,” to learn how to
write a script. Study section 8.2.1, “Software distribution configurations,” to le
how to create software distribution configurations.

2. Check the Revisions section ofTOPS IWS Base Platform User’s Guide, 297-2251-
010, to see whether any files have changed since the last release. On the RA
manually update the new version of those files with your customized data.

3. Use the Script Editor tool to write a script listing the customized datafill files t
should be included in the second configuration. After you save your script, it w
appear in the Software Distribution Scripts list box in the Define Software
Distribution Configuration window.

4. In the Define Software Distribution Configurations window, create the first
configuration by highlighting all the relevant application software distribution
scripts in the list. Leave both the Application Software and the Application Data
boxes checked, as they are by default. This allows the default datafill to be
transferred to the position.

5. Select the New Configuration button and then create the second configuratio
highlighting your new script containing all the datafill files with customized
values. (In the example, that would include files mpxnet.ini, posmsa.lng, hosts,
newfile.) The values in these files will overwrite the default values transferred
the first configuration. Under Files To Transfer, check only the Application Data
box.

6. Transfer both configurations in the set before rebooting the positions.

8.2.3.5  Software distribution example: method B

Just as in the example for method A, this example for method B involves a software
upgrade from IWS11 to IWS13. The user has customized many datafill files for IWS
and wants to keep those customized files for use in IWS13.

As in method A, the user creates a configuration set containing two configurations. In
case, however, the first configuration containsonly the application software. The second
configuration, written using the Script Editor, contains customized versions of all the
datafill files that have been modified or added by Nortel Networks in the new softwa
releases IWS12 and IWS13.

Note: It is very important not to reboot the IWS positions until both configurations in 
set have been transferred. If any datafill files have changed between the two release
will receive an error message if you reboot before sending the new datafill files.

Table 4 lists typical IWS11 datafill files that might be on a target general operator pos
before the RAMP of new software and datafill.
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TABLE 4. Before the software distribution transfer

Note that four of these files (mpxnet.ini, xkboard.tbl, posma.lng, and hosts) contain
customized IWS11 datafill.

In the first configuration, the checkbox in the Application Datafill in the Define Softwa
Distribution Configurations window is deselected (with no checkmark displayed) to
ensure that no datafill files for the IWS13 load are transferred.

Table 5 shows the datafill files on the target IWS position after the first configuration
transfer:

TABLE 5. Before the software distribution transfer

Note that none of the file contents have changed, because no IWS13 datafill files we
transferred.

In the second configuration, the user wants to keep the datafill customizations in the
posmsa.lng file. The posmsa.lng file, however, was affected by Nortel Networks cha
added in IWS12. Therefore, the user mustmanually apply the customizations from the
IWS11 version to the IWS13 version of the file on the RAMP. Then the newly customi
IWS13 file must be included in the script for second configuration set, instead of the
IWS11 customized version.

In addition, for the sake of this example, IWS13 introduced a new file that did not exis
IWS11. (In reality, IWS13 contains no new files.) This file, too, must be sent to the ta
IWS positions. If the new file was not transferred to the IWS positions, IWS13 startu
would fail, and the positions would not be able to come back into service after the RA
transfer was complete.

Just as in the example for method A, the user decides to change the default values 
came in the new file. Therefore, the script the user writes for the second configuratio
must include both the posmsa.lng file and the new file.

Table 6 lists the datafill files on the target IWS position after the second configuratio
transfer.

File Contents

ntoa.lng Default IWS11 datafill

mpxnet.ini Customized IWS11 datafill

xkboard.tbl Customized IWS11 datafill

posmsa.lng Customized IWS11 datafill

hosts Customized IWS11 datafill

File Contents

ntoa.lng Default IWS11 datafill

mpxnet.ini Customized IWS11 datafill

xkboard.tbl Customized IWS11 datafill

posmsa.lng Customized IWS11 datafill

hosts Customized IWS11 datafill
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TABLE 6. After the second configuration transfer

At this point, both configurations in the set have been transferred to the target IWS
positions, and the resulting datafill is correct for the user’s site. Only the datafill files 
changed between IWS11 and IWS13 are included in IWS13 versions on the target
positions. The old IWS11 versions are still accurate for the files that were unchange
the new release. Depending on the rebooting choice the user made before file trans
began, the system may now reboot the target positions.

8.2.3.6  Summary: configuring method B

1. Study section 10.0, “Software Distribution Script Editor Tool,” to learn how to
write a script. Study section 8.2.1, “Software distribution configurations,” to le
how to create software distribution configurations.

2. Check the Revisions section ofTOPS IWS Base Platform User’s Guide, 297-2251-
010, to see whether any datafill files have changed or been added since the l
release. These are the files you will need to include in your script for the seco
configuration.

3. Look at the list of datafill files affected by the new release, and determine whe
any of those files are ones that you have customized. If so, manually update 
new version of the files on the RAMP with your customized data, and include
new customized versions of those files in your script. If there are new datafill 
with this release that will require customizing, you must also include the
customized version of the new files in your script.

4. Use the Script Editor tool to write a script listing the datafill files you identified
the previous step, the ones that have changed or been added in the new relea
the example, that would include the posma.lng file and the new file.) After you
save your script, it will appear in the Define Software Distribution Configuratio
window.

5. In the Define Software Distribution Configuration window, create the first
configuration by highlighting all the relevant application software files. Unchec
the Application Datafill box. This box is checked by default; unchecking it
prevents the datafill files from being overwritten. Leave the Application Softwa
box checked.

File Contents

ntoa.lng Default IWS11 datafill

mpxnet.ini Customized IWS11 datafill

xkboard.tbl Customized IWS11 datafill

posmsa.lng Customized IWS13 datafill -- IWS11 customizations added to IWS13

hosts Customized IWS11 datafill

newfile Customized IWS13 datafill -- new to IWS13
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6. Select the New Configuration button and then create the second configuratio
highlighting your new script containing all the datafill files that have changed si
the last release. With the configurations in this order, the new application files
overwrite the old ones, but the old customized datafill files will be untouched.
Under Files To Transfer, check only the Application Datafill box.

7. Transfer both configurations in the set before rebooting the positions.

8.2.4  Managing datafill upgrades using diskettes

Some companies do not use the Software Distribution Tool to upgrade datafill. If you
company’s datafill policy is to upgrade each position individually using diskettes, the
follow these steps:

1. Use the Software Distribution Tool to transferonly the application software files.
Do not transfer any datafill files.

2. Upgrade the datafill files on each position individually, using your customized
upgraded datafill files.

3. Reboot the position.

8.2.5  Software distribution configuration set transfer

Follow these steps for immediate software distribution:

1. From the Tools menu in the main RAMP window, select File Transfer and
Software Distribution.

The Software Distribution dialog box displays.

2. Select the configuration set you wish to transfer, and select Open.

The Define Software Distribution Configuration dialog box displays.

3. Select Transfer.

You are asked if you wish to capture the results to a file. If you select Yes, a S
As dialog box appears, where you can specify a directory and filename. After
specify a filename, you are asked if you want to reboot the target positions
following the transfer. If you answered No at the file-saving prompt, you will s
the reboot box now.

When you answer Yes or No to the reboot, file transfer begins. The RAMP
software distribution window displays. (See section 8.2.5.1, below.)

When file transfer is complete and you are closing the window, you will be giv
another opportunity to save the file transfer information to a file. If you answe
Yes, you will get the dialog box where you can specify a directory and filenam
After you save the file, or if you answer No, the window will close.
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8.2.5.1  RAMP software distribution window

The RAMP software distribution window (see Figure 30) displays information about 
software distribution in progress, including the files being transferred. Contents of th
window can be stored in a results file. (See section “Displaying a results file” on page
The status bar at the bottom of the window contains the five fields described below.

FIGURE 30. RAMP Software Distribution status window

Detail level field

This field refers to the degree of detail of the information displayed. It can be Low,
Medium, or High and can be specified in the RAMP Configuration dialog box access
from the Options menu in the main RAMP window. It can be changed during softwa
distribution. Once you change the level, all subsequent output displays at the new le
The choice of detail level affects file transfer time. The higher the level, the more tim
takes to transfer files. For example, the choice of a high detail level increases the file
transfer time up to ten times longer than the choice of low detail level.

error count field

detail level field position field

SWD script field

progress field

remote file c:\windows\OIAINI.INI

File transfer to Cluster 0 Position 9 complete.

Beginning file transfer to Cluster 0 Position 11.

Connecting to host 128.1.12.32.

Sending local file c:\ramp\install\mpxoia\mpxoia.exe to remote
file c:\mpxoia\mpxoia.exe.

Sending local file c:\ramp\install\mpxoia\oialogs.doc to remote
file c:\mpxoia\oialogs.doc.

Sending local file c:\ramp\install\mpxoia\oiaanlzr.exe to
remote file c:\mpxoia\oiaanlzr.exe.

OIASWD
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Information displayed at each level is described in Table 7.

Error count field

This field displays the number of errors that occurred during the distribution. When t
count is more than 0, the display is in red.

Position field

This field displays the cluster number and the operator position to which files are be
transferred.

Software Distribution (SWD) Script field

This field displays the name of the software distribution script file in use.

Progress field

This field displays the progress of the distribution to the current operator position. It
displays the number of files transferred, as a percentage of the total number of files 
configuration set to be transferred to the current operator position. A progress bar a
displays graphical indication of the percentage of completion.

TABLE 7. Contents in RAMP software distribution window

Detail Level Display Contents

Low (default) • beginning file transfer message with start time

• position connections and disconnections

• error messages

• software distribution process complete message with end time

Medium • beginning file transfer message with start time

• position connections and disconnections

• names of the files being transferred

• software distribution configuration set names

• source and destination file names and directories

• error messages

• software distribution process complete message with end
time

High • beginning file transfer message with start time

• position connections and disconnections

• names of the files being transferred

• software distribution configuration set names

• source and destination file names and directories

• error messages

• FTP information

• software distribution process complete message with end
time
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Other displays

When a target position is not in a state to receive files through software distribution, 
message displays in the RAMP software distribution window to indicate this.

When a software distribution is complete, the message “Software Distribution Proce
Complete” displays.

When these messages occur, you can choose to store them in the results file.

8.2.5.2  Interrupting a software distribution

While software distribution is in progress, you can interrupt the file transfer through on
the following methods:

• Select the Interrupt File Transfer option from the Options menu.

• Close the site connection on a remote RAMP. You can do this by selecting the
menu and Close from the main RAMP window. This method applies to immedi
and scheduled software distribution.

• Close the RAMP software distribution window while file transfer is in progress
This only applies to scheduled software distribution.

When any of the above methods is used, a dialog box prompts you to confirm or canc
interruption.

Note: When an interruption occurs, target operator positions are not rebooted, regar
of previous requests to reboot after file transfer.

8.2.5.3  Online help for software distribution

You can obtain online help for software distribution by accessing the Define Softwar
Distribution Configuration dialog box. Activate online help by selecting the Help button
this dialog box. Then scroll through the help text displayed to find the appropriate he
topic.
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8.3  Using the RAMP to upgrade other IWS positions

IWS positions can be upgraded from a local on-ring RAMP or from a RAMP located
another LAN. In off-ring RAMP mode, a RAMP-only PC can be used to distribute IW
software, such as NTDA application files, to another IWS position.

8.3.1  Before you begin to distribute software

Before you start the procedure for distributing software through the RAMP, you mus
decide how you will handle updating your customized files. You also need to unders
the concepts of scripts and of distribution configurations. If you choose to, you can us
RAMP’s schedule manager to set this software distribution for a later date and time.
addition, the RAMP’s script file editor can be used to create special datafill files for
distribution.

8.3.2  Software file distribution procedure

Use the following steps to upgrade target positions with a new release of IWS. (This
procedure is also documented inTOPS IWS Base Platform User’s Guide, 297-2251-010.)

1. Start the software file distribution procedure only after all customized
datafill issues have been worked out.

DO NOT start the file distribution procedure until you have
determined how you will handle your customized datafill. This
procedure assumes that the handling of customized datafill has already
been worked out. For detailed information on how to manage your

DISCLAIMER: If your company’s standard practice is to transfer
customized datafill to positions individually with a floppy diskette,
scripts will not be necessary.

customized datafill during an upgrade, refer to section 8.3.3.

STOP
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2. Ensure that the positions to be upgraded have been put into a Busy INB
state at the MP Level from the DMS switch MAP position.

It is important to busy the target positions before starting the file transfer
procedure. Failing to make the target positions Busy INB will cause alarms at
switch.

3. At the RAMP, from the IWS logo window, press the Start key.

The Operator Administration window appears.

4. In the Operator Administration window, press the Position Profile softkey.

The IWS Position Profile window appears, displaying a list of all the
applications loaded onto this position.

5. Verify that the RAMP has been loaded with the appropriate IWS 17.0
software.

Note: You cannot use a RAMP-only PC to upgrade the Windows operating
system of another IWS position. A RAMP-only PC, however, can be used in
off-ring RAMP mode to transfer IWS software, such as NTDA application file
to another IWS position.

6. Press the Quit softkey twice to return to the IWS logo window.

7. Use the Alt+Tab key combination to bring up the RAMP window.

Hold down the Alt key while pressing the Tab key as many times as necessa
reach the RAMP, then release both keys.

8. Ensure that the ping function of the RAMP is working.

Before this RAMP can be used to monitor another IWS position, the ping
function of the RAMP must be set to on. This is done by opening the RAMP
Options menu and setting the ping interval (usually at 15 seconds) in the RA
Configuration window. Follow substeps a through d to set the ping interval.

a. Press Alt+O to open the Options menu.

b. Press the C key to choose the option “Configure RAMP.”

c. When the RAMP Configuration dialog box appears, tab to the Ping Inter
box and use the arrow keys to select 15 Seconds as the ping interval.

d. Press the O key to close the RAMP Configuration dialog box.

9. Press Alt+T to open the RAMP Tools menu from the RAMP window.

10. Press the F key to open the File Transfer submenu and then the S key to
access Software Distribution from the menu.

The Software Distribution window displays, as shown in Figure 31.
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FIGURE 31. Software Distribution window

11. If the configuration set you need is listed in the Software Distribution
window, follow substeps a through c. If no configuration sets appear, or if
the configuration set you need is not listed in this window, go on to step 12.

a. Select and highlight the configuration set you will be using.

b. Press Alt+O to select the Open button. This opens the Define Software
Distribution Configurations dialog box.

c. Go to step 22.

12. If no sets are listed, or if you need to create a new set, press Alt+N to selec
New. This opens the Define Software Distribution Configurations dialog
box, shown in Figure 32.
297-2251-015 Standard 14.04 February 2004



65
FIGURE 32. Example Software Distribution Dialog Box

13. The window opens with the cursor in the Available Positions listing. Use the
arrow keys and spacebar to highlight and select the target positions
individually, or press Alt+L to select all positions, and then use the space bar
to deselect the RAMP.

[to c:\ramp] Base Application

[to c:\ramp] NTDA Application

[to c:\ramp] Billing Application (NTOA)

[to c:\ramp] OIA Application

Base Application

NTDA Application

Billing Application (NTOA)

OIA Application

Group I:

Group II:

files for transfer

files for transfer to

only to another
RAMP

any IWS position

[to c:\ramp] EISA Application

EISA Application
DMS-100 Family TOPS IWS RAMP and Provisioning User’s Guide  IWS 17.1



66

ou
es.

ng

ted
le.
en

to

ral

t

If you are working at an on-ring RAMP, and you use the Select All Positions
button, be sure to deselect the RAMP position from which you are working. Y
cannot distribute software to the position from which you are sending the fil

Note: If you used Ctrl+Alt+Del to close the Base application, instead of enabli
Alt+Tab, you will not see the RAMP listed with the other positions.

14. Press the Tab key to move to the list of software distribution scripts.

15. Use the arrow keys and the space bar to select the scripts for the
appropriate IWS 17.017.0 applications.

The list of software scripts includes preset scripts provided with the new
software release, in addition to any customized scripts that have been crea
previously at your site. The list of scripts shown in Figure 32 is only an examp
The actual content of the list always depends on which applications have be
loaded onto the RAMP.

The scripts are divided into two groups, as illustrated in Figure 32:

• Group I scripts, which are used only when sending files from one RAMP 
another RAMP. The titles of these scripts include the path name for their
RAMP destination.

• Group II scripts, which are used when sending files to all positions, gene
operator positions as well as RAMPs.

The contents of both groups of files are essentially the same, but their targe
destinations differ.
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16. Tab to the Files To Transfer option box (in the lower left corner of the
window, as shown in Figure 32) and select the types of files to transfer.

Regardless of which scripts are selected for transfer (from Group I, Group I
both), it is important to note that the Files To Transfer option box can be set u
transfer

• only application software

• only application datafill

• both application software and datafill

This transfer option determines how the datafill of a target position will be
affected by an upgrade.

WARNING: If you have a manual process for transferring datafill, select
only application software in the Files to Transfer option box. Do not select
application datafill.

In this case, upgrading the positions requires three tasks:

1. Use the Software Distribution Tool to transfer only the application softwa

2. Use a diskette to update the datafill manually.

3. Reboot the positions.

Remember that there is more than one way to handle the datafill of a target
position, to allow you to maintain datafill that has been customized or to
implement datafill revisions required by a new IWS release. All decisions ab
upgrading customized datafill should already have been made at this point,
explained in step 1 of this procedure. For detailed information on managing
datafill during a RAMP software transfer, refer to section 8.2.3.

17. If you are creating more than one configuration in the configuration set,
press Alt+S to save the configuration. Otherwise, go on to the next step.

At this point, you may create an additional configuration to include in this
configuration set, or you may choose to have only one configuration in the s
To create a second configuration, press Alt+N for a new configuration, and
repeat steps 9 through 17.

When you are ready to save your configuration set, go to the next step.

18. Press Alt+C to close the Define Software Distribution Configurations
window.

In response, the RAMP Software Distribution dialog box displays. If you hav
not already saved the configuration, it prompts you to save it now with the
question, “Save the changes?” Press Y to answer YES.

Next, the RAMP Software Distribution dialog box prompts you to save the
configurationsetwith the question, “Save the changes?” Press Y to answer Y
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Note: If you pressed Alt+S to save each individual configuration as you crea
it, the RAMP Software Distribution dialog box will prompt you only once, to
save the configuration set.

19. When you answer YES, the Save Configuration Set dialog box prompts you
to enter a text string describing the configuration set. Give your new
configuration set a descriptive name, and press Alt+O for OK.

This saves the configuration set under the name you have entered and clos
Save Configuration Set dialog box. The descriptive name appears in the Soft
Distribution window.

20. Press Alt+C to close the Define Software Distribution Configurations dialog
box.

21. Back in the Software Distribution window, use the arrow keys and the space
bar to highlight the configuration set you have created.

22. Press Alt+O to open the configuration.

23. Press Alt+T to transfer the configuration. When the question “Capturing
results to file?” appears, answer YES or NO, depending on whether you
want to keep a file with the results.

24. When the question “Rebooting after completion?” appears, stop and read
this step carefully before you answer it.

Before you answer the question “Rebooting after completion?,” consider

If you are upgrading from IWS 17.0, you are about to transfer

o IWS 17.0 software
o Customized datafill files (See Step 16 for specifics.)

If this is not the case, do not answer this question. Stop and call your
next level of support.

how you are handling the update of your customized datafill files. Keep
the following points in mind:

STOP

If you have chosen to use a manual datafill process, apply your datafill
at this point.
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Note:The upgraded version of software does not take effect on the target
positions until the positions are rebooted. In cases when it would be useful 
delay when the upgrade took effect, you might choose to distribute the files
not reboot the positions until later when you were ready.

25. After you have rebooted the target positions, return them to service (RTS) at
the MP Level from the DMS switch MAP position.

26. This completes the installation of IWS software onto the target IWS
positions. At this point you may go to the separate patch installation
procedure, which is covered inTOPS IWS Base Platform User’s Guide, 297-
2251-010.

8.3.3  What Happens During File Transfer

When you press Alt+T (in step 22), the software begins to be distributed. After they
receive the software, the target positions gather existing network parameters and be
upgrading. At each position, the upgrade is automatically driven by a scripting file.
Several information screens appear during this operation, and the following automat
actions occur:

• Files from the IWS disks or the IWS CD are copied to a targeted position. These 
are used to perform the upgrade.

• Existing network values (IP address, subnet mask, and database gateway IP add
are extracted for use under Windows XP Professional.

When a file transfer is initiated, the following events occur:

• The RAMP sends a message informing the target position of a pending file transf

• If the target position is not in a state to receive a file transfer, a message is displa
the RAMP to indicate this. If there is another target position, file transfer starts with
position.Remember to go back later to the position that was skipped. The RAMP
software distribution tool does not automatically return to that position to attempt 
transfer again.

• When a file transfer is in progress, a message is displayed at the target position t
cate this. Also, an unsolicited BSY is sent to the DMS switch.

• For security reasons, the FTP server application is terminated after each file trans

• When all file transfers are completed to a target, the RAMP sends a message to 
get position to indicate this.

• If a target position is to be rebooted, the RAMP sends a message to do so. If the tar
not rebooted, the FTP server application ends, and an RTS message is sent to the
switch to return the IWS position to service.
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9.0  Schedule manager

Use the schedule manager option to schedule software distribution for a later date a
time. This option is available from the Tools menu in the main RAMP window on a lo
or remote RAMP connected or unconnected to an IWS LAN. The schedule manage
displays the following data:

• name of the schedule

• schedule dates and times

• brief status

— pending (schedule is queued for execution)

— in-progress (schedule is in the process of being executed)

— pre-empted (schedule prioritized for execution before the other schedules

— interrupted (schedule execution is canceled)

— unexecutable (unable to execute the schedule)

— successful (schedule successfully executed)

— failed (schedule execution failed)

Note: All schedules, regardless of status, remain in the schedule manager until you
remove them. This is true even when the system is rebooted. In-progress schedules c
be removed. See section 9.1.3 on page 75.

The schedule manager is designed to schedule various tasks. Currently, it is availab
schedule software distribution only.

9.1  Scheduled software distribution

To operate scheduled software distribution properly, the following considerations mus
noted:

• When a scheduled distribution time arrives, a local RAMP distributes the softw
to the site to which it is connected. A remote RAMP connects and disconnect
from sites on the basis of information in the scheduled distribution configurati
sets. For the distribution to occur, it must not be already connected to a site w
distribution arrives.

• When a local RAMP is controlled by a remote RAMP, scheduled distributions
the local RAMP do not execute as the scheduled time arrives. When the RAM
are disconnected, the local RAMP executes any remaining scheduled distribut

• A scheduled distribution can still occur up to five minutes after the scheduled ti
Once the five-minute time limit passes, the schedule status is changed to pre
empted. This happens, for example, when a local RAMP controlled by a remo
RAMP is disconnected up to five minutes after the scheduled time.

• When a scheduled distribution time arrives, a RAMP must be in the same mo
(remote or local) as it was when that distribution schedule was created.
DMS-100 Family TOPS IWS RAMP and Provisioning User’s Guide  IWS 17.1



72

n.

ime

led

. It
d

nts

n in

 the
e

n the
sults

tion

ts

are

 the
• A scheduled distribution status can become unexecutable under the following
conditions:

— A remote RAMP is connected to a site when a scheduled distribution time
arrives. This is still true even though the site that the remote RAMP is
connected to is the same as the one specified in the scheduled distributio

— Another software distribution is in progress when a scheduled distribution t
arrives.

• When an operator uses a combined RAMP/operator position where a schedu
distribution is in progress, time to process a call can increase at that position.

• A RAMP is automatically disconnected from a site after a software distribution
is recommended that you not perform any RAMP functions during a schedule
software distribution. When distribution ends, disconnection can occur while a
RAMP function is being performed.

When a scheduled software distribution occurs on a remote RAMP, the following eve
take place:

• The RAMP connects with the first site specified in the schedule.

• A LAN status window displays to show this connection. (See Figure 10, “LAN
Status window” on page 27.)

• Files are transferred to the positions at this site on the basis of the informatio
the software distribution configuration sets.

• The RAMP Software Distribution window displays the progress and results of
transfer. (See Figure 30, “RAMP Software Distribution status window” on pag
59.)

• Results of the file transfer are stored in a results file.

• The above events are repeated for each site designated for the distribution. I
results file, the results of each subsequent file transfer are appended to the re
of the transfer just completed. When file transfer is completed at the last posi
listed in the configuration set, the RAMP is disconnected from the site of that
position. The LAN status window, logs window, and the RAMP Software
Distribution window are closed.

When a scheduled software distribution occurs on a local RAMP, the following even
take place:

• Files are transferred to the positions on the basis of the information in the softw
distribution configuration sets.

• The RAMP Software Distribution window displays the progress and results of
transfer.

• When the distribution is completed, the RAMP Software Distribution window
remains on display.
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9.1.1  Adding a schedule

A schedule can be added as follows:

1. From the Tools menu in the main RAMP window, select Schedule Manager.

The Schedule Manager dialog box displays. (See Figure 33.) It contains
chronological listings of schedules on the RAMP. The command buttons are
enabled or disabled according to the status of the selected schedule.

FIGURE 33. Schedule Manager dialog box

2. Select Add.

The Add Scheduled Software Distribution dialog box displays. For a remote
RAMP, the dialog box also contains IWS site listings. (See Figure 34.)
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FIGURE 34. Add Scheduled Software Distribution dialog box

3. Type a name in the Schedule Name field.

The name can be up to 30 alphanumeric characters.

4. Select one or more configuration sets in the Configuration Sets list box.

For a remote RAMP, also select one or more desired sites from the Sites list 

5. Select month, day, year, hour, minutes, and AM or PM for hour.

The hour and minutes are concurrent with the local time zone and reflect the 
system clock time. The year selection can be the current or the following yea

Note: Dates and times used by another schedule or earlier than the current dat
time cannot be selected.

6. Optionally, select the checkbox for “Reboot positions after transfer.”

If the files being transferred are system files, you must choose to reboot the sy
to activate these files.

7. Select OK.

A message box displays to prompt you for a results file name.

Optionally, select Cancel to exit from adding a schedule.

Local RAMP Remote RAMP connected to a site

IWS Sites

Chatham OSC RAMP
Croswell
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8. Select OK from the message box.

A dialog box titled “Save As” displays for you to enter a file name.

9. Type a file name and path.

10. Select OK.

If the results file name is used for another schedule, a message box displays
indicate this. Otherwise, the Schedule Manager dialog box displays.

11. Optionally, select Close to exit from the Schedule Manager dialog box.

9.1.2  Editing a schedule

A schedule can be edited as follows:

1. From the Tools menu of the RAMP, select Schedule Manager.

The Schedule Manager dialog box displays.

2. Select a schedule.

3. Select Edit.

The Edit Scheduled Software Distribution dialog box displays. All settings in t
box are based on the information of the selected schedule. (See Figure 35.)

FIGURE 35. Edit Scheduled Software Distribution dialog box

4. Make changes accordingly in the dialog box.

5. Select OK to save the changes. Alternatively, select Cancel to quit editing the
schedule.

The Schedule Manager dialog box displays.

6. Optionally, select Close to exit from the schedule manager.

9.1.3  Removing a schedule

A schedule can be removed as follows:

1. From the Tools menu of the RAMP, select Schedule Manager.
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The Schedule Manager dialog box displays.

2. Select a schedule.

3. Select Delete.

A dialog box displays to prompt you for confirmation.

4. Select “yes.”

5. Optionally, select Close to exit from the dialog box.

9.1.4  Displaying a results file

A results file can be displayed with the following steps:

1. From the Tools menu of the RAMP, select Schedule Manager.

The Schedule Manager dialog box displays.

2. Select a schedule.

3. Select Detailed Results.

A RAMP observation window displays the contents of the results file of the
selected schedule. When the size of the file exceeds the storage capacity of 
window, a message box displays to inform you of the situation. You can choos
open the file in the text editor of your choice.

9.1.5  File transfer process

When the RAMP communicates with each operator position for software distribution
computer program in the FTP server starts transferring files listed in the selected soft
distribution script. The sequence of events is as follows:

• The RAMP is connected to the target operator position.

• The RAMP parses the software distribution script.

• The file directory on the target position is changed to the one specified in the
distribution script.

• The RAMP transfers and renames system files (see section “Types of files fo
distribution,” below) by changing the last character of the file extension to an
underscore character. For example, MPXBASE.EXE is changed to
MPXBASE.EX_. These files are placed in the file directories specified in the
distribution script.

• File WININIT.INI that handles general system functions is transferred.

• The RAMP is disconnected from the target position when file transfer is comp
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10.0  Software Distribution Script Editor tool

Software distribution scripts can be predefined and supplied with a software release
Nortel Networks or created by you.

A software distribution script is a file that lists applicaton and datafill files for transfer
from the RAMP to operator positions. Each script file name has the extension “SWD”
example, DISTRIB.SWD). Some software distribution scripts are provided in availab
software loads by Nortel Networks; for example, those in the IWS Billing, OIA, and Ba
applications. You can also create your own software distribution scripts. To create a s
see section 10.3 on page 79.

The Software Distribution (SWD) Script File Editor tool is used to create software
distribution scripts that list software application and datafill files for transfer from the
RAMP to operator positions. Access the SWD Script Editor from the Tools menu in t
main RAMP window.

10.1  Software distribution script file format

Software distribution script files are text files. A script file contains the four sections
shown below. Note that NTOA has been renamed the IWS Billing application as of IW
release 13.0. To transfer IWS Billing application files, however, continue to use the
“NTOA” designation.

FIGURE 36. Sample SWD script file

[NAME]
ScriptName=IWS NTDA

[FileType]
SystemFiles=0

[Software]
File1Source=c:\ramp\install\iwsntda\ntda.exe
File1Destination=c:\iwsntda\ntda.exe
File2Source=c:\ramp\install\iwsntda\pdtls.dll
File2Destination=c:\iwsntda\
File3Source=c:\ramp\install\iwsntda\*.doc
File3Destination=c:\iwsntda\
File4Source=c:\ramp\install\iwsntda\read.me
File4Destination=c:\iwsntda\

[Datafill]
File1Source=c:\ramp\install\iwsntda\*.tbl
File1Destination=c:\mpxbase\datafill\
File2Source=c:\ramp\install\iwsntda\*.lng
File2Destination=c:\mpxbase\datafill\

First section

Fourth section

Third section

Second section
DMS-100 Family TOPS IWS RAMP and Provisioning User’s Guide  IWS 17.1



78

 of

at
cript
s.

e

The

urce
gs is
tain

, an
ource
ing in
 the

isk (*)
es

ause
ion if

types

y to
 to an
• The [Name] section contains the ScriptName entry. This entry is a description
the software application with which the transferred files are associated. The
contents of this entry also displays in the Define Software Distribution
Configurations dialog box. (See Figure 29 on page 49.)

If the ScriptName is missing, the script file is still valid.

The [FileType] section contains the SystemFiles entry. This entry is a value th
reflects the selection (System Files or Non-System Files) made in the SWD S
Editor Edit Window. (See Figure 38.) Software application files are system file
(See section  “Types of files for distribution” on page 78.) They will be becom
active on the position only when the system is rebooted.

• The [Software] section lists the application files to be transferred.

• The [Datafill] section lists the datafill files to be transferred

The software and datafill sections contain listings of the file source and destination. 
source is the location of the files (to be transferred) at the RAMP. The corresponding
destination is the location of the files (after the transfer) at the target position. Each so
file must have an associated destination file. Each pair of source and destination listin
numbered, starting with 1 and having an increment of 1. Each listing of files must con
the designated disk drives and file directories of the files.

When you use a text editor other than the SWD script file editor to create a script file
incident of missing destination can occur. When a script file is being opened and a s
file is missing a matching destination file, an error displays and the system stops read
the script file. Also, the system ignores extra destination files numbered higher than
last source file.

Because these are DOS directory and file naming conventions, you can use the aster
wild card to simplify your file list entries. For example, if you want to transfer all the fil
in a directory, enter the path and use the wild card in the standard DOS format
(c:\ramp\install\ntda\iwsntda\*.*). If you want to transfer all the template files in a
directory, enter the path and use the wild card and the template extension
(c:\ramp\install\ntda\mpxbase\tools\template\*.tpl). See Figure 38 on page 80 for
examples of the asterisk wild card used to simplify SWD scripts.

When the wild card is used, you do not need to specify the destination file names, bec
they will be the same as the source file names. You can rename files at the destinat
you specify file names different from the source file names.

10.2  Types of files for distribution

Files transferred by software distribution are either system or non-system files. File 
can be specified in the File Types box in the Software Distribution Script Editor Edit
Window. See Figure 38, “Script editor window” on page 80.

A system file is an executable or dll file. This type of file resides in the system memor
enable proper operation of software applications. When system files are transferred
operator position, the position must be rebooted to activate these files.
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A non-system file is a non-executable file that does not need to reside in the system
memory. System and non-system files are selected in the File Types box in the SWD
Script File Editor edit window.

10.3  Creating SWD script files

To create SWD script files, do the following steps.

1. Access the main RAMP window.

2. In the RAMP window, select Tools.

3. In the Tools menu, select SWD Script Editor. (See Figure 37.)

FIGURE 37. RAMP Software Distribution Script File Editor window

4. In this window, select File in the top menu bar, then select New.

The Script File Editor window displays with “Untitled” showing in the title bar.
(See Figure 38.)
DMS-100 Family TOPS IWS RAMP and Provisioning User’s Guide  IWS 17.1



80

ws
ox.

10.2
FIGURE 38. Script editor window

5. Enter a script name, up to 55 characters, in the Script Name box.

Use a common prefix in the script name for related SWD script files. This allo
related files to be displayed together in the Software Distribution Scripts list b

6. Select Software or Datafill in the Select Transfer File box.

7. Select System Files or Non-System Files in the File Types box. (See section 
on page 78.)

8. In the Transfer File List box, select Add Above. (See Figure 39.)
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FIGURE 39. Add Above dialog box

9. In the Source File box of this dialog box, enter the path and name of the source
Alternatively, select Browse to open the Browse dialog box to select the want
file.

10. In the Destination File box, enter the path and name of the destination file.
Alternatively, select Browse to open the Browse dialog box to select the want
file.

11. Select OK.

An entry of source file and destination file displays in the Transfer File List.

Optionally, you can select Cancel in the Add Above dialog box to cancel the
entries, or Reset to reset the entries to the last saved version.

12. To add more files to this list, select Add Above or Add Below and repeat the ab
steps.

13. When all wanted files are added to the list, select File from the top menu bar o
Script editor window. Then select Save or Save As to save the script file.

Alternatively, you can select Close to close the script file without saving it.

Note: The Save As option also allows you to save an existing file with another
name. The Save All option saves all files that you have opened and changed. I
ScriptName box is empty when you save the file, an error message displays.

14. Select Exit from the File menu to leave the script editor, or proceed to other
commands in the menu bar.

10.4  Editing SWD script files

To edit SWD scripts, do the following steps.

1. Access the main RAMP window.
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2. In the RAMP window, select Tools.

3. In the Tools menu, select SWD Script Editor.

4. In this window, select File in the top menu bar, then select Open. (See Figure

FIGURE 40. Open dialog box

5. Select the file to be edited. Then select OK. (See Figure 41.)

FIGURE 41. RAMP SWD Script File Editor window

6. Select the area to be changed.
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When you are in the Transfer File List area, you can select any of the listings
use the Add Above, Add Below, Delete and Change buttons to make changes t
listings.

If you select Change, the Change dialog box displays. (See Figure 42.)

FIGURE 42. Change dialog box

Note: To select multiple listings, click the mouse on the desired listing and dra
the cursor to select sequential listings. To select out of sequence, click the m
on the first listing, hold down theCtrl  key, and click each listing you want to
select.

Alternatively, you can use the arrow keys to select the first listing and hold do
theShift key while pointing the arrow key to the desired listings for multiple,
sequential selections.

7. In the File menu, select Save or Save As to save the script file.

Alternatively, you can select Close to close the script file without saving it.

8. Select Exit from the File menu to leave script editor, or proceed to other option
the menu bar.

10.5  Software Distribution Script File Editor window

The RAMP Software Distribution Script File Editor window has three drop-down men
that can be accessed while the Editor window has focus:

• File

• Edit

• Window

These menus provide Microsoft Windows functions to open, edit, and save RAMP
software distribution scripts. Note that files must be saved in the C:\RAMP\ directory w
the file extension “.swd.” This allows the software distribution tool to find the files.
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11.0  Reboot

IWS positions on the network can be rebooted from the RAMP. Choose the Reboot o
from the Tools menu to access the Specify Positions dialog box to choose one, some,
positions to be rebooted.

When the positions have been chosen, select the OK button to display the Position R
dialog box. (See Figure 43.) The Position Reboot dialog box provides one check bo
clearing trace settings at the positions being rebooted. Trace settings are sometime
established so that messages occurring during the reboot can be captured. The che
allows you to specify whether existing trace settings are to remain in effect during pos
reboot, or are to be cleared.

Note that pressing theEnter key cancels the reboot process. You must select Continu
activate the reboot process.

FIGURE 43. Position Reboot dialog box

If you attempt to reboot a position that is in an RTS state with the DMS switch, the Reb
Failure message box displays to inform you that the position is RTSed. You can then
cancel the reboot if necessary.

Reboot may be denied by a position for the following reasons.

• operator logged in

• position is a RAMP

• application active

• file transfer in progress

• position is an IWS gateway, currently controlling active positions

• unknown
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When reboot is denied, an observation window displays the following message:

*** REBOOT Denied ***
Cluster: <cluster no.>
Position: <pos no.>
DMS Pos ID: <pos id>
Reason: <reason text>

Note: If the position does not have communication with the DMS switch, the DMS Pos
will not be displayed.

If reboot is denied by several positions, a message for each position is displayed in 
observation window.
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12.0  Provisioning tool

The provisioning tool enables you to create or change the initialization (.INI), table
(.TBL), and language (.LNG) datafill files. The provisioning tool can be customized b
changing default datafill in the PROVTOOL.INI file. See “Configuring the provisionin
tool” on page 92.

Note: The provisioning tool cannot read a datafill file that exceeds the size of 250,00
characters or 3,000 lines.

12.1  Using the provisioning tool

1. In the main RAMP window, select Tools, then select Provisioning.

The IWS Provisioning Tool window displays. (See Figure 44 and section
“Provisioning tool window” on page 90.)

FIGURE 44. Provisioning tool window

2. Select File, then select New or Open from the File menu to create or change

When the New option is selected, a list of file names displays. (See Figure 45
These are names for .INI, table, and language files that you can create.
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FIGURE 45. File menu with New option selected

When you select a name, a configuration window displays for you to create th
file. The values of the parameters in these files are the default values that we
assigned for the software load that is currently in use. (See Figure 46.)

FIGURE 46. Example of an open file when New option is used

When the Open option is selected, the Open dialog box displays. (See Figure
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FIGURE 47. Example of Open dialog box

In this dialog box, select the file you want to open (for example, MPXINI.INI),
then select OK. A configuration window displays for you to modify the file. Un
you assign customized datafill to these files, the values of the parameters wil
represent the default datafill that comes with the current software load.

You can access help for each parameter by selecting the Help menu in the to
menu bar when a particular parameter is selected.

See following sections on creating and changing specific datafill files.

3. When all changes are done, select Close.

A dialog box displays to prompt you to save any changes made. (See Figure

FIGURE 48. Dialog box prompting you to save changes

4. Optionally, select Exit to close the provisioning tool main window.
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12.2  Provisioning tool window

The Provisioning Tool window has the following menus in the menu bar:

• File
• Run
• Window
• Help

12.2.1  File menu

The File menu contains the following options:

FIGURE 49. Example of File menu

New This option creates new datafill files. When it is selected, you c
access .INI, table and language files with their default values wh
you can modify. (See Figure 46 on page 88.)

Open This option opens existing datafill files for changes.

Close This option closes any open files. It prompts you to save chang
before closing.

Save This option saves changes to an open file.

Save As This option saves an existing file with another file name.

Save All This option saves changes made to all opened files.

Exit This option exits the provisioning tool. You are prompted to save
changes before exiting.
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12.2.2  Run menu

The options that display in the Run menu depend on what IWS software application
installed on the position and whether any modifications have been made to the
PROVTOOL.INI file. For example, NTDASetup is listed as an option on the Run men
after NTDA is installed on the position. For details on the PROVTOOL.INI file, see
“Configuring the provisioning tool” on page 92.

FIGURE 50. Example of Run menu

The AUDIOINI.INI option allows access to the audtool utility for datafilling the
AUDIOINI.INI file. For information on the audtool utility, refer toTOPS IWS Audio Card
Configuration and Diagnostics.

12.2.3  Window menu

The options shown in the Window menu are disabled when no files are open.

FIGURE 51. Window menu with file open

Cascade This option arranges open file windows in a cascade form.
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Arrange Icons This option arranges minimized file configuration windows alon
the bottom of the main window.

Close This option closes the selected file configuration window. You a
prompted to save the open file if it is not saved.

Close All This option closes all open file configuration windows. You are
prompted to save any files that are not saved.

The Window menu also displays the names of any open datafill files.

12.2.4  Help menu

The Help menu contains the following options.

FIGURE 52. Example of Help menu

Help This option provides access to a help text box.

About This option provides the version number of the provisioning too
which matches the current IWS software load.

You can access the Help menu from any open file window to read information about
specific file.

12.3  Configuring the provisioning tool

The provisioning tool can be customized by changing the default datafill in the
PROVTOOL.INI file. For example, this tool can be configured to open certain .INI file
automatically when it is activated. The Run menu of this tool can also be customized
include desired datafill files, including files of other vendors’ API-compliant applicatio

To customize this tool, do the following steps.
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1. Select Run in the main menu bar of the provisioning tool.
Figure 53. “Run menu with PROVTOOL.INI option.”

FIGURE 53. Run menu with PROVTOOL.INI option

2. Select PROVTOOL.INI. (See Figure 54.)

FIGURE 54. Edit window for PROVTOOL.INI file

3. In the edit window, make desired changes such as adding or removing progr
files. For example, in Figure 55, line 6 (6=&NTDASetup
c:\IWSNTDA\NTDASETP.EXE) is added to the PROVTOOL.INIl file. This line
provides access to an IWS program called NTDA Setup.
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FIGURE 55. Example of modified PROVTOOL.INI file

To have the provisioning tool open all .INI files when it is activated, delete the
semicolon (;) at the beginning of the following lines in the PROVTOOL.INI file

;Window1=MPXINI %windir%\MPXINI.INI

;Window2=MPXNET %windir%\MPXNET.INI

;Window3=MPXPARM %windir%\MPXPARM.INI

;Window5=SCRPTINI %windir%\SCRPTINI.INI

4. When you are done with changes, select File, then select Save.

5. To exit from the edit window, select File, then select Exit.

12.4  Provisioning tool error checking

The provisioning tool provides error checking when you create a datafill file or open 
existing file for modification. There are two types of error checking: full or limited. Fu
checking can be applied to a parameter that has specific boundaries; for example, a
integer with a defined range. Limited checking can be applied to a parameter such a
string whose length and alphanumeric content is checked.

Error checking prohibits many typing mistakes; for example, in the XCASTS.TBL file
the valid entries for call arrival type are integers between 1–8. If you enter any other va
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the field remains blank. Similarly, if you type a character string longer than the maxim
length, it is truncated.

When errors such as duplicate entries or out-of-range values occur in language files,
displays with the error message, “An error was encountered in <line #> of
C:\MPXBASE\DATAFILL\<filename>. ProvTool cannot continue.” You must open the
file with a text editor to repair it.
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13.0  Using the provisioning tool to datafill files

The following sections describe how to create and change datafill files of IWS
applications. These files are discussed inTOPS IWS Base Platform User’s Guide, 297-
2251-010.

13.1  MPXINI.INI provisioning

The MPXINI.INI file starts IWS applications. The file is datafilled to provide the name
and directory paths of registering and nonregistering application that run on the IWS
position. In addition the file is datafilled to set some audio card and timer parameter

1. From the top menu bar of the Provisioning Tool window, select File.

2. From the File menu, select New or Open.

If Open is selected, the Open dialog box displays. If New is selected, a list of
displays.

3. Select MPXINI. (See Figure 56.)

FIGURE 56. Example of MPXINI.INI configuration window

4. Select the desired command buttons in the configuration window. The followi
sections describe the usage of the command buttons which enable you to sp
values and settings.

5. When you are done with the command buttons and want to save the values a
settings specified, select File, then select Save.

The Save As option enables you to save the file with another name.

6. To close the configuration window, select Close from the File menu.
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A message box displays to prompt you to save before closing the window. Se
from Yes, No, and Cancel.

13.1.1  Datafill Path command button

The Datafill Path command button enables you to specify a file directory path for yo
datafill files.

1. In the configuration window, select Datafill Path. (See Figure 57.)

FIGURE 57. Select Default Datafill Directory dialog box

2. Select the desired path.

3. Select OK. Optionally, you can select Cancel to leave the dialog box without
entering or saving a path.

13.1.2  Registering command button

The Registering command button enables you to specify the registering applications
registering application is service-providing; that is, billing can be assigned. The first
application in the registering list should be the one to switch to if a call arrives at an 
position and no application is available to process the call.
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1. In the configuration window, select Register. The Registering Applications dia
box displays with the default registering application. (See Figure 58.)

FIGURE 58. Example of Registering Applications dialog box

Note:As of IWS release 13.0, the NTOA/NTOA Plus application was renamed
the IWS Billing application. Continue to select path c:\iwsntoa\ntoa to choose
IWS Billing application as the default registering application for IWS.

2. Select Assign to assign a registering application to the MPXINI file.

A dialog box displays for you to select the path name of the registering applicat
Select OK.

3. Select Remove to remove any unwanted registering applications.

4. Select View Nonregistering Applications to see what nonregistering applicatio
have been assigned. You cannot add a nonregistering application from this b
You must select the Nonregistering button shown in Figure 56 on page 97.

When done, select OK to close this dialog box.

5. Select Add Parameters to add any necessary command line parameters to a
selected application. (See Figure 59.)
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FIGURE 59. Example of Command Line Parameters dialog box

Enter a parameter, then select OK.

6. When you return to the Registering Application dialog box, you can select OK
keep the entry and close the dialog box. Alternatively, select Cancel to leave 
dialog box, or Reset to return to the previous settings. A Help button is also
available in this dialog box.

The view shown in Figure 58 on page 99 has 15 lines plus the top line. Thus you ca
16 registering applications for both the standard and extended versions of the IWS b
However, the standard version of IWS base supports five registering applications, so
if you list 16, only the first five are supported.

13.1.3  Nonregistering command button

The Nonregistering command button enables you to specify the nonregistering
applications; that is, those applications that are not service-providing.
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1. In the configuration window, select Nonregistering. (See Figure 60.)

FIGURE 60. Example of nonregistering applications dialog box for TDM positions

The Nonregistering Applications dialog box displays currently datafilled
applications that do not require registration with the IWS base application. If n
applications are datafilled, this box is blank.
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Note: If this is an IP position, theMake DMS Gatewaybutton will be grayed out
and unavailable as in Figure 61.

FIGURE 61. Example of nonregistering applications dialog box for IP positions

2. Select Assign to assign a nonregistering application to the MPXINI file.

A dialog box displays where you can select the path name of the nonregister
application. Select OK.

3. Select Remove to remove any unwanted nonregistering applications.

4. Select View Registering to view the registering applications.

5. Select Add Parameters to add command lines to a selected application.

6. Select Make DMS Gateway to add the necessary applications for the DMS
gateway automatically.

7. Select Make RAMP Position to add the necessary applications for the remote
access maintenance position automatically.

8. When all changes are made, you can select OK to keep the changes and clo
dialog box. Alternatively, select Cancel to leave the dialog box, or Reset to re
to the previous settings. A Help button is also available in this dialog box.

The view shown in Figure 60 on page 101 has 16 lines. Thus you can list 16
nonregistering applications for both the standard and extended versions of the IWS 
However, the standard version of IWS base supports five nonregistering applications
even if you list 16, only the first five are supported.
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13.1.4  Time-Outs command button

The Time-Outs command button enables you to specify server, application, and logo
time out values for operator positions.

1. In the configuration window, select Time Outs. (See Figure 62.)

FIGURE 62. Example of Time-Out Values dialog box

2. In this dialog box, specify a timeout value for server, application, and logon
respectively.

You can specify a value by typing in the number box, or by using the scroll but

If the value you specify is out of the valid range, a message box displays to a
you. You have to correct the values before you can exit the dialog box.

3. When all changes are made, select OK to keep the changes and close the d
box. Alternatively, select Cancel to leave the dialog box, or Reset to return to
previous settings. A Help button is also available in this dialog box.

13.1.5  Debug command button

The Debug command button enables you to specify options for the debugging tools a
operator positions.

1. In the configuration window, select Debug.

A message box displays to indicate that the debug settings can affect system
performance. Select OK. The Debug Options dialog box displays. (See Figure
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FIGURE 63. Example Debug Options dialog box

2. Select the desired options.

3. You can select OK to keep the settings and close the dialog box. Alternatively
select Cancel to leave the dialog box, or Reset to return to the previous setting
Help button is also available in this dialog box.

13.1.6  Audio Device command button

The Audio Device command button enables you to specify options for audio cards a
headsets at operator positions. The type of position used, TDM or IP, will determine
screens displayed when you select the Audio Device button.

13.1.6.1  TDM Audio Device command button

Upon selecting the Audio Device command button on a TDM position, the Nortel Au
Card window will appear. Follow these steps to configure the options.

1. In the configuration window, select Audio Card. (See Figure 64.)

FIGURE 64. Example of the Audio Device dialog box for TDM positions

2. Select the desired options. Detailed information about each option is provide
TOPS IWS Base Platform User’s Guide, 297-2251-010.
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3. You can select OK to keep the settings and close the dialog box. Alternatively
select Cancel to leave the dialog box, or Reset to return to the previous setting
Help button is also available in this dialog box.

13.1.6.2  IP Audio Device command button

Upon selecting the Audio Device command button on a IP position, the Plantronics
Headset window will appear. Detailed information about each option or setting is prov
in TOPS IWS Base Platform User’s Guide, 297-2251-010. Follow these steps to configur
the options.

1. In the configuration window, select theHeadset Installed in USB portcheckbox.
The default will automatically check it. (See Figure 65.)

FIGURE 65. Example of the Audio Device dialog box for IP positions

2. The Headset Volume will reset at 7, but it has a range of 1 to 12.

3. The Headset Model EQ Preset will reset at 4, but it has a range of 0 to 6.

4. The Headset Sidetone will reset at 4, but it has a range of 0 to 5.

5. You can select OK to keep the settings and close the dialog box. Alternatively
select Cancel to leave the dialog box, or Reset to return to the previous setting
Help button is also available in this dialog box.

13.2  MPXPARM provisioning

The MPXPARM.INI file is contains various IWS parameters that can be defined and u
by API-compliant applications that reside on the IWS platform.

1. From the top menu bar of the provisioning tool window, select File.

2. From the File menu, select New or Open.
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If Open is selected, the Open dialog box displays. If New is selected, a list of
displays.

3. Select MPXPARM. (See Figure 66.)

FIGURE 66. Example of the MPXPARM configuration window

4. Select the desired command buttons in the configuration window. The followi
sections describe the use of the command buttons.

5. When you are done with the command buttons and want to save the values a
settings specified, select File, then select Save.

The Save As option enables you to save the file with another name.

6. To close the configuration window, select Close from the File menu.

A message box displays to prompt you to save before closing the window. Se
from Yes, No, and Cancel.

13.2.1  Currency command button

The Currency command button enables you to specify the placement of the currenc
symbol, number of decimal digits, the type of currency symbol, and the currency
separator.
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1. In the configuration window, select Currency. (See Figure 67.)

FIGURE 67. Example of Currency dialog box

2. To select the placement for the currency symbol, select the down arrow button
a placement from the pull-down box.

3. To select the decimal digits, select the down arrow button and the number of d
you want from the pull-down box.

4. To enter the currency symbol of your choice, type the symbol in the Symbol b
Up to five characters can be entered. Any ASCII characters are accepted.

5. To enter the separator of your choice, type the separator in the Separator box.
one character can be entered. Any ASCII character is acceptable.

6. Select OK to keep the settings and close the dialog box. The settings are sav
when you select Save from the File menu in the provisioning tool window.

Alternatively, select Cancel to leave the dialog box, or Reset to return to the
previous settings. A Help button is also available in this dialog box.

13.2.2  Number Format command button

The Number Format command button enables you to specify the character to be use
separator of a directory number or calling card number.
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1. In the configuration window, select Number Format. (See Figure 68.)

FIGURE 68. Example of Number Format dialog box

2. Enter a character in the Separator box. Any ASCII character is acceptable.

3. Select OK to close the dialog box. The entry will be saved when you select S
from the File menu in the Provisioning Tool window.

Alternatively, select Cancel to close the dialog box without saving the entry. Y
can also use Reset in this dialog box to reset the entry to the previous state. A
button is also available in this box.

13.2.3  Charge Indicator command button

The Charge Indicator command button enables you to set various indicators for cha
adjust values.

1. In the configuration window, select Charge Indicator. (See Figure 69.)

FIGURE 69. Example of Charge Adjust Indicators dialog box

2. To set the indicator for minutes, enter an upper-case ASCII character in the
Minutes box.

3. To set the indicator for money, enter an upper-case ASCII character in the M
box.
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4. To set the indicator for occurrences (number of calls credited), enter an upper-
ASCII character in the Occurrences box.

5. Select OK to close the dialog box. The entries are saved when you select Sa
from the File menu in the provisioning tool window.

Alternatively, select Cancel to close the dialog box without saving the settings
Reset to return to the previous settings. A Help button is also available in this

13.2.4  Char Translate command button

For TOPS software loads earlier than TOPS13, select the Char Translate command b
if your alphabet has characters above ASCII value 127. These characters must be
translated before being sent to the DMS switch.

As of IWS release 13.0, the Character Translator section is no longer used unless th
TOPS software load in the DMS switch is earlier than TOPS13.

1. In the configuration window, select Character Translation. (See Figure 70.)

FIGURE 70. Example of Character Translation dialog box

2. Select the Translate checkbox.

3. Select OK to close the dialog box. The setting is saved when you select Save
the File menu in the Provisioning Tool window.

Alternatively, select Cancel to close the dialog box without saving the settings
Reset to return to the previous settings. A Help button is also available in this

13.2.5  Time-Outs command button

The Time-Outs command button enables you to set time-out values for the Make Bu
Withhold Calls position states.
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1. In the configuration window, select Time Outs. (See Figure 71.)

FIGURE 71. Example of Time-Out Values dialog box

2. Select the button in the scroll bar and slide it left or right to set the time-out va
in seconds.

Alternatively, select the text box on the left of the scroll bar and enter the des
integer value in seconds.

3. Select OK to close the dialog box. The setting is saved when you select Save
the File menu in the Provisioning Tool window.

Alternatively, select Cancel to close the dialog box without saving the settings
Reset to return to the previous settings. A Help button is also available in this

13.2.6  Text Flashing command button

The Text Flashing command button enables text flashing. The text flashing capabilit
works with the colorblind mode to emphasize alert and error messages, regardless 
datafill. You can activate text flashing without activating colorblind support.

1. In the configuration window, select Text Flashing. (See Figure 72.)
.

FIGURE 72. Example of Enable Text Flashing dialog box

2. Select the Enable Text Flashing checkbox.

3. Select OK to close the dialog box. The setting is saved when you select Save
the File menu in the Provisioning Tool window.

Alternatively, select Cancel to close the dialog box without saving the settings
Reset to return to the previous settings. A Help button is also available in this
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13.2.7  Colorblind Support command button

The Colorblind Support command button enables colorblind support.

1. In the configuration window, select Colorblind Support. (See Figure 73.)

FIGURE 73. Example of Enable Colorblind Support dialog box

2. Select the Enable Colorblind Support check box.

The command buttons in the Colors section are enabled. You can set the color
option on normal, alert, or error text. The text colors are specified by the indu
standard of red, green, and blue (RGB).

3. To set colorblind normal text color, select the Set Normal Text Color button. (
Figure 74.)

FIGURE 74. Set Normal Text Color dialog box

4. Select the button in each scroll bar and slide it left or right to set the value for e
color (red, green, blue). You can also enter an integer value (range 0–255) in
box next to each color.

Default datafill sets the colorblind normal text color to black, which is the
recommended color. Black is specified with the values of 0 for red, 0 for green,
0 for blue. The color of the string “Sample Normal Text Color” at the top of the
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dialog box changes to display whatever color corresponds to the current num
settings.

5. Select OK to keep the settings and close the dialog box. Alternatively, select
Cancel to leave the dialog box, or Reset to return to the previous settings. A H
button is also available in this dialog box.

6. To set alert text color, select the Set Alert Text Color button. (See Figure 75.)

FIGURE 75. Set Alert Text Color dialog box

7. Select the button in each scroll bar and slide it left or right to set the value for e
color (red, green, blue). You can also enter an integer value (range 0–255) in
box next to each color.

Default datafill sets the colorblind alert color to light-medium grey, which is th
recommended color. Do not set this value equal to the colorblind normal text c
value. Light-medium grey is specified with the values of 160 for red, 160 for gre
and 160 for blue. The color of the string “Sample Alert Text Color” at the top o
the dialog box changes to display whatever color corresponds to the current
numeric settings.

8. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the dialog box, or Reset to return to the previous settings. A Help butto
also available in this dialog box.
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9. To set Error Text Color, select the Set Error Text Color button. (See Figure 76

FIGURE 76. Set Error Text Color dialog box

10. Select the button in each scroll bar and slide it left or right to set the value for e
color (red, green, blue). You can also enter an integer value (range 0–255) in
box next to each color.

Default datafill sets the colorblind error color to light-medium grey, which is th
recommended color. Do not set this value equal to the colorblind normal text c
value. Light-medium grey is specified with the values of 160 for red, 160 for gre
and 160 for blue. The color of the string “Sample Error Text Color” at the top 
the dialog box changes to display whatever color corresponds to the current
numeric settings.

11. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the dialog box, or Reset to return to the previous settings. A Help butto
also available in this dialog box.

12. In the Enable Colorblind Support dialog box, select OK to keep the settings f
normal, alert, and error text. Alternatively, select Cancel to leave the dialog box
Reset to return to the previous settings. A Help button is also available in this
dialog box.

13.2.8  Clock and Call Timer command button

The Clock and Call Timer command button enables display of the clock and the call ti
The clock displays when an operator logs on and the call timer displays when a call
arrives.
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1. In the configuration window, select Clock and Call Timer. (See Figure 77.)

FIGURE 77. Clock and Call Timer dialog box

2. To enable the clock display, select the Clock Display check box.

3. Select the button in the scroll bar and slide it left or right to make adjustments
the time, or enter an integer value in the entry box on the left of the scroll bar

The default value is 0. The adjustment range is plus or minus 12 hours.

4. To enable the call timer display, select the Call Timer Display check box.

5. Select OK. The settings are saved when you select Save from the File menu i
Provisioning Tool window. Alternatively, select Cancel to leave the dialog box
Reset to return to the previous settings. A Help button is also available in this
dialog box.

13.2.9  Simultaneous Display of Trunk Group/SPID command button

The Trunk Group/SPID command button enables the simultaneous display of trunk g
and service provider identification (SPID).

1. In the configuration window, select Trunk Group/SPID. (See Figure 78.)

FIGURE 78. Trunk Group/SPID dialog box

2. To enable simultaneous display of trunk group and SPID, select Display both
Trunk Group and SPID.

3. In the Display Priority box, select either Trunk Group or SPID. If Trunk Group
selected, Trunk Group displays first. If SPID is selected, SPID displays first.
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4. Select OK. The settings are saved when you select Save from the File menu i
Provisioning Tool window. Alternatively, select Cancel to leave the dialog box
Reset to return to the previous settings. A Help button is also available in this
dialog box.

Note: To ensure proper working of this feature, the following guidelines apply:

• When the OPP_ALWAYS_SEND_SPID_INFO parameter (in table TOPSPAR
in the DMS switch) is set to “Yes,” you must select Display both Trunk Group a
SPID in the Simultaneous Display of Trunk Group and SPID window.

• When OPP_ALWAYS_SEND_SPID_INFO is set to “No,” do not select Displa
both Trunk Group and SPID.

13.3  MPXNET provisioning

The MPXNET.INI file contains configuration information about IWS clusters and
positions. All positions in a cluster should have the same MPXNET.INI file.

A discussion of the parameters that make up the MPXNET.INI file can be found inTOPS
IWS Base Platform User’s Guide, 297-2251-010.

13.3.1  TDM positions - MPXNET

1. From the top menu bar of the Provisioning Tool window, select File.

2. From the File menu, select New or Open.

If Open is selected, the Open dialog box displays. If New is selected, a list of
displays.

3. Select MPXNET. (See Figure 79.)

FIGURE 79. MPXNET configuration window
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4. In the PVC Layout Type box, select one of the following listings: STD4, IMUX
IMUX16, or IMUX20.

STD represents standard layout and IMUX represents increased multiplexed
layout. The STD layout supports a 4-position configuration (STD4). The IMUX
layout supports a 4, 16, or 20 position configuration (IMUX4, IMUX16,
IMUX20).

5. To check a position for its assigned cluster, select the Check Positions option i
Position In Cluster Check box.

Note: When a RAMP is not datafilled as a position assigned to a cluster, do n
select the Check Positions option.

6. To assign an on-ring RAMP, select the down arrow button at the On-ring RAM
Position box. Then select the host name of the on-ring RAMP position from th
listings displayed.

The selected on-ring RAMP position determines where logs are sent. The log
destination must be on a valid LAN, but need not be an IWS operator position
Any position (except a DMS gateway) on the LAN can be the on-ring RAMP
position if RAMP software is installed. Each cluster must have an on-ring RAM
position.
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7. To define the layout of each cluster of operator positions, select Cluster Layo
(See Figure 80.)

FIGURE 80. Example of MPXNET STD4/IMUX4 dialog box
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The cluster dialog box reflects the selection of STD4 or IMUX4 PVC layout ty
from the MPXNET dialog box. If the IMUX16 PVC layout type is selected in th
MPXNET dialog box, a cluster dialog box with a different layout displays. (Se
Figure 81.)

FIGURE 81. Example of MPXNET IMUX16 dialog box

Note: Within a LAN, positions are organized into clusters. Each cluster has one
two DMS gateways. The cluster datafill maps the IWS position/cluster definiti
to the network that addresses the scheme provided by the network TCP/IP
software. At least one position must be assigned in one cluster. Clusters mus
datafilled in order (for example, Cluster 0 must be datafilled before Cluster 1)
GWA (Gateway A) must be assigned in any cluster with assigned positions. G
(Gateway B) is optional.

In the dialog box, the Hostname box lists all host names in the
C:\WINDOWS\SYSTEM32\DRIVERS\ETC\HOSTS file.

a. To assign a position to a host name, select the radio button next to the pos
then select Assign.

b. To clear a host name from a position, select the radio button next to the
position, then select Clear. You can also select Clear All to clear the host na
assigned to all the positions.

Note: The position assignments in the Hostname box MUST MATCH the
assignments made in the C:\WINDOWS\SYSTEM32\DRIVERS\ETC\HOS
file. The HOSTS file is not available for editing with the provisioning tool.
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This file can be referred to or edited using a standard Windows editor suc
Notepad. If these assignments do not match, the positions cannot initializ

c. Select OK to close the window and keep the settings. Alternatively, select
Cancel to leave the dialog box, or Reset to return to the previous settings.

4. When you return to the MPXNET configuration window, you can save the setti
by selecting Save from the File menu in the provisioning tool window. You can
also close the window by selecting Close from the File Menu, when you will b
prompted to save the file.

13.3.2  IP Positions - MPXNET

1. From the top menu bar of the Provisioning Tool window, select File.

2. From the File menu, select New or Open.

If Open is selected, the Open dialog box displays. If New is selected, a list of
displays.

3. Select MPXNET. (See Figure 82.)

FIGURE 82. MPXNET IP configuration window

4. In the DMS section, enter a valid node name from the HOSTS file that specifies
IP address of the DMS switch with which the position is to communicate.

For the PortIn value of the DMS section, enter the UDP port number that will 
used for messaging from the DMS to the IP position.

For the PortOut value of the DMS section, enter the UDP port number that will
used for messaging from the IP position to the DMS.
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If you are using the OIA application, in the OIA section, enter a valid node na
from the HOSTS file that specifies the IP address of the OIA database with w
the position is to communicate.

For the PortIn value of the OIA section, enter the UDP port number that will b
used for messaging from the OIA database to the IP position.

For the PortOut value of the OIA section, enter the UDP port number that will
used for messaging from the IP position to the OIA database.

5. To define the layout of each cluster of operator positions, select MtcCluster
Layout. (See Figure 83.)

FIGURE 83. Example of MPXNET IP Maintenance dialog box

In the dialog box, the Hostname box lists all host names in the
C:\WINDOWS\SYSTEM32\DRIVERS\ETC\HOSTS file.

a. To assign a position to a host name, select the radio button next to the pos
then select Assign.
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b. To clear a host name from a position, select the radio button next to the
position, then select Clear. You can also select Clear All to clear the host na
assigned to all the positions.

Note: The position assignments in the Hostname box MUST MATCH the
assignments made in the C:\WINDOWS\SYSTEM32\DRIVERS\ETC\HOS
file. The HOSTS file is not available for editing with the provisioning tool.
This file can be referred to or edited using a standard Windows editor suc
Notepad. If these assignments do not match, the positions cannot initializ

c. The IPMtcSrv specifies the RAMP position that maintains this IP position.

4. When you return to the MPXNET configuration window, you can save the setti
by selecting Save from the File menu in the provisioning tool window. You can
also close the window by selecting Close from the File Menu, when you will b
prompted to save the file.

13.4  SCRPTINI provisioning

The SCRPTINI.INI file contains the following information:

• Standard versus enhanced scripting mode setting

• Scripting window size and location for each application that displays the
scripting window

• Standard scripting mode priority settings for determining which call arrival
data drives the contents of the script window

• Other miscellaneous scripting settings

To configure IWS scripting, the IWS Provisioning tool, PVTOOL.EXE, can be used a
follows:

1. From the top menu bar of the Provisioning Tool window, select File.

2. To edit a pre-existing SCRPTINI.INI file, select “Open”. A Windows “Open”
dialog box displays. Select the SCRPTINI.INI file in the C:\WINDOWS director
To create a new SCRPTINI.INI file, select “New”. A template list appears. Sel
SCRPTINI.

3. By default, parameters that relate to enhanced scripting are grayed out. (See
Figure 84.)
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FIGURE 84. SCRPTINI configuration window for standard scripting
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If the enhanced scripting check box is checked, then all the enhanced scriptin
related parameters are no longer grayed out. (See Figure 85.). Note also that
figure the user has enabled enhanced scripting’s datafill debug functionality.

FIGURE 85. SCRPTINI configuration window for enhanced scripting

4. To configure the scripting parameters that pertain to a particular application, s
the down arrow button at the Applications box to display the available
applications. Then select the appropriate application from the displayed list (f
example, NTOA or NTDA).

Note:As of IWS release 13.0, the NTOA/NTOA Plus application was renamed
IWS Billing application. In the Applications box, however, continue to select
NTOA when you wish to configure the scripting window to automatically displ
on call arrivals in the IWS Billing application.

5. Select Edit to edit the scripting settings for an existing application. (See
Figure 86.)

The Edit Application window includes a field for the name of the selected
application (up to eight characters), a box for enabling display of the scripting
window, four fields to define the X and Y coordinates, the width, and the heigh
the scripting window, and other application specific scripting settings.
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FIGURE 86. Example of the Edit Application window with NTOA (IWS Billing
application) selected

6. Select the Enable Scripting checkbox if you want automatic display of the
scripting window when the call arrives in this application.

7. In the Window Position and Size section, you can change the values for the X
Y coordinates, width, and height for the scripting window. You can either ente
value or use the up/down arrow buttons to make these changes.

8. If NTOA (IWS Billing) is the selected application, you can select the
GiveScrptFocusOnArrival option to give the scripting window focus automatica
at call arrival. The default is to give focus to an NTOA call processing field, fo
example, Clg field, Cld field, etc.

9. If either the NTDA or NTOA application is selected as the application name, an
enhanced scripting mode is not selected, the Scripting Priority section (lower
portion of the window) is not grayed out and can be datafilled. For standard
scripting, these priorities are used in determining which call information is used
IWS to determine the text contents of the scripting window.

• If NTDA is the selected application, you can set scripting priority among
CT4Q, call origination type, and SPID.
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• If IWS Billing (NTOA) is the selected application, you can set the scripting
priority among CT4Q, call origination type, SPID, and reason code.

When there are duplicates in the priority choices, an error message window sh
(See Figure 87.)

FIGURE 87. Example of error window when duplicates occur

10. Select OK on “Edit Application” window to close the window and keep the curre
settings. Alternatively, select Cancel to leave the window, or Reset to return to
previous settings. A Help button is also available in this window. Changes mad
this window will be saved when you select Save from the File menu in the
Provisioning Tool window.
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The SCRPTINI.INI file by default has a section for both NTOA and NTDA. A section c
be created for another IWS registering application that supports IWS scripting. To
configure a new application section, do the following steps;

1. Enter the desired application name in the Application Name box. The applica
name can contain up to eight characters. (See Figure 88.). Note, if you enter o
the pre-existing applications, NTDA or NTOA as the application name, the curr
settings for that application appear.

FIGURE 88. Example of the SCRPTINI New Application window

2. Follow the steps for the Edit Application procedure (page 123) to customize t
scripting settings for the application.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous settings. A Help button
also available in this window.

The SCRPTINI configuration window redisplays. A new application is added t
the Applications list box in the SCRPTINI configuration window. A maximum 
16 applications can be listed. The New command button is disabled once the
maximum is reached.

An application section can be removed from the SCRPTINI.INI file.
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1. Select an application in the Applications list box in the configuration window.

2. Select Remove.

A confirmation message displays.

3. Select Yes to confirm the deletion. The selected application section is remove
from the SCRPTINI file.

Alternatively, select “No” to cancel the deletion.

The configuration window redisplays.

4. When you are done with the command buttons in the configuration window a
want to save the settings, in the Provisioning Tool window select File, then se
Save.

The Save As option enables you to save the SCRPTINI file to another name,
the IWS will not read this file because the IWS always looks for the file
C:\WINDOWS\SCRPTINI.INI.

5. To close the configuration window, select Close from the File menu.

For more information on configuring IWS scripting, refer toTOPS IWS Base HMI
Application Guide, 297-2251-013.

13.5  CLNTTCPI provisioning

CLNTTCPI.INI is reserved for Nortel Networks maintenance use.

13.6  NTOAINI provisioning

The NTOAINI.INI file contains configuration information for the IWS Billing application
For more information on the NTOAINI.INI file, refer toTOPS IWS Billing Application
User Guide, 297-2251-016.

1. From the top menu bar of the Provisioning Tool window, select File.

2. From the File menu, select New or Open.

3. If Open is selected, the Open dialog box displays. If New is selected, a list of
displays.

4. Select NTOAINI. (See Figure 89.)
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FIGURE 89. Example of NTOAINI configuration window

5. Select the desired command buttons in the configuration window. The followi
sections describe the purpose of these command buttons.

6. When you are done with the command buttons and want to save the values a
settings specified, select File, then select Save.

The Save As option enables you to save the file with another name.

7. To close the configuration window, select Close from the File menu.

8. A message box displays to prompt you to save before closing the window.

13.6.1  Timezone Offset command button

1. To make timezone adjustments, select Timezone Offset in the configuration
window. (See Figure 90.)

FIGURE 90. Example of Timezone Offset dialog box

2. In the Offset entry box, enter a number in the range of +/-24 hours.
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This determines the number of hours added to Greenwich mean time (GMT) to
local time.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.

13.6.2  Card Format command button

1. To set the number of digits between each separator in a card number, select
Format in the configuration window. (See Figure 91.)

FIGURE 91. Example of Card Format dialog box

2. In the Format entry box, enter the number of digits you want to display betwe
each separator.

The sum of the digits must not exceed ten. The example in the dialog box refl
your entry. “n” represents a digit. “x” represents the PIN.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.

13.6.3  Application Audit Timeout command button

1. To set the number of seconds the IWS Billing application waits for an audit
response from the calling card database (CCDB), select App Audit Timeout in
configuration window. (See Figure 92.)

FIGURE 92. Example of Application Audit Timeout dialog box

2. In the Audit Timeout entry box, enter a value.
DMS-100 Family TOPS IWS RAMP and Provisioning User’s Guide  IWS 17.1



130

ncel
is

 to
g

ncel
is

e

ncel
is
The value can range from 1–65 but must be less than the App Audit Interval.
Otherwise, zero will be used.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.

13.6.4  DB Timer command button

1. To set the number of seconds the IWS Billing application waits for a response
an operator query from the CCDB or the Intelligent Service Node Provisionin
System (IPS), select DB Timer in the configuration window. (See Figure 93.)

FIGURE 93. Example of DB Timer dialog box

2. In the DB Timer entry box, enter a value between 1–65.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.

13.6.5  Audit Heartbeat command button

1. To set the number of seconds the datalink (a component in the IWS Billing
application) waits for a response from the CCDB, select Audit Heartbeat in th
configuration window. (See Figure 94.)

FIGURE 94. Example of Audit Heartbeat dialog box

2. In the Audit Heartbeat entry box, enter a value between 0–65.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.
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13.6.6  LIDB Query Fail Flag command button

1. To block or unblock a call or to send custom AMA when a domestic call is
completed, select LIDB Query Fail Flag in the configuration window. (See
Figure 95.)

FIGURE 95. Example of LIDB Query Fail Flag dialog box

2. Check or uncheck the Query Flag checkbox.

When this box is unchecked, a call is blocked and no custom AMA is sent whe
domestic call is completed. This indicates one of the following:

• the CCDB is active, but no card is found, and the LIDB (line information
database) is inactive.

• the CCDB and the LIDB are inactive.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.

13.6.7  App Audit Interval command button

1. To set the number of seconds between each Application Audit message sent
CCDB, select App Audit Interval in the configuration window. (See Figure 96.

FIGURE 96. Example of Application Audit Interval dialog box

2. In the AuditInterval entry box, enter a value between 1–65.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.
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13.6.8  DirNum Connect command button

1. To connect to a directory number automatically upon pressing theStart key, select
DirNum Connect in the configuration window. (See Figure 97.)

FIGURE 97. Example of Directory Number Connect dialog box

The DirNumConnect checkbox is checked by default. This indicates the direc
number is to be outpulsed.

Note: If DirNumConnect and Enable Triggers (see page 133) are both checked
inconsistent trigger message can occur.

2. Check or uncheck the DirNumConnect checkbox.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.

13.6.9  CCDB Query Fail Flag command button

When the CCDB is inactive and the LIDB is active, the CCDB Query Fail Flag comma
button can be used to:

• block calls

• complete domestic calls

• send custom AMA

1. Select CCDB Query Fail Flag in the configuration window to do any of the abo
(See Figure 98.)

FIGURE 98. Example of CCDB Query Fail Flag dialog box

2. Check or uncheck the Query Flag checkbox.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.
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13.6.10  Enable Triggers command button

1. To send trigger messages to the DMS switch, select Enable Triggers in the
configuration window. (See Figure 99.)

FIGURE 99. Example of Enable Triggers dialog box

2. Check or uncheck the Enable Triggers checkbox.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.

Note: If DirNumConnect and Enable Triggers are both checked, an inconsistent trigg
message can occur.

13.6.11  DB Connected command button

1. To connect to or disconnect from the CCDB or the Intelligent Service Node
Provisioning System (IPS), select DB Connected in the configuration window
(See Figure 100.)

FIGURE 100. Example of DB Connected dialog box

2. Select one of the following four options in the dialog box:

• None (disconnect from all databases)

• CCDB Only (connect to the CCDB)

• IPS Only (connect to the IPS)

• CCDB/IPS Combo (connect to both IPS and CCDB)

Note: When you configure the NTOAINI.INI file for the IWS Billing application
select either CCDB Only or IPS Only in the dialog box.

The IWS Billing application provides operator backup support for Billing Acce
Services on the IWS. Billing Access Services uses the IPS to manage certain
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of datafill. When a call arrives at an operator position from Billing Access
Services, the position automatically queries the IPS database for basic resell
information (a greeting, terminating brand, or allowed billing types). If
connectivity to the IPS is established, the IPS returns any restrictions or
terminating brand information, to display at the position.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.

13.6.12  Default Language command button

1. To choose a default language, select Default Language in the configuration
window. (See Figure 101.)

FIGURE 101. Example of Default Language dialog box

2. In the dialog box, enter a value (from 0–99) in the entry box or slide the scrol
button to select a value to indicate the wanted language.

A selected default language is needed when one is not supplied by the calling
or the XDBCOMP.TBL file.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.
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13.6.13  Encrypt Method command button

1. To choose an encryption method for the enhanced calling card PIN, select En
Method in the configuration window. (See Figure 102.)

FIGURE 102. Example of Encrypt Method dialog box

2. In the dialog box, select either no PIN encryption or one of the encryption
methods.

The default encryption method is No PIN Encryption. The same method mus
used on all enhanced calling card components, including Calling Card
ServiceNode and Calling Card Database.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.

13.6.14  Custom AMA Layout command button

1. To select a custom AMA layout when the record is sent to the DMS switch, s
Custom AMA Layout in the configuration window. (See Figure 103.)

FIGURE 103. Example of Custom AMA Layout dialog box

2. In the dialog box, select one of the AMA layout options.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.
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13.6.15  Acct Code Min Digits command button

1. To select the minimum number of digits in the account code, select Acct Code
Digits in the configuration window. (See Figure 104.)

FIGURE 104. Example of Account Code Minimum Digits dialog box

2. In the dialog box, enter a value in the entry box or move the scroll button to se
a value from 2–8. The default is 2.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.

13.6.16  Account Code Max Digits command button

1. To select the maximum number of digits in the account code, select Acct Cod
Max Digits in the configuration window. (See Figure 105.)

FIGURE 105. Example of Account Code Maximum Digits dialog box

2. In the dialog box, enter a value in the entry box or move the scroll button to se
a value between 2–8.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.
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13.6.17  Num PIN Code Digits command button

1. To select the maximum number of digits a valid PIN number can contain, sele
Num PIN Code Digits in the configuration window. (See Figure 106.)

FIGURE 106. Example of Number of PIN Code Digits dialog box

2. In the dialog box, enter a value in the entry box or move the scroll button to se
a value from 0–4.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.

13.6.18  ECC Context Revision command button

1. To select a revision level for an enhanced calling card (ECC) context block to
created by the IWS, select ECC Context Revision in the configuration window
(See Figure 107.)

FIGURE 107. Example of ECC Context Revision dialog box

When an IPS database is not connected, the IWS creates a context block. A
revision level is needed to create the context block.

If the database is a CCDB and an enhanced calling card is used by the caller,
uses the revision level specified in the ECC Context Revision to create a con
block.

2. In the dialog box, select the revision level of either version 1 or 5.

The default is version 1.
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3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.

13.6.19  SPL Field Editing command button

1. To allow editing in the special field when you press theEdit  key, select SPL Field
Editing in the configuration window. (See Figure 108.).

FIGURE 108. Example of Special Field Editing dialog box

2. In this dialog box, check the SPL Field Editing checkbox.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this window.

13.7  MPXTOP provisioning

The MPXTOP.INI file contains various connection parameters used by the IWS Billin
and NTDA applications. For more information on the MPXTOP.INI file, refer toTOPS
IWS Billing Application User Guide, 297-2251-016, orTOPS IWS Base Platform User’s
Guide, 297-2251-010.

Note: The connection parameters for the NTDA application are set using NTDA Setu
Both the NTDA section of the MPXTOP.INI file and information on NTDA Setup can 
found inTOPS IWS NTDA Application Guide, 297-2251-017.

1. From the top menu bar of the Provisioning Tool window, select File.

From the File menu, select New or Open.

If Open is selected, the Open dialog box displays. If New is selected, a list of
displays.
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2. Select MPXTOP. (See Figure 109.)

FIGURE 109. Example of the MPXTOP configuration window

3. Select the NTOA Service Number 16 button to enter primary and secondary 
address information. (See Figure 110.)

FIGURE 110. Example of the NTOA Service Number 16 dialog box (for IWS Billing)

4. In the dialog box, enter the IP address (valid range is 0 to 255.255.255.255),
number (valid range is 0 to 9000), and protocol type (valid range is 3) for prim
and secondary parameters as wanted.

5. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this dialog box.

13.8  Datafilling table files

Table files provide for the orderly reference and location of data. All IWS table files a
datafilled by default, but you may wish to customize some or all of these files for your s
Even though table files are local to the IWS position, note that many are referenced
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tables in the DMS switch and the values must correspond. Each table has a help se
where you will find references to table files in the DMS switch, if any exist.

TOPS IWS Base Platform User’s Guide, 297-2251-010,TOPS IWS Billing Application
User Guide, 297-2251-016,TOPS IWS NTDA Application Guide, 297-2251-017,TOPS
IWS OIA Application Guide, 297-2251-012, andTOPS IWS Base HMI Application Guide,
297-2251-013 all contain discussions of the table files provided by the applications t
reference.

Follow the steps below to change the datafill in a table file.

Note:The process of datafilling the XFNCTS and XCT4QMNU table files differs slight
from that of other table files. For instruction on how to datafill the XFNCTS table file,
refer to section 13.10 on page 144. For instruction on how to datafill the XCT4QMNU
table file, refer to section 13.11 on page 147.

1. From the top menu bar of the Provisioning Tool window, select File.

2. From the File menu, select New or Open.

3. If you chose Open, select Table File (*.tbl). in the List files of type box. If you
chose New, select Table File.

A list of table files displays.

4. Select a file from the listing; for example, file XAltRte. (See Figure 111.)

FIGURE 111. Example of a table file dialog box

5. To customize the datafill, select the line you wish to change. For example, se
the line that contains Switch ID as 0, Index as 1, Alt Rte as rt1. Then select Ed
open the Edit dialog box. (See Figure 112.)
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FIGURE 112. Example of Edit dialog for a table file

6. Select or make an entry for each entry box within the valid range indicated.

7. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this dialog box.

8. To add data, select Add to open the Add dialog box. (See Figure 113.)

FIGURE 113. Example of Add dialog box for a table file

9. Select or type a value for each entry box within the valid range indicated.

10. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this dialog box.

11. To remove data displayed, select the data, then select Remove. A confirmati
message displays.
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12. To reset all the data in the file to the settings in place at the last save comma
select Reload.

You can access online help for each file by selecting the Help option that is available i
main table window and the Edit and Add windows. (See Figure 114.)

FIGURE 114. Example of Help dialog for a table file

13.9  Datafilling language files

Language files contain datafillable text strings for the IWS screen displays. Each file
comes with online help text.

TOPS IWS Base Platform User’s Guide, 297-2251-010,TOPS IWS Billing Application
User Guide, 297-2251-016,TOPS IWS NTDA Application Guide, 297-2251-017,TOPS
IWS OIA Application Guide, 297-2251-012, andTOPS IWS Base HMI Application Guide,
297-2251-013 all contain discussions of the language files provided by the applicatio
they reference.

Follow the steps below to change the datafill in a language file.

1. From the top menu bar of the Provisioning Tool window, select File.

2. From the File menu, select New or Open.

3. If you chose Open, select Language File (*.lng). in the List files of type box. If y
chose New, select Language File.
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A list of language files displays.

4. Select a file from the listing; for example, file IDLMSA. (See Figure 115.)

FIGURE 115. Example of language file dialog box

5. To change the data displayed, select the data. For example, select the line th
contains String ID as 0, Text as Gen AMA. Then select Edit. (See Figure 116

FIGURE 116. Example of Edit dialog box

6. Select or make an entry for each entry box within the valid range indicated.

7. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this dialog box.

8. To reset all the data in the file to the settings in place at the last save comma
select Reload.
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You can access online help for each file by selecting the Help option that is available i
main table window and the Edit window. (See Figure 117.)

FIGURE 117. Example of Help dialog box for a language file

13.10  Datafilling the XFNCTS table file

1. From the top menu bar of the Provisioning Tool window, select File.

2. From the File menu, select New or Open.

3. If you chose Open, select Table File (*.tbl). in the List files of type box. If you
chose New, select Table File.

A list of table files displays.
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4. Select file XFNCTS from the listing. (See Figure 118.)

FIGURE 118. Example of an XFNCTS dialog box

5. To change data, select the function name to be changed, then select Edit. (S
Figure 119.)

FIGURE 119. Example of Edit dialog box for XFNCTS table file

6. Select or make an entry for each entry box within the valid range indicated.
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7. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this dialog box.

8. To add data, select Add to open the Add dialog box. (See Figure 120.)

FIGURE 120. Example of Add dialog box for an XFNCTS table file

9. Select or type a value for each entry box within the valid range indicated.

10. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window. A Help button is also available in this dialog box.

11. To remove data, select the data, then select Remove. A confirmation messag
displays.

12. To relocate data, select the data, then select MoveUp or MoveDown.

13. To reset all the data in the file to the settings in place at the last save comma
select Reload.

Warning: The function ID maps to an internal function
number and MUST remain with its associated function
name.

DO NOT separate the function ID from its function
name. To facilitate adding or removing functions, you
can alter the Function ID field shown in Figure 120.
Thus you can change the number in the Function ID box
to any value between 0-78, but selecting function ID “6”
will continue to invoke the Dial Rate function.

DO NOT separate the function ID from its function
name.
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13.11  Datafilling the XCT4QMNU table file

To datafill the XCT4QMNU table file, follow these steps:

1. From the top menu bar of the Provisioning Tool window, select File.

2. From the File menu, select New or Open.

3. If you chose Open, select Table File (*.tbl). in the List files of type box. If you
chose New, select Table File.

4. A list of table files displays. Select file XCT4QMNU from the listing. The dialo
box shown in Figure 121 appears.

FIGURE 121. Example of an XCT4QMNU dialog box

Note that Figure 121 shows duplicate entries: CT4Q ID 5, “French Operators Queue
appears twice in the listing. The CT4Q IDs listed in table XCT4QMNU are pulled fro
table XCT4Q. When those IDs are referenced in table XCT4QMNU, they are allowe
be listed more than once. This enables the use of multiple entries of the NIL value (20
In addition, operators may find it useful to have the same menu item appear on mor
one page, to avoid some paging back and forth.

Note: With the exception off the NIL value (2047), the CT4Q IDs entered in table
XCT4QMNU must be a subset of the CT4Q IDs datafilled in table XCT4Q.
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13.11.1  Changing data

To change data in the XCT4QMNU.TBL file, follow these steps:

1. Select the CT4Q to be changed, then select Edit. The Edit dialog box display
shown in Figure 122.

FIGURE 122. Example of Edit dialog box for XCT4QMNU table file

2. Select or make an entry for each entry box within the valid range indicated.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window, or Reset to return to the previous setting. A Help button 
also available in this dialog box.

13.11.2  Adding data

The order in which entries are displayed in the CT4Q menu is determined, not by th
CT4Q ID numbers, but by the order in which they are datafilled in the XCT4QMNU.TB
file. Before adding data, therefore, it is important to determine the order in which you w
the entries to appear in the menu listing.

Figure 123 shows a sample XCT4QMNU.TBL file, and Figure 124 shows the
corresponding CT4Q menu that displays when theCT4Q key is pressed twice.

Warning: The CT4Q ID maps to an internal number
and MUST remain with its associated name.

DO NOT separate the CT4Q ID from its name. To
facilitate adding or removing CT4Q IDs, you can
change the number in the CT4Q ID box to any value
between 0-2047, but selecting CT4Q ID “6” will
continue to invoke the CT4Q designated for it.

DO NOT separate the CT4Q ID from its CT4Q name.
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FIGURE 123. Example of XCT4QMNU.TBL file

FIGURE 124. Example of CT4Q menu
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To add data, follow these steps:

1. Select Add to open the Add dialog box. (See Figure 125.)

FIGURE 125. Example of Add dialog box for an XCT4QMNU table file

2. Select or type a value for each entry box within the valid range indicated.

3. Select OK to close the window and keep the settings. Alternatively, select Ca
to leave the window. A Help button is also available in this dialog box.

As explained in section 13.11 on page 147, multiple entries can be added with the s
CT4Q ID.

13.11.3  Removing data

There are two ways to remove data from the CT4Q menu. One method is the same 
with other IWS menus. To delete entries, select the data and then select Remove. A
message displays to confirm that the entry was deleted.

The second method is unique to the CT4Q menu. In the XCT4QMNU.TBL file, the e
2047 represents a NIL CT4Q value. When an entry is given this value, its CT4Q nam
not displayed in the CT4Q menu and its CT4Q number is disabled. This arrangemen
allows you to retain the numbering of your menu, even when some CT4Qs listed on
become invalid.

For example, if CT4Qs 50 and 4 in Figure 123 become invalid and should no longer
used by the operator, you might choose to delete those entries. Then all the CT4Q e
following them in the XCT4QMNU.TBL file would be renumbered. For example,
“Address Announcement” would be displayed as 1 in the CT4Q menu. This change in
appearance of the menu could cause confusion for operators.

Using the NIL CT4Q entry instead of deleting the old CT4Q entries avoids the confu
by retaining the same CT4Q entries on the CT4Q menu and disabling the old CT4Q
entries.
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Figure 126 shows an example of the XCT4QMNU.TBL file using this functionality.

FIGURE 126. XCT4QMNU.TBL using NIL CT4Q numbers

Figure 127 shows the corresponding CT4Q menu.

FIGURE 127. CT4Q menu
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13.11.4  Relocating data

To relocate data, select the data, then select MoveUp or MoveDown.

13.11.5  Reloading data

To reset all the data in the file to the settings that were in place at the last save com
select Reload.
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14.0  KeyBind

The KeyBind utility allows you to assign a specific action to a specific key at an IWS
position. KeyBind is located in the KEYBIND.EXE file in directory
C:\MPXBASE\TOOLS. From the KeyBind window, you can assign actions to keys an
verify the keyboard layout as identified in the current IWS keyboard datafill file. For
information on the following subjects, refer toTOPS IWS Base Platform User’s Guide,
297-2251-010:

• keyboard datafill file format and field descriptions

• keyboard configuration tips

Activate the KeyBind utility by selecting KeyBind from the provisioning tool Run men
in the main RAMP window.

For information on how to move through menus and select menu actions, see sectio
on page 18.

By default, KeyBind uses file XKBOARD.TBL from the default datafill directory to set u
the initial keyboard layout. You can apply a new keyboard layout from any other table
but you must name that file XKBOARD.TBL and you must specify the directory path
file MPXINI.INI. Consider renaming the original file XKBOARD.TBL first, to avoid
overwriting and losing it.

Besides file XKBOARD.TBL, KeyBind loads the following table files from the default
datafill directory.

• XAPPL.TBL

• XCT4QMNU.TBL

• XFNCTS.TBL

• XOGTMENU.TBL

• XSERVS.TBL

• XTROUBLE.TBL

If any of these table files is corrupted or missing, KeyBind will not run.

14.1  Note for new users of Windows XP Professional

If you are upgrading to IWS release 17 or above but keeping the datafill from an ear
release of file XKBOARD.TBL, you must use the KeyBind utility to reassign key actio
to three keys whose scan codes were changed with the introduction of Windows XP
Professional. Figure 128 shows the assignments of scan codes for the IWS keyboar
before and as of IWS release 17.
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FIGURE 128. Current and past scan code assignments

14.2  Selecting an application section

Figure 129 shows the main IWS KeyBind window.

FIGURE 129. IWS KeyBind window
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The IWS keyboard datafill allows a specific key to be datafilled with different key actio
for different applications. To customize the keyboard on a per-application basis, the
keyboard datafill table file contains both default and application-specific sections.

The default section is identified by the tag “Default.” The application-specific sections
identified by the application name (for example, NTDA).

Note: If you are using a text editor to datafill file XKBOARD.TBL, the section titles mu
be enclosed in square brackets (for example, [NTDA]). If these brackets are missing
system ignores the application-specific section and applies default key mappings to
entire file.

Application-specific sections are used whenever key datafill is different for a particul
application. Only keys that have different actions from those in the default section req
datafill in the application-specific section. If you press a key while a particular applica
is running on the IWS position, the system checks that application-specific section o
XKBOARD.TBL for the key. When this key is not datafilled in the particular applicatio
specific section, the system checks the default section to determine if this key is data
there. Then the system takes action according to the datafilled information.

Note: In the XKBOARD.TBL file, key actions 0–9 (representing keypad 0 through keyp
9) can be datafilled only in the default section. If you try to datafill these keys in an
application-specific section, the system displays the message “Number pad keys ca
be defined in the Default section.”

The Section box in the KeyBind window lists section headings found in the current
keyboard datafill file. Select the arrow button or pressAlt + the down arrow key to display
the list of section choices. Use the arrow keys to highlight the desired section and pr
Enter to select it.

Once you have selected a section, all commands within KeyBind (for example, Add,
Undefine, and Verify) perform their actions in the context of the selected section in th
current datafill file.

14.3  Key set

From the Key Sets box in the KeyBind window, you can view the choices by selecting
arrow button or pressingAlt +the down arrow key. Then you can use the arrow keys to
highlight the desired key set and pressEnter to select it.

After the selection, the key actions in the selected key set display in the Key Actions
When an application-specific key set is chosen, KeyBind locates a key action descri
file for the current application section in the datafill directory.

Any application that provides application-specific keys has a key action description fi
The file lists the available key actions and descriptions of keys for these actions. The
system displays the text from this key action description file in the Key Actions list bo

When the system cannot find the file, a message box displays to indicate there are n
application-specific keys available for that section. The IWS Generic key actions dis
in the Key Actions window.
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For third-party applications that provide application-specific key actions, consult the
application vendor for a key action description file.

When no key action description file is available for the application, the application-
specific key actions can be assigned to physical keys by using a text editor to datafi
actions in file XKBOARD.TBL.

14.4  Assigning action to a key

When you use the Assign Key GUI, you create an association between one of the k
actions listed in the current IWS keyboard file and a physical key. The link between 
action and the key is the scan code that is assigned to the physical key.

To assign an action to a key, follow these steps in the KeyBind window:

1. Select a key set.

2. Select the key action you wish to associate with a physical key.

3. Select the Add button to open the Assign Key window.

The Assign Key window displays. The title bar of the window contains the nam
of the currently selected section. (“Default” in Figure 130.) The selected key s
(Action Set) and key action (Action) display.

FIGURE 130. Assign Key window

4. On the keyboard, press the key you wish to assign to the selected key action
window closes, and for the action set (IWS Generic) you selected in step 1, th
physical key will perform the action you selected. You can verify your selection
following the steps in section 14.6 on page 158.

If you press theEnter key instead of the key you want to assign, a message bo
displays to confirm or deny that theEnter key is the choice for this key
assignment.

When you select a key to which an action has already been assigned, a mes
box displays asking you to confirm or deny overwriting the previous assignmen
you do not want to overwrite the previous assignment, select Cancel.

5. To exit from the Assign Key window without assigning an action, select Cance
return to the KeyBind main window.
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A key can be assigned in combination with the modifier keys (Shift, Ctrl , Alt ). When a
modifier key is pressed, its color changes from gray to black in the Assign Key wind
TheTab key and the following modifier keys and combinations are not available for
assignment:

• Shift+Shift
• Ctrl+Ctrl
• Alt+Alt
• Shift+F10
• Alt+F6

However, theTab key can be assigned to an IWS key action by using a text editor to
datafill the key in file XKBOARD.TBL.

Do not assign any key action to theCaps Lock key. When datafilling NTDA keys, do not
assign any key action to the period (.) or comma (,) keys. NTDA key action assignments
are discussed inTOPS IWS NTDA Application Guide, 297-2251-017.

The following cursor movement key actions from the IWS Generic key set must not 
datafilled on any of the modifier keys (Shift, Ctrl , Alt ). Neither can they be datafilled as a
key combined with a modifier key (for example,Ctrl +<a key listed below>):

• right arrow

• left arrow

• up arrow

• down arrow

• Delete

• Home

For more detail, refer to the Keyboard Configuration Considerations section in the
XKBOARD table description section in theTOPS IWS Base Platform User’s Guide, 297-
2251-010.

14.5  Removing an assigned key action from a key

To remove an assigned key action from a key, follow these steps:

1. Select an application section as described in the previous section.

2. Select the Undefine button.

The Undefine Key window displays. The title bar contains the name of the
currently selected section. (“Default” in Figure 131.)
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FIGURE 131. Undefine Key window

3. Press the desired key and any combination of the modifier keysShift, Ctrl , or Alt .
The window closes.

Note that when a modifier key is pressed, the color of that modifier key chang
from gray to black. (See “Control Key” in the figure above.)

4. To exit from the Undefine Key window, select Cancel to return to the KeyBind
main window.

14.6  Verifying a key assignment

To verify the assignment of keys, follow these steps:

1. Select an application section.

2. Select the Verify button.

The Verify Key window displays. The title bar contains the name of the curren
selected section. (“Default” in Figure 132.)

FIGURE 132. Verify Key window
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3. Press the desired key and any combination of the modifier keys (Shift, Ctrl , Alt ).

When you press a key in the verify window, the system checks the application
specific section for that key assignment. Then this assignment displays in the
Verify Key window. If that key assignment is not in the application-specific
section, the system checks the default section.

4. To exit from the Verify Key window, select the Close button to return to the
KeyBind main window.

14.7  File menu options

The KeyBind file menu options are similar to those of a standard text editor, except t
only keyboard files can be opened. The path and name of the currently opened file di
in the title bar of the KeyBind main window. KeyBind begins with XKBOARD.TBL as
the current file. Only one file can be opened at a time.

The file menu options follow:

New This option opens a new file with no key definitions.
The window title bar indicates that the file is untitled.
When you enter changes and save the file, the system
prompts you for a file name.

Open This option activates an Open dialog box, from which
you can select a keyboard file to open and display wi
the KeyBind GUI. The title bar of the Open File dialog
box indicates the name of the opened file.

If a file is already opened and changes are made to t
file, the system prompts you to save the changes bef
opening another file.

Save This option saves changes made to the opened file. F
new file that is untitled, the system prompts you for a
file name and location.

Save As This option activates the Save dialog box. When a file
saved, the KeyBind title bar is changed to reflect the
name of the new file.

Revert This option reloads the latest saved version of the
currently opened file into the system. For changes ma
to this file, the system prompts you to verify whether
you want to abandon the changes made since the las
save command was implemented.

Exit This option exits KeyBind. For changes made to the
current file, the system prompts you to save the chang
before exiting.

Note:When you save key assignments in a file with a name other than XKBOARD.T
you do not change the keyboard layout that is understood by the IWS applications. T
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change the keyboard layout, you must save the key assignments in the XKBOARD.T
file, and the file must be in the default datafill directory. You can verify this directory 
using the provisioning tool to open the MPXINI.INI file, and selecting Datafill Path.

14.8  Utilities menu options

The Utilities menu contains the options for accessing the key macro utility, adding o
deleting a section from the keyboard file, and viewing the key bindings.

14.8.1  Key macros

Key macros link multiple key actions and perform them as a single keystroke. Key ma
are similar to hot keys, but they provide more flexibility because they can be created
any application that accepts keystrokes on the IWS position through the API/SDK. A
macro can be defined, for example, so that just one keystroke replaces those that oth
are necessary to invoke an action (for example, Svc, 4, Start). When you press the ke
triggers a given key macro, you see in rapid succession the screen displays that an op
would see while pressing each key separately. The difference is that the screen disp
occur very quickly.

Up to 25 key actions can be combined into a single macro, and up to 25 key macros c
defined.

KeyBind is used to set up and edit key macros for use on the IWS position. The follow
sections describe key macros in detail.

14.8.1.1  Key macro guidelines

The following list contains guidelines to consider when you are defining key macros.
Some of these guidelines arise from the interactions between various applications o
IWS position and the interaction of these applications with external sources such as
databases or the DMS switch. Others arise from the design of the feature. Read all 
guidelines and remember to heed the warning in the box above. Do not use a key mac
a live IWS operator position before you have thoroughly tested it.

Warning: Thorough testing must be done by the
operating company personnel who define the key
macros BEFORE they are used on a live operator
position. Operators should be trained to use key
macros on demo positions before they execute them
on live positions.

The real-time action of a key macro may not be
what was intended by the macro designer, owing to
the effect of one or more of the guidelines discussed
in the following section.
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• When defining a key macro with a key action (or more than one key action) that sen
message to the DMS switch or other external source (such as a calling card data
consider the delay that is associated with the message. Such a pause could lead to
of effect, or possibly alteration of intent, of one or more subsequent key actions. B
sure to test the key macro thoroughly before you use it on a live IWS operator po

• All key macro definition must be done in KeyBind. (See section 14.8.1.2 on page 1
No other editor is allowed.

• Modifiers (Alt , Shift, Ctrl ) are not allowed as key actions in key macros. Neither a
modifiers allowed when they are linked with other keys to create key actions (for
example,Shift+F10, Alt+F6).

• Define key macros within the application-specific section that corresponds to the
intended application. Observance of this guideline will reduce the chance of
unpredictable outcomes from the execution of a key macro in an application for w
it was not intended.

For example, if NTDA is the application that currently has focus on the IWS positi
then each key action in a key macro will be checked first against the NTDA sectio
file XKBOARD.TBL, so long as the section application name is identical to the
application name listed on the registering line in file MPXINI.INI. Thus the same k
action mapped to the “tab” action in IWS Billing may be mapped to the “clear field
action in NTDA. A key macro defined for NTDA would have a different outcome if
executed in the IWS Billing application.

Extra entry menu key macros are the only key macros that can be defined reasona
the Default section of KeyBind, because they can be implemented independently o
application.

• In general, do not define a key macro to contain a context change key action. If s
macro is defined, however, observe the following guideline:

Operating company personnel must define key macros that contain a context cha
key action within the appropriate application-specific section. A macro cannot be
expected to achieve the desired result if it is executed in an application other than
one for which it was defined.

For example, an operator working in the NTDA application can switch to the billin
application by pressing theCLD  key. The IWS position then displays the IWS Billing
application screen. If the operator pressesCLD  while the IWS Billing application has
focus, the cursor moves into the called field and no context change takes place. S
including theCLD key action in a key macro defined to work in IWS Billing will make
that macro behave unexpectedly if it is executed in NTDA.

• Application-specific keystrokes, menu hot keys, and previously defined key macro
keystrokes are not allowed in key macros.

Application-specific keystrokes are key actions that have been specifically defined
mapped in an application-specific section. For example, the application-specific se
for NTDA contains over a hundred key actions. Not all of these key actions may b
use at your site; however, be aware of those that have been mapped to specific ke
avoid them in defining key macros.
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• KeyBind permits you to bind one key action to a physical key in one default or
application section, and a different key action to the same physical key in another
application section. Binding different key actions to the same physical key in diffe
application sections, however, has the potential to cause problems with key macr
the key action is included in a key macro, the key macro will not work the same w
across all applications.

For example, suppose you bind the OGT menu key action to ther  key in the default
section of KeyBind, while binding the Trouble menu key action to ther  key in the
NTDA section. In that case, an OGT key macro (such asOGT + 1 + 0 + START) will
not work properly in NTDA. To prevent this kind of problem from happening, be
careful when binding different key actions to the same physical key in different sect
and then using those key actions in key macros, because it may cause unexpecte
behavior in different applications.

• Do not include adjacent tabs in a key macro. A key macro may contain more than
tab, but one tab must not immediately follow another.

14.8.1.2  Defining a key macro

Each macro can have a maximum of 25 key actions, and a maximum of 25 key macro
be defined. The key macros are stored in file XKEYMAC.TBL. The procedure for
assigning a key macro is similar to that for assigning a single key action, as discuss
earlier in this section. (See the KeyBind discussions beginning on page 153.)

Note that any macro you define must be thoroughly tested before being put into use o
operator positions. In addition, the operators must be thoroughly trained to use key
macros.

All macros must be created with the key macro utility. To define a key macro, select 
Macros from the pulldown Utilities menu in the KeyBind main window. (See Figure 13
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FIGURE 133. Key Macros selected in the Utilities menu

The Key Macro Configuration Screen appears. (See Figure 134.)

FIGURE 134. Key Macro Configuration Screen
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The Macros list box contains a short list of default key macros; however, these may 
apply to the specific needs of your site. In any case, you can create new macros by
following these steps:

1. Select an undefined (unnamed) macro from the Macros list box. In the above
figure, #5 is the next available undefined macro. Using the mouse or theTab key,
move the focus to the Macro Title field. Type the name or description of the ma
up to 30 alphanumeric characters and spaces. You must provide a title and th
actions that make up the macro before you can save it.

2. Select the section in which you want to place the key macro from the pulldown
in the Sections field.

3. Select the Macro Keys field and press the keys you wish to include. Alternativ
you can select the Key Actions list box and then select the key actions from t
list. Use the spacebar or click the mouse to add the highlighted key to the ma
key list.

If you add key actions to the macro by pressing keys, each key action is looked
and taken from the XKBOARD section that is specified in the Sections list bo
the lower right corner of the Key Macro Configuration Screen. Key actions are
taken from the last saved version of file XKBOARD.TBL. If a key action is not
found in the specified section, it is searched for in the Default section. If the k
action is not listed at all, then the keystroke will be interpreted to match the ac
of the physical key on the keyboard.

If you select an action from the Key Actions list with the spacebar, the action 
added to the Macro Keys list, but focus remains in the Key Actions window. If y
wish to press a key to enter a new key action, you mustTab to the Macro Keys
window to activate the cursor and provide focus.

Note:TheTab key moves focus from one field or button to another in KeyBind,
you cannot press that key to add “Tab” to a macro. If your macro includes “Ta
select it from the bottom of the IWS Generic Key Actions list. TheFnctskey also
moves focus from one field or button to another in KeyBind, so you cannot pr
that key to add “Functions menu” to a macro. So if your macro includes “Fnct
select it from the IWS Generic Key Actions list.

4. Select Save. The macro will be listed in the selected empty space in the Macro
box.

5. Select Done to return to the KeyBind main window, or return to step 1 to add
another macro.

14.8.1.3  Editing an existing key macro

If you want to edit an existing macro, follow these steps:

1. In the Macros list box, select the macro you wish to edit. The macro title and 
actions display in the appropriate fields.
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2. Use the backspace key to move about in the list of key actions. Each time you p
the backspace key, the cursor retreats one complete keystroke. Thus you can
remove the word “START” by pressing the backspace key just once, because
start key action is expressed with just one keystroke.

3. Make your changes, and select Save.

If you select Done at any time during either of these operations, you are prompted to
or ignore the current work. To delete a macro from the list, select it from the Macros
box and select Clear and Save.

14.8.1.4  Assigning a key macro

After you define a key macro, you must assign it to a physical key. Follow the instructi
found earlier in this section. (See “Assigning action to a key” on page 156.) When yo
open the Key Sets list box in the KeyBind main window, you will find a key set reserv
for key macros.

14.8.2  Add Section

Selecting the Add Section menu item from the Utilities menu in the KeyBind main
window opens a dialog box so you can enter the name of a new section into the cur
IWS keyboard datafill file. (See Figure 135.)

FIGURE 135. Add Section window

Once a name is entered, select OK or press theEnter key. A message box displays to
ascertain that you want to add a section. (See Figure 136.) Alternatively, you can se
Cancel or press theEsc key to close the window and cancel the action.

FIGURE 136. KeyBind add section verification window

The section name is limited to eight characters. You cannot add duplicate sections t
current IWS keyboard file.

Once you have added a new application-specific section, you can assign application
specific key actions for the application and re-assign key actions to other keys.
DMS-100 Family TOPS IWS RAMP and Provisioning User’s Guide  IWS 17.1



166

you
ee

ent

ction

at
bar of
e
ve
w.

bine
14.8.3  Delete Section

Selecting the Delete Section menu item from the Utilities menu opens a dialog box so
can delete the section displayed in the Section field of the main KeyBind window. (S
Figure 137.)

FIGURE 137. Delete section choice and dialog box

If you select Yes or pressEnter, all key assignments and the section heading in the curr
IWS keyboard file are deleted.

You cannot delete the Default section. Note that while Default is displayed in the Se
field, the Delete Section menu item is disabled.

14.8.4  View Bindings

Selecting the View Bindings menu option from the Utilities menu opens a window th
shows the status of key assignments, sorted by scan code or by key action. The title
the window indicates the section for which the bindings are shown. The list box in th
window contains keys and their assignments based on what boxes in the window ha
been checked. You can pressEscor Enter, or select the Close button, to close the windo

Following are descriptions of the choices you can make to configure the window:

• Modifiers (Alt , Shift, orCtrl  key, or extended scan code)–Checking any of
these boxes causes the window to display all the key assignments that com
a key with the chosen modifier(s).
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• Display Settings (Show Assigned, Show Unassigned)–You can check eithe
both of these boxes. If you check both, all keys are displayed (by scan co
by key action) whether or not they are assigned to a key set. If you check S
Assigned, the keys and their key set assignments are displayed. If you ch
Show Unassigned, the keys that have not been assigned in any section d

• View Key Bindings (By Scan Code, By Key Action)–You can check one of
these two boxes to display the list of keys sorted either by scan codes or by
actions, along with their associated assignments.

Figure 138 shows all assigned and unassigned key bindings sorted numeri
by scan code. If no key is assigned to a particular scan code (and thereby
physical key), the entry in the Key Set column reads “Unassigned.” Use th
window in combination with the keyboard graphic on page 154 to learn wh
physical keys are without assignment for the section shown in the title bar
this example, Default). If you uncheck the Show Unassigned box, the stat
window displays all the scan codes (and thereby the physical keys) that h
assigned key actions.

FIGURE 138. View key bindings by Scan Code window
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Figure 139 shows all assigned and unassigned key bindings sorted numeri
by key action within each key set. The list order first displays all the key
actions for a particular key set, and then all the key actions for another key
and so on until all key actions in all key sets are shown. In this status wind
the assigned or unassigned designation in the Display Settings box conve
whether a key action is assigned to a scan code (and thereby to a physical

FIGURE 139. View key bindings by key action window

14.9  View

The view menu has two options, Toolbar and Status Bar. By default, both are turned o
toggle an option off, select the option you wish to change and pressEnter. Alternatively,
press the associated accelerator key to toggle the option off or on.
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14.9.1  Toolbar

You can toggle the toolbar option to display or hide the Microsoft Windows file icons
shown below.

FIGURE 140. Toolbar display toggled on, status bar toggled off
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14.9.2  Status Bar

You can toggle the status bar option to display or hide the Microsoft Windows status
messages at the bottom of the window.

FIGURE 141. Status bar display toggled on, toolbar display toggled off

14.10  Help

You can access the Microsoft Windows-type help index in several ways. You can se
menu option, press F1, or select the arrow-question mark icon on the toolbar.

status bar display on

toolbar display off
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15.0  Revisions

15.1  Release 17.0/17.1 revisions

• The following datafill (.INI, .TBL, .LNG) files were added, altered, or delete

— New files:

no new files
— Altered files:

SCRPTINI.INI
MPXINI.INI
MPXNET.INI
NTDAINI.INI
HOSTS.TBL
PDCALLD.LNG

— Deleted files:

no deleted files

• Microsoft Windows XP Professional has replaced Windows 95 as the
operating system.

— IWS IP Positions available. (SeeTOPS IWS Base Platform User’s Guidefor
more information.)

• The hosts. file moved from c:\windows to c:\windows\system32\drivers\etc

• Updated section “IP Audio Device command button” on page 105 for the
Plantronics headset.

15.2  Release 15.2 revisions

• The following datafill (.INI, .TBL, .LNG) files were added, altered, or delete

— New files:

no new files
— Altered files:

MPXINI.INI
SCRIPTINI.INI

— Deleted files:

no deleted files

• The provisioning tool window for SCRIPTINI.INI has a new option: “Give
Scripting Window Focus at Call Presentation.” The old option “ScriptVisibl
During Call” has been removed.

15.3  Release 15.0 revisions

• The following datafill (.INI, .TBL, .LNG) files were added, altered, or delete

— New files:
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no new files
— Altered files:

MPXINI.INI
— Deleted files:

no deleted files
Parameter WavDeviceSupported is added to the MPXINI.INI file to suppo
the audible alert feature.

15.4  Release 14.0 revisions

• No revisions to the RAMP application for this release.

• No revisions to the provisioning tool for this release. However, a new sect
(page 147) describes how to use the provisioning tool to datafill the new CT
menu. Two new IWS base files support this new menu: XCT4QMNU.TBL a
CT4QMENU.LNG.

15.5  Release 13.0 revisions

Note: As of IWS release 13.0, the NTOA/NTOA Plus application is renamed the IWS
Billing application.

• The following datafill (.INI, .TBL, .LNG) files were added, altered, or delete

— New files:

no new files
— Altered files:

no altered files
— Deleted files:

no deleted files

• KeyBind rewrite:  The KeyBind utility has been rewritten to conform with
IWS 32-bit architecture. The KeyBind main menu has changed. The five
previous menu items are consolidated into four. The Key Macros, Add Sect
Delete Section and View Bindings items are now found under the utilities
menu. The Help now uses a Microsoft Windows-type GUI and covers vari
KeyBind topics. (See page 153.)

• CCDB Timer name change:The CCDB Timer control button is now called
the DB Timer control button. (See page 130)

• Documentation improvement: Section 8.0, “File transfer tool,” was updated
again after Gate 3 to explain in more detail how to use the RAMP for
upgrading other IWS positions and to how to manage customized datafill
during software distribution.

15.6  Release 12.0 revisions

• No revisions to the RAMP application for this release.
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15.7  Release 11.0 revisions

• The following datafill (.INI, .TBL, .LNG) files were added, altered, or delete

— New files:

no new files
— Altered files:

MPXINI.INI
XFNCTS.TBL
XKBOARD.TBL

— Deleted files:

SCRSINI.INI

• The RAMP dial-up connection enables a PC equipped with Windows 95 a
configured as an off-ring RAMP to dial-in to an on-ring RAMP. Once the tw
RAMPs are connected, the off-ring RAMP can perform maintenance to th
LAN that the on-ring RAMP is residing. All functionalities of an off-ring
RAMP are supported when RAMP dial-up is used. (See page 23.)

• A key macro can record multiple key actions and perform them as a single
keystroke. Up to 25 key actions can be recorded in a key macro, and up t
key macros can be defined. The KeyBind utility is used to set up and edit 
macros for use on the IWS position. (See page 160)

• NTDA no longer supports the DA router system configuration. The button
labeled “Make NT-DA Gateway” has been removed from the Nonregisterin
Applications dialog box of the MPXINI.INI configuration window in
ProvTool. If you are upgrading to the release IWS110 version of NTDA, bu
keeping the datafill in file MPXINI.INI from any release prior to IWS110, u
the provisioning tool to remove FT router from the list of nonregistering
applications. Failure to remove this line from file MPXINI.INI results in an
error at startup of the IWS position.

• Added Allow Automation to file XFNCTS.TBL to support the No Automation
feature.

• Windows 95 supplies a new virtual keyboard driver, which sends three new
scan codes. If you are upgrading to IWS release 11 but keeping the datafi
from an earlier release of file XKBOARD.TBL, you must use the KeyBind
utility to reassign key actions to the three keys whose scan codes were
changed. Refer to the XKBOARD.TBL section of theTOPS IWS Base
Platform User’s Guide, 297-2251-010. (See page 153)

• Manual file transfer can be done by using Windows 95 File Manager. This
the commercial application used by RAMP for file transfer. The user interf
is Windows Explorer. (See page 45)
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• The previous IWS custom screen saver is replaced with Windows-complia
screen savers. This change makes file SCRSINI.INI obsolete. Use the
Windows 95 Control Panel—Display GUI to select and configure a screen
saver.

• Follow the steps below to enable the use of a mouse with a RAMP:

1. If already at the Windows 95 desktop, proceed to step 7. If the IWS b
application is running, pressCtrl+Alt+Delete  to obtain the Close
Program window.

2. Use the down arrow key to highlight MPX BASE Application.

3. Use theTab key to highlight End Task. PressEnter to close the IWS base
application.

4. If the RAMP application is running, pressCtrl+Alt+Delete to obtain the
Close Program window.

5. Use the down arrow key to highlight Remote Access Maintenance
Position.

6. Use theTab key to highlight the End Task button and then pressEnter to
end the RAMP application.

7. To detect new hardware, the mouse must be plugged into the positio
the mouse is not already plugged in, do so now.

8. PressCtrl+Esc to open the Start menu.

9. Select Shut Down by pressingU.

10. In the Shut Down Windows dialog box, use the arrow keys to select
Restart the computer and then pressEnter to restart the computer.

11. Upon restart, the IWS base application is running. PressCtrl+Alt+Delete
to obtain the Close Program window.

12. Use the down arrow key to highlight MPX BASE Application.

13. Use theTab key to highlight End Task. PressEnter to close the IWS base
application.

14. PressCtrl+Esc to open the Start menu.

15. Select Run from the Start menu by pressingR.

16. At the Open text box, type:
c:\win95tmp\mouseins

17. PressEnter. The Finished–mouseins dialog box will appear. Ignore it an
proceed to the next step.

18. Modify the C:\AUTOEXEC.BAT file. PressCtrl+Esc to open the Start
menu.

19. Select Program from the Start menu by pressingP.
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20. Use the arrow keys to select MS-DOS Prompt from the Program me
PressEnter.

21. From the C:\WINDOWS prompt type:

edit C:\AUTOEXEC.BAT

22. PressEnter. In the AUTOEXEC.BAT file, locate the line that says “rem
MOUSEON=1.” Remove “rem” from the line.

23. PressALT+F , then pressX to exit the editor. A Save File dialog box will
appear. To save the changes, pressY.

24. Type EXIT to close the DOS shell window.

25. PressCtrl+Esc to open the Start menu.

26. Select Settings from the Start menu by pressingS.

27. Select Control Panel from the Settings menu by pressingC.

28. Use the arrow keys to select Add New Hardware. PressEnter.

29. The Add New Hardware Wizard will now run. PressEnter to continue.

30. To allow the Wizard to search for new hardware, select Yes
(Recommended) by pressingY. Then pressEnter to continue.

31. At the next window, pressEnter to continue with the new hardware
detection. The Wizard now will begin to detect new hardware.

32. After Windows has finished detecting new hardware, pressD to see what
new hardware components have been detected. If the mouse has not
detected, an error has occurred. Repeat these steps. Remember to a
the mouse to the position. Also note any additional hardware that ma
have been detected, such as extra ethernet or token ring network adap
These may need to be removed so the IWS position can restart corre

33. Tab to the Finish button and pressEnter.

34. The Windows mouse drivers will then be automatically installed. Whe
complete, a System Settings Change dialog box appears. To finish
installing the mouse, the position must be rebooted. Select YES by
pressingY.

15.8  Release 10.0 revisions

• Software distribution enhancements are as follows:

— Capabilities of including software distribution configurations in
configuration sets. (See page 48 and page 50)

— Schedule Manager for scheduling tasks to be executed at a certain tim
Currently software distribution is the only available task for scheduling
(See page 71)
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• Special field editing Parameter SPL Field Editing is added to file
NTOAINI.INI so the service provider can enable editing of a confirmed spec
number using the Edit key. (See page 138)

• NTOA ECC enhancements NTOA Plus is upgraded to provide new service
for enhanced calling cards. (See page 137)

The length of ECC PINs can now be datafilled in file NTOAINI.INI with
parameter NumPINCodeDigits.

One string (string ID 0018) is changed and two strings are added (string I
0041 and 0042) to file PCCCINFO.LNG as labels for the different types of
billing represented in the special field.

Two new strings (string IDs 0043 and 0044) are added to file PCCCINFO.LN
to provide a message in the MSA about the status of CCDB validation. Th
operator can press the Thr/CC key to turn CCDB card validation on or off.

If the operator enters only the PIN in the special field, these digits are
appended to the called number and sent to the CCDB for validation as a
complete enhanced calling card number.The length of ECC PINs can be
datafilled with parameter Num PIN Code Digits in file NTOAINI.INI.

• OIA HMI enhancements File OIACIW.LNG is reorganized. New text strings
for the new fields in the OIA application are added to file OIACIW.LNG.

These strings replace existing strings:

IC: string ID 0005

CLGNme: string ID 0006

CLGNum: string ID 0007

Txt: string ID 0008

CLDNme: string ID 0009

CLDNum: string ID 0010

15.9  Release 9.0 revisions

• Clock and Call Timer A new command button (Clock and Call Timer) is
added to the MPXPARM configuration window for the new IWS Customizab
Clock/Timer feature. The MPXPARM configuration window, which is used
datafill file MPXPARM.INI, can be accessed through the provisioning tool.
(See page 113)

A new cross reference table, XCOTHSD.TBL, is added for datafilling a
threshold (in minutes and seconds) for each call type for the call timer feat
(SeeTOPS IWS Base Platform User’s Guide)

• Print/Save Screen This new feature enables an operator to capture screen
displays during call processing for problem reporting purposes. These scr
captures are saved as files in directory SCRNCAPT on the operator posit
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Each screen capture generates a log that can be observed in the logs
observation window of the RAMP. (SeeTOPS IWS Base HMI Application
Guide). Table file, XTROUBLE.TBL, includes an additional new field name
ScreenCapture. IWS Generic key set includes an additional new key nam
Screen capture.

File Transfer tool at the RAMP can be used to collect screen capture files f
the operator positions to a common location at the RAMP
(C:\RAMP\SCRNCAPT directory). There is a PrintScreenCapture option
under Tools in the main menu of the RAMP. This can be used to print the
screen capture files selectively at the printer connected to the RAMP. (Se
page 43)

• SPID/trunk group simultaneous displayThis new feature is implemented in
the NTOA application (SeeTOPS IWS NTOA/NTOA Plus Application Guide).
For NTDA application, either SPID information or trunk group can be
displayed (SeeTOPS IWS NTDA Application Guide).

In the MPXPARM.INI file, new variables (DisplayBoth, Priority) are added t
the [TrunkGroupSPID] section. (See page 114)

• Scripting Enhancement added the following changes:

— SPID as an attribute to the current ones (Call origination type, CT4Q,
Reason Code for NTOA and NTOA Plus) that control the display in the
Scripting window at call arrival in NTOA, NTOA Plus and NTDA. New
cross reference table files (NTDASPID.TBL for NTDA and
XSPIDXSC.TBLfor NTOA and NTOA Plus) are added and existing cro
reference table files CORGNTDA.TBL and CT4QNTDA.TBL are
renamed. (SeeTOPS IWS Base Platform User’s Guide)

— Allows the scripting hierarchy, which determines which attribute has w
priority for display in the Scripting window, to become datafillable by th
customers in the SCRPTINI.INI file. This can be done via the SCRPTI
configuration window through the provisioning tool. (page 121)

Also see Scripting window in theTOPS IWS NTDA Application Guide and
Scripting utility in theTOPS IWS NTOA/NTOA Plus Application Guide.

— For NTOA and NTOA Plus, the Scripting window can be displayed durin
call processing. The operator can switch between the application wind
and the Scripting window by using the Script Window Display key and c
processing keys. (See Scripting Window inTOPS IWS Base HMI
Application Guide)

— In file SCRPTINI.INI, in NTOA and NTDA sections, the following new
datafillable variables are added: SPIDPriority, CT4QPriority, COPriority
VisibleDuringCall (NTOA only) and RCPriority (NTOA only). (See
page 121)

• Additional Hardware Requirements
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— Printer with capabilities for Bitmap printing, attached to the RAMP

— Label for the new screen capture key

15.10  Release 8.0 revisions

• The NTDA file NTDAMSA.LNG can now be datafilled by using Provtool.

Note: File NTDAMSA.LNG replaced MSA.LNG.

• The NTDA datafill files CT4QNTDA.TBL and CORGNTDA.TBL are no
longer datafilled through the NTDA setup tool;, they are now datafilled throu
Provtool.

• The NTDA files TASKON.BAT and TASKOFF.BAT replaced files
UNLOCK.BAT and LOCK.BAT. The new files TASKON.BAT and
TASKOFF.BAT are located in directory C:\RAMP\INSTALL\MPXBASE.

Note: For positions other than RAMP, the new files TASKON.BAT and
TASKOFF.BAT are also located in directory C:\MPXBASE\TOOLS.

15.11  Release 7.0 revisions

• Added the DMS Position number to the Profile, File Transfer, Trace, and
Reboot Windows where a list of available positions is displayed. If the DM
position is not available, the display will show “Position ????” along with th
network cluster and position numbers.

• Added the description for the File Types box in the SWD Script Editor Edi
window. Described the System Files and Non-System Files radio buttons.

• RAMP file transfers now use file renaming if the SWD files are “system” file
This will allow applications and DLLs to be replaced while they are running
memory, and not be “loaded” until the position is rebooted. See section 8.
“Software distribution,” on page 47.

• Removed the restriction that new SWD files had to be created by using a 
editor instead of the new menu command.

• Updated screens and text to reflect the IWS070BF load.

• Added the updated Debug Options screen and corresponding text to refle
addition to file MPXINI.INI.

• Added Text Flashing and Colorblind Support screens and corresponding te
reflect additions to file MPXPARM.INI.

• Changed PCCINI.INI references to NTOAINI.INI.

• Removed file MPX.INI and placed pertinent parameters in file
CLNTTCPI.INI.
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• Added Encrypt Method, Custom AMA Layout, Acct Code Min Digits, Acct
Code Max Digits, and Num PIN Code Digits screens and corresponding tex
reflect additions to file NTOAINI.INI.

• Eliminated all README files.

15.12  Release 6.0 revisions

• Removed capability to selected positions from the LAN status window. Th
was redundant activity. Before this change, positions had to be selected in
LAN status window before the user could access any of the RAMP tools. Th
once the RAMP tool was accessed, positions had to be selected again in 
tool. After this change, the RAMP tools may be selected as long as at least
position is communicating with RAMP. If at least one position is
communicating with RAMP, the RAMP tools may be accessed, and the us
then specifies the positions which will be effected by the tool from the dial
boxes and other user interface elements of the tool in use.

• Added new command button to the MPXPARM Configuration window, and
the Time Out Values dialog box to the IWS provisioning tool. These are us
to provision the Make Busy/Withhold Calls timeout value in MPXPARM.IN

• RAMP can now control other LANs that are connected through commerci
routers.

• Added a status bar to the main RAMP window to provide various user
information.

• Added a capture to file option in the file menu of RAMP. This allows trace da
to be saved in a file in addition to being displayed in the trace window. A
capture button is added to the software distribution configuration window t
capture the contents of the RAMP software distribution observation windo

• Added the RAMP Software Distribution Script File Editor. This tool is used
edit and create SWD files, listing software and datafill files for transfer, for u
with RAMP software distribution.

• Added the ability to change the detail level of the information displayed in t
RAMP Software Distribution window during a software distribution.

• Added a Select All Positions command button to the Define Software
Distribution Configurations dialog box to select and highlight all positions
listed in the Available Positions list box.

• Added the ability to edit and view SCRPTINI.INI, XCORGXSC.TBL,
XCT4QXSC.TBL, and SCRPTLNG.LNG files with the provisioning tool.

• Addition of theEdit  andClear Memo keys to the KeyBind utility.

15.13  Release 5.0 revisions

• Not applicable. This is the first release of this document.
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16.0  List of terms

AMA
See automatic message accounting.

American Standard Code for Information Interchange (ASCII)
The widely used coding method used by small computers to convert letters,
numbers, punctuation, and control codes into digital format. There are 128 defi
ASCII characters.

API
See application programmer’s interface.

ASCII
See American Standard Code for Information Interchange

application programmer’s interface (API)
A layer of TOPS IWS base software that provides an open interface enabling
applications from different vendors to communicate with system software.

automatic message accounting (AMA)
An automatic recording system that documents all the necessary billing data 
subscriber-dialed long distance calls.

BSY
See busy.

Busy (BSY)
The message BSY is sent to the DMS switch to indicate that the operator pos
is not accepting calls.

calling card database (CCDB)
A database that stores cardholder profiles for an enhanced calling card. Inform
from the CCDB determines whether restrictions apply to an enhanced calling
call, and it can help detect potentially fraudulent calls.

call type for queueing (CT4Q)
Part of a system for organizing and assigning call queues. Instead of mappin
origination types directly to a call queue, table QMSTOPS provides a CT4Q. 
series of tables then refine the CT4Qs to allow the traffic office to divide incom
traffic into separately manageable categories based on different call attribute
according to office-specific criteria.

CBSY
See C-side busy.

CCDB
See calling card database.

C-side busy (CBSY)
The message CBSY displays on the MAP when a file transfer occurs through
DMS gateways at the same time, with no operator logged on. This busy cond
generates alarms on the MAP display of the DMS switch.

CT4Q
See call type for queueing.
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Digital Multiplex System (DMS)
A central office switching system in which all external signals are converted to
digital data and stored in assigned time slots. Switching is performed by reassig
the original time slots.

Disk Operating System (DOS)
An operating system for computer systems that use disks and diskettes for aux
storage of programs and data.

DMS
See Digital Multiplex System.

domain name system (DNS)
The name and address used by the internet. The IWS positions are identified by
IP address separated by “x” (for example, 47x142x225x217). The DNS could
be “www.nortelnetworks.com.”

DNS
See domain name system.

DOS
See Disk Operating System.

ECC
See enhanced calling card.

enhanced calling card (ECC)
A calling card that can be datafilled to provide customers easy access to a varie
card services, including speed dialing, sequence dialing, message delivery, a
others, fully automated, with operator backup available.

file transfer protocol (FTP)
A protocol used to transfer files, such as load files and patch files, across the
Ethernet local area network facility.

FTP
See file transfer protocol.

gateway (GTWY)
In the time division multiplexing (TDM) configuration of IWS only, the DMS
gateway position provides the data connection between the DMS switch and 
other positions in the cluster. The Internet Protocol (IP) configuration does not
gateway positions.

graphical user interface (GUI)
Hardware and software that allows an operator to interact with and perform act
at a TOPS IWS position.

GTWY
See gateway.

GUI
See graphical user interface.

HMI
See human machine interface.
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human machine interface (HMI)
Hardware and software that allows an operator to interact with and perform act
at a TOPS IWS position.

Intelligent Workstation (IWS)
The Nortel Networks programmable operator workstation for traditional and n
traditional operator services.

Internet Protocol (IP)
Along with Transmission Control protocol (TCP), one of the two main parts of t
TCP/IP protocol suite. IP enables information to be routed from one network 
another. It is used in the public internet and in private intranets.

IP
See Internet Protocol.

IP address
A unique numeric address used by a computer on a TCP/IP network (for exam
48.192.008.012).

IWS
See Intelligent Workstation.

LAN
See local area network.

LIDB
See line information database.

line information database (LIDB)
An external database developed by the Bell operating companies and used fo
validating alternate billing requests and potentially used for other applications
must reference an external database, such as originating line number screen

local areal network (LAN)
A network that permits the interconnection and intercommunication of multipl
computers, primarily for the sharing of resources such as data storage device
printers.

maintenance and administration position (MAP)
A group of components that provide a user interface between operating comp
personnel and the DMS-100 Family of switches. A MAP consists of a visual disp
unit and keyboard, a voice communications module, test facilities, and MAP
furniture.

MAP
See maintenance and administration position.

Nortel Networks Directory Assistance (NTDA)
The TOPS IWS application that supports operators who provide telephone num
and intercept services for subscribers.

NTDA
See Nortel Directory Assistance Application.
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OIA
See Open Information Access.

Open Information Access (OIA)
The TOPS IWS application that provides reference data such as emergency nu
information, rate and route information, phraseology, and city name through a
external database. The IP configuration of IWS does not support the OIA
application.

open position protocol (OPP)
The procedures required for communication between the DMS switch and the
TOPS IWS position.

OPP
See open position protocol.

personal computer (PC)
A workstation that has computational capability and that can be programmed
perform user-determined functions.

PC
See personal computer.

personal identification number (PIN)
A unique identifier specific to a particular user.

PIN
See personal identification number.

RAMP
See remote access maintenance position.

remote access maintenance position (RAMP)
A TOPS IWS position on a token ring or Ethernet LAN that allows support
personnel to update all other positions on the same ring.

software distribution (SWD)
Software distribution.

special (SPL)
A a third-party or credit card number.

service provider identification (SPID)
The actual operating company of the subscriber, which may be different from
trunk group.

SPID
See service provider identification.

SPL
See special.

SWD
See software distribution.

TCP
See Transfer Control Protocol.
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TOPS
See Traffic Operator Position System.

TOPS position controller (TPC)
A control unit that functions as an operator position-based microcomputer wit
networking capabilities.

TPC
See TOPS position controller.

Traffic Operator Position System (TOPS)
A call processing system made up of a number of operator positions, each
consisting of a monitor, a controller, a keyboard, and a headset.

Traffic Operator Position System Intelligent Workstation (TOPS IWS)
A personal computer consisting of a controller, a video display, keyboard, hea
jack, and software for monitoring call details and entering routing and billing
information for operator assistance, directory assistance, and intercept calls.

Transfer Control Protocol (TCP)
A connection-oriented protocol that is part of the TCP/IP suite of protocols. T
adds reliability through sequencing, timeouts, and retransmissions. It provide
acknowledgments and checks for missing, out-of-sequence, and duplicated pa
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nonregistering100

registering98
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configuration
increased multiplex (IMUX)116

on-ring RAMP16

provisioning tool92

remote LAN17

standalone RAMP16

standard (STD)116

connection
new site definitions22

customized datafill files62

D
database gateway69

DB Timer172

F
file transfer preparation52

file transfer process69

files
archive37

ASCII 37

AUTOEXEC.BAT 174

CLNTTCPI.INI 127

HOSTS118, 120, 121

initialization (.INI) 15

key action description156

KEYBIND.EXE 153

language (.LNG)15

logs37, 38, 39

menus39

message35

MOUSEINS.BAT174

MPXINI.INI 160, 161, 173

MPXLOGS.ARC37

MPXLOGS.DAT37, 39

MPXNET.INI 21, 28, 38, 115, 119

MPXPARM.INI 105

MPXTOP.INI 138

NTOAINI.INI 127, 133

SCRPTINI.INI121

SCRSINI.INI174

SWD 18

table (.TBL)15

text (.TXT) 39

TOPSPARM115

transfer of24, 35, 45

XAPPL.TBL 153

XCT4QMNU.TBL 140, 147, 153

XDBCOMP.TBL 134

XFNCTS.TBL140, 144, 153, 173

XKBOARD.TBL 153, 155, 156, 157, 159, 161,
173

XKEYMAC.TBL 162

XOGTMENU.TBL 153

XSERVS.TBL153

XTROUBLE.TBL 153

G
gateway

definition28

DMS 102

I
IP Audio Device command button105

IP Positions119

K
keyboard

customize155

datafill 15, 153, 155, 165

PC keyboard layout18

scan codes153

keys
actions158

Alt+Alt 157

Alt+Esc18

Alt+F6 157, 161

Alt+Tab 17

Caps Lock157

Ctrl+Alt+Delete174
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Ctrl+Ctrl 157

Ctrl+Esc174, 175

Ctrl,Tab34

modifier157

Shift+F10157, 161

Shift+Shift 157

L
logs

central collection point37

count field29

destination116

display26

format37

log count field29

remote information15

tracing tool37

M
manual file updates52

messages
application audit131

inconsistent trigger132

stored35

trace33

trigger132

Microsoft Windows15, 18, 23, 31, 39, 45, 83,
153

Explorer173

MPXNET IP Maintenance120

N
networks

addressing scheme118

commercial router17

TCP/IP118

P
ping function63

pinging25, 28, 29

S
scan codes153

software distribution examples52

sound option25

subnet mask69

U
upgrading positions from RAMP62

W
windows

KeyBind 154

logs25

menu26

observation26, 29, 37, 38

refresh option26

software distribution59

software distribution status59

status25, 26, 27

trace26
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	12.3 Configuring the provisioning tool
	1. Select Run in the main menu bar of the provisioning tool.
	Figure�53. “Run menu with PROVTOOL.INI option.”
	FIGURE 53. Run menu with PROVTOOL.INI option
	2. Select PROVTOOL.INI. (See Figure�54.)
	FIGURE 54. Edit window for PROVTOOL.INI file

	3. In the edit window, make desired changes such as adding or removing program files. For example...
	FIGURE 55. Example of modified PROVTOOL.INI file

	4. When you are done with changes, select File, then select Save.
	5. To exit from the edit window, select File, then select Exit.
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	13.0 Using the provisioning tool to datafill files
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	3. Select MPXINI. (See Figure�56.)
	FIGURE 56. Example of MPXINI.INI configuration window

	4. Select the desired command buttons in the configuration window. The following sections describ...
	5. When you are done with the command buttons and want to save the values and settings specified,...
	6. To close the configuration window, select Close from the File menu.

	13.1.1 Datafill Path command button
	1. In the configuration window, select Datafill Path. (See Figure�57.)
	FIGURE 57. Select Default Datafill Directory dialog box
	2. Select the desired path.
	3. Select OK. Optionally, you can select Cancel to leave the dialog box without entering or savin...


	13.1.2 Registering command button
	1. In the configuration window, select Register. The Registering Applications dialog box displays...
	FIGURE 58. Example of Registering Applications dialog box
	2. Select Assign to assign a registering application to the MPXINI file.
	3. Select Remove to remove any unwanted registering applications.
	4. Select View Nonregistering Applications to see what nonregistering applications have been assi...
	5. Select Add Parameters to add any necessary command line parameters to a selected application. ...
	FIGURE 59. Example of Command Line Parameters dialog box

	6. When you return to the Registering Application dialog box, you can select OK to keep the entry...


	13.1.3 Nonregistering command button
	1. In the configuration window, select Nonregistering. (See Figure�60.)
	FIGURE 60. Example of nonregistering applications dialog box for TDM positions
	FIGURE 61. Example of nonregistering applications dialog box for IP positions
	2. Select Assign to assign a nonregistering application to the MPXINI file.
	3. Select Remove to remove any unwanted nonregistering applications.
	4. Select View Registering to view the registering applications.
	5. Select Add Parameters to add command lines to a selected application.
	6. Select Make DMS Gateway to add the necessary applications for the DMS gateway automatically.
	7. Select Make RAMP Position to add the necessary applications for the remote access maintenance ...
	8. When all changes are made, you can select OK to keep the changes and close the dialog box. Alt...


	13.1.4 Time-Outs command button
	1. In the configuration window, select Time Outs. (See Figure�62.)
	FIGURE 62. Example of Time-Out Values dialog box
	2. In this dialog box, specify a timeout value for server, application, and logon respectively.
	3. When all changes are made, select OK to keep the changes and close the dialog box. Alternative...


	13.1.5 Debug command button
	1. In the configuration window, select Debug.
	FIGURE 63. Example Debug Options dialog box
	2. Select the desired options.
	3. You can select OK to keep the settings and close the dialog box. Alternatively, select Cancel ...


	13.1.6 Audio Device command button
	13.1.6.1 TDM Audio Device command button
	1. In the configuration window, select Audio Card. (See Figure�64.)
	FIGURE 64. Example of the Audio Device dialog box for TDM positions
	2. Select the desired options. Detailed information about each option is provided in TOPS IWS Bas...
	3. You can select OK to keep the settings and close the dialog box. Alternatively, select Cancel ...


	13.1.6.2 IP Audio Device command button
	1. In the configuration window, select the Headset Installed in USB port checkbox. The default wi...
	FIGURE 65. Example of the Audio Device dialog box for IP positions
	2. The Headset Volume will reset at 7, but it has a range of 1 to 12.
	3. The Headset Model EQ Preset will reset at 4, but it has a range of 0 to 6.
	4. The Headset Sidetone will reset at 4, but it has a range of 0 to 5.
	5. You can select OK to keep the settings and close the dialog box. Alternatively, select Cancel ...




	13.2 MPXPARM provisioning
	1. From the top menu bar of the provisioning tool window, select File.
	2. From the File menu, select New or Open.
	3. Select MPXPARM. (See Figure�66.)
	FIGURE 66. Example of the MPXPARM configuration window

	4. Select the desired command buttons in the configuration window. The following sections describ...
	5. When you are done with the command buttons and want to save the values and settings specified,...
	6. To close the configuration window, select Close from the File menu.

	13.2.1 Currency command button
	1. In the configuration window, select Currency. (See Figure�67.)
	FIGURE 67. Example of Currency dialog box
	2. To select the placement for the currency symbol, select the down arrow button and a placement ...
	3. To select the decimal digits, select the down arrow button and the number of digits you want f...
	4. To enter the currency symbol of your choice, type the symbol in the Symbol box. Up to five cha...
	5. To enter the separator of your choice, type the separator in the Separator box. Only one chara...
	6. Select OK to keep the settings and close the dialog box. The settings are saved when you selec...


	13.2.2 Number Format command button
	1. In the configuration window, select Number Format. (See Figure�68.)
	FIGURE 68. Example of Number Format dialog box
	2. Enter a character in the Separator box. Any ASCII character is acceptable.
	3. Select OK to close the dialog box. The entry will be saved when you select Save from the File ...


	13.2.3 Charge Indicator command button
	1. In the configuration window, select Charge Indicator. (See Figure�69.)
	FIGURE 69. Example of Charge Adjust Indicators dialog box
	2. To set the indicator for minutes, enter an upper-case ASCII character in the Minutes box.
	3. To set the indicator for money, enter an upper-case ASCII character in the Money box.
	4. To set the indicator for occurrences (number of calls credited), enter an upper-case ASCII cha...
	5. Select OK to close the dialog box. The entries are saved when you select Save from the File me...


	13.2.4 Char Translate command button
	1. In the configuration window, select Character Translation. (See Figure�70.)
	FIGURE 70. Example of Character Translation dialog box
	2. Select the Translate checkbox.
	3. Select OK to close the dialog box. The setting is saved when you select Save from the File men...


	13.2.5 Time-Outs command button
	1. In the configuration window, select Time Outs. (See Figure�71.)
	FIGURE 71. Example of Time-Out Values dialog box
	2. Select the button in the scroll bar and slide it left or right to set the time-out value in se...
	3. Select OK to close the dialog box. The setting is saved when you select Save from the File men...


	13.2.6 Text Flashing command button
	1. In the configuration window, select Text Flashing. (See Figure�72.)
	.
	FIGURE 72. Example of Enable Text Flashing dialog box
	2. Select the Enable Text Flashing checkbox.
	3. Select OK to close the dialog box. The setting is saved when you select Save from the File men...



	13.2.7 Colorblind Support command button
	1. In the configuration window, select Colorblind Support. (See Figure�73.)
	FIGURE 73. Example of Enable Colorblind Support dialog box
	2. Select the Enable Colorblind Support check box.
	3. To set colorblind normal text color, select the Set Normal Text Color button. (See Figure�74.)
	FIGURE 74. Set Normal Text Color dialog box

	4. Select the button in each scroll bar and slide it left or right to set the value for each colo...
	5. Select OK to keep the settings and close the dialog box. Alternatively, select Cancel to leave...
	6. To set alert text color, select the Set Alert Text Color button. (See Figure�75.)
	FIGURE 75. Set Alert Text Color dialog box

	7. Select the button in each scroll bar and slide it left or right to set the value for each colo...
	8. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...
	9. To set Error Text Color, select the Set Error Text Color button. (See Figure�76.)
	FIGURE 76. Set Error Text Color dialog box

	10. Select the button in each scroll bar and slide it left or right to set the value for each col...
	11. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave th...
	12. In the Enable Colorblind Support dialog box, select OK to keep the settings for normal, alert...


	13.2.8 Clock and Call Timer command button
	1. In the configuration window, select Clock and Call Timer. (See Figure�77.)
	FIGURE 77. Clock and Call Timer dialog box
	2. To enable the clock display, select the Clock Display check box.
	3. Select the button in the scroll bar and slide it left or right to make adjustments to the time...
	4. To enable the call timer display, select the Call Timer Display check box.
	5. Select OK. The settings are saved when you select Save from the File menu in the Provisioning ...


	13.2.9 Simultaneous Display of Trunk Group/SPID command button
	1. In the configuration window, select Trunk Group/SPID. (See Figure�78.)
	FIGURE 78. Trunk Group/SPID dialog box
	2. To enable simultaneous display of trunk group and SPID, select Display both Trunk Group and SPID.
	3. In the Display Priority box, select either Trunk Group or SPID. If Trunk Group is selected, Tr...
	4. Select OK. The settings are saved when you select Save from the File menu in the Provisioning ...



	13.3 MPXNET provisioning
	13.3.1 TDM positions - MPXNET
	1. From the top menu bar of the Provisioning Tool window, select File.
	2. From the File menu, select New or Open.
	3. Select MPXNET. (See Figure�79.)
	FIGURE 79. MPXNET configuration window

	4. In the PVC Layout Type box, select one of the following listings: STD4, IMUX4, IMUX16, or IMUX20.
	5. To check a position for its assigned cluster, select the Check Positions option in the Positio...
	6. To assign an on-ring RAMP, select the down arrow button at the On-ring RAMP Position box. Then...
	7. To define the layout of each cluster of operator positions, select Cluster Layout. (See Figure...
	FIGURE 80. Example of MPXNET STD4/IMUX4 dialog box
	FIGURE 81. Example of MPXNET IMUX16 dialog box

	a. To assign a position to a host name, select the radio button next to the position, then select...
	b. To clear a host name from a position, select the radio button next to the position, then selec...
	c. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...
	4. When you return to the MPXNET configuration window, you can save the settings by selecting Sav...


	13.3.2 IP Positions - MPXNET
	1. From the top menu bar of the Provisioning Tool window, select File.
	2. From the File menu, select New or Open.
	3. Select MPXNET. (See Figure�82.)
	FIGURE 82. MPXNET IP configuration window

	4. In the DMS section, enter a valid node name from the HOSTS file that specifies the IP address ...
	5. To define the layout of each cluster of operator positions, select MtcCluster Layout. (See Fig...
	FIGURE 83. Example of MPXNET IP Maintenance dialog box

	a. To assign a position to a host name, select the radio button next to the position, then select...
	b. To clear a host name from a position, select the radio button next to the position, then selec...
	c. The IPMtcSrv specifies the RAMP position that maintains this IP position.
	4. When you return to the MPXNET configuration window, you can save the settings by selecting Sav...



	13.4 SCRPTINI provisioning
	1. From the top menu bar of the Provisioning Tool window, select File.
	2. To edit a pre-existing SCRPTINI.INI file, select “Open”. A Windows “Open” dialog box displays....
	3. By default, parameters that relate to enhanced scripting are grayed out. (See Figure�84.)
	FIGURE 84. SCRPTINI configuration window for standard scripting
	FIGURE 85. SCRPTINI configuration window for enhanced scripting

	4. To configure the scripting parameters that pertain to a particular application, select the dow...
	5. Select Edit to edit the scripting settings for an existing application. (See Figure�86.)
	FIGURE 86. Example of the Edit Application window with NTOA (IWS Billing application) selected

	6. Select the Enable Scripting checkbox if you want automatic display of the scripting window whe...
	7. In the Window Position and Size section, you can change the values for the X and Y coordinates...
	8. If NTOA (IWS Billing) is the selected application, you can select the GiveScrptFocusOnArrival ...
	9. If either the NTDA or NTOA application is selected as the application name, and if enhanced sc...
	FIGURE 87. Example of error window when duplicates occur

	10. Select OK on “Edit Application” window to close the window and keep the current settings. Alt...

	1. Enter the desired application name in the Application Name box. The application name can conta...
	FIGURE 88. Example of the SCRPTINI New Application window
	2. Follow the steps for the Edit Application procedure (page�123) to customize the scripting sett...
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...

	1. Select an application in the Applications list box in the configuration window.
	2. Select Remove.
	3. Select Yes to confirm the deletion. The selected application section is removed from the SCRPT...
	4. When you are done with the command buttons in the configuration window and want to save the se...
	5. To close the configuration window, select Close from the File menu.


	13.5 CLNTTCPI provisioning
	13.6 NTOAINI provisioning
	1. From the top menu bar of the Provisioning Tool window, select File.
	2. From the File menu, select New or Open.
	3. If Open is selected, the Open dialog box displays. If New is selected, a list of files displays.
	4. Select NTOAINI. (See Figure�89.)
	FIGURE 89. Example of NTOAINI configuration window

	5. Select the desired command buttons in the configuration window. The following sections describ...
	6. When you are done with the command buttons and want to save the values and settings specified,...
	7. To close the configuration window, select Close from the File menu.
	8. A message box displays to prompt you to save before closing the window.

	13.6.1 Timezone Offset command button
	1. To make timezone adjustments, select Timezone Offset in the configuration window. (See Figure�...
	FIGURE 90. Example of Timezone Offset dialog box
	2. In the Offset entry box, enter a number in the range of +/-24 hours.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.2 Card Format command button
	1. To set the number of digits between each separator in a card number, select Card Format in the...
	FIGURE 91. Example of Card Format dialog box
	2. In the Format entry box, enter the number of digits you want to display between each separator.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.3 Application Audit Timeout command button
	1. To set the number of seconds the IWS Billing application waits for an audit response from the ...
	FIGURE 92. Example of Application Audit Timeout dialog box
	2. In the Audit Timeout entry box, enter a value.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.4 DB Timer command button
	1. To set the number of seconds the IWS Billing application waits for a response to an operator q...
	FIGURE 93. Example of DB Timer dialog box
	2. In the DB Timer entry box, enter a value between 1–65.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.5 Audit Heartbeat command button
	1. To set the number of seconds the datalink (a component in the IWS Billing application) waits f...
	FIGURE 94. Example of Audit Heartbeat dialog box
	2. In the Audit Heartbeat entry box, enter a value between 0–65.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.6 LIDB Query Fail Flag command button
	1. To block or unblock a call or to send custom AMA when a domestic call is completed, select LID...
	FIGURE 95. Example of LIDB Query Fail Flag dialog box
	2. Check or uncheck the Query Flag checkbox.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.7 App Audit Interval command button
	1. To set the number of seconds between each Application Audit message sent to the CCDB, select A...
	FIGURE 96. Example of Application Audit Interval dialog box
	2. In the AuditInterval entry box, enter a value between 1–65.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.8 DirNum Connect command button
	1. To connect to a directory number automatically upon pressing the Start key, select DirNum Conn...
	FIGURE 97. Example of Directory Number Connect dialog box
	2. Check or uncheck the DirNumConnect checkbox.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.9 CCDB Query Fail Flag command button
	1. Select CCDB Query Fail Flag in the configuration window to do any of the above. (See Figure�98.)
	FIGURE 98. Example of CCDB Query Fail Flag dialog box
	2. Check or uncheck the Query Flag checkbox.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.10 Enable Triggers command button
	1. To send trigger messages to the DMS switch, select Enable Triggers in the configuration window...
	FIGURE 99. Example of Enable Triggers dialog box
	2. Check or uncheck the Enable Triggers checkbox.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.11 DB Connected command button
	1. To connect to or disconnect from the CCDB or the Intelligent Service Node Provisioning System ...
	FIGURE 100. Example of DB Connected dialog box
	2. Select one of the following four options in the dialog box:
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.12 Default Language command button
	1. To choose a default language, select Default Language in the configuration window. (See Figure...
	FIGURE 101. Example of Default Language dialog box
	2. In the dialog box, enter a value (from 0–99) in the entry box or slide the scroll button to se...
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.13 Encrypt Method command button
	1. To choose an encryption method for the enhanced calling card PIN, select Encrypt Method in the...
	FIGURE 102. Example of Encrypt Method dialog box
	2. In the dialog box, select either no PIN encryption or one of the encryption methods.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.14 Custom AMA Layout command button
	1. To select a custom AMA layout when the record is sent to the DMS switch, select Custom AMA Lay...
	FIGURE 103. Example of Custom AMA Layout dialog box
	2. In the dialog box, select one of the AMA layout options.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.15 Acct Code Min Digits command button
	1. To select the minimum number of digits in the account code, select Acct Code Min Digits in the...
	FIGURE 104. Example of Account Code Minimum Digits dialog box
	2. In the dialog box, enter a value in the entry box or move the scroll button to select a value ...
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.16 Account Code Max Digits command button
	1. To select the maximum number of digits in the account code, select Acct Code Max Digits in the...
	FIGURE 105. Example of Account Code Maximum Digits dialog box
	2. In the dialog box, enter a value in the entry box or move the scroll button to select a value ...
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.17 Num PIN Code Digits command button
	1. To select the maximum number of digits a valid PIN number can contain, select Num PIN Code Dig...
	FIGURE 106. Example of Number of PIN Code Digits dialog box
	2. In the dialog box, enter a value in the entry box or move the scroll button to select a value ...
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.18 ECC Context Revision command button
	1. To select a revision level for an enhanced calling card (ECC) context block to be created by t...
	FIGURE 107. Example of ECC Context Revision dialog box
	2. In the dialog box, select the revision level of either version 1 or 5.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.6.19 SPL Field Editing command button
	1. To allow editing in the special field when you press the Edit key, select SPL Field Editing in...
	FIGURE 108. Example of Special Field Editing dialog box
	2. In this dialog box, check the SPL Field Editing checkbox.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...



	13.7 MPXTOP provisioning
	1. From the top menu bar of the Provisioning Tool window, select File.
	2. Select MPXTOP. (See Figure�109.)
	FIGURE 109. Example of the MPXTOP configuration window

	3. Select the NTOA Service Number 16 button to enter primary and secondary IP address information...
	FIGURE 110. Example of the NTOA Service Number 16 dialog box (for IWS Billing)

	4. In the dialog box, enter the IP address (valid range is 0 to 255.255.255.255), port number (va...
	5. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.8 Datafilling table files
	1. From the top menu bar of the Provisioning Tool window, select File.
	2. From the File menu, select New or Open.
	3. If you chose Open, select Table File (*.tbl). in the List files of type box. If you chose New,...
	4. Select a file from the listing; for example, file XAltRte. (See Figure�111.)
	FIGURE 111. Example of a table file dialog box

	5. To customize the datafill, select the line you wish to change. For example, select the line th...
	FIGURE 112. Example of Edit dialog for a table file

	6. Select or make an entry for each entry box within the valid range indicated.
	7. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...
	8. To add data, select Add to open the Add dialog box. (See Figure�113.)
	FIGURE 113. Example of Add dialog box for a table file

	9. Select or type a value for each entry box within the valid range indicated.
	10. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave th...
	11. To remove data displayed, select the data, then select Remove. A confirmation message displays.
	12. To reset all the data in the file to the settings in place at the last save command, select R...
	FIGURE 114. Example of Help dialog for a table file



	13.9 Datafilling language files
	1. From the top menu bar of the Provisioning Tool window, select File.
	2. From the File menu, select New or Open.
	3. If you chose Open, select Language File (*.lng). in the List files of type box. If you chose N...
	4. Select a file from the listing; for example, file IDLMSA. (See Figure�115.)
	FIGURE 115. Example of language file dialog box

	5. To change the data displayed, select the data. For example, select the line that contains Stri...
	FIGURE 116. Example of Edit dialog box

	6. Select or make an entry for each entry box within the valid range indicated.
	7. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...
	8. To reset all the data in the file to the settings in place at the last save command, select Re...
	FIGURE 117. Example of Help dialog box for a language file



	13.10 Datafilling the XFNCTS table file
	1. From the top menu bar of the Provisioning Tool window, select File.
	2. From the File menu, select New or Open.
	3. If you chose Open, select Table File (*.tbl). in the List files of type box. If you chose New,...
	4. Select file XFNCTS from the listing. (See Figure�118.)
	FIGURE 118. Example of an XFNCTS dialog box

	5. To change data, select the function name to be changed, then select Edit. (See Figure�119.)
	FIGURE 119. Example of Edit dialog box for XFNCTS table file

	6. Select or make an entry for each entry box within the valid range indicated.
	7. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...
	8. To add data, select Add to open the Add dialog box. (See Figure�120.)
	FIGURE 120. Example of Add dialog box for an XFNCTS table file

	9. Select or type a value for each entry box within the valid range indicated.
	10. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave th...
	11. To remove data, select the data, then select Remove. A confirmation message displays.
	12. To relocate data, select the data, then select MoveUp or MoveDown.
	13. To reset all the data in the file to the settings in place at the last save command, select R...


	13.11 Datafilling the XCT4QMNU table file
	1. From the top menu bar of the Provisioning Tool window, select File.
	2. From the File menu, select New or Open.
	3. If you chose Open, select Table File (*.tbl). in the List files of type box. If you chose New,...
	4. A list of table files displays. Select file XCT4QMNU from the listing. The dialog box shown in...
	FIGURE 121. Example of an XCT4QMNU dialog box


	13.11.1 Changing data
	1. Select the CT4Q to be changed, then select Edit. The Edit dialog box displays, as shown in Fig...
	FIGURE 122. Example of Edit dialog box for XCT4QMNU table file
	2. Select or make an entry for each entry box within the valid range indicated.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.11.2 Adding data
	FIGURE 123. Example of XCT4QMNU.TBL file
	FIGURE 124. Example of CT4Q menu
	1. Select Add to open the Add dialog box. (See Figure�125.)
	FIGURE 125. Example of Add dialog box for an XCT4QMNU table file
	2. Select or type a value for each entry box within the valid range indicated.
	3. Select OK to close the window and keep the settings. Alternatively, select Cancel to leave the...


	13.11.3 Removing data
	FIGURE 126. XCT4QMNU.TBL using NIL CT4Q numbers
	FIGURE 127. CT4Q menu

	13.11.4 Relocating data
	13.11.5 Reloading data


	14.0 KeyBind
	14.1 Note for new users of Windows XP Professional
	FIGURE 128. Current and past scan code assignments

	14.2 Selecting an application section
	FIGURE 129. IWS KeyBind window

	14.3 Key set
	14.4 Assigning action to a key
	1. Select a key set.
	2. Select the key action you wish to associate with a physical key.
	3. Select the Add button to open the Assign Key window.
	FIGURE 130. Assign Key window

	4. On the keyboard, press the key you wish to assign to the selected key action. The window close...
	5. To exit from the Assign Key window without assigning an action, select Cancel to return to the...

	14.5 Removing an assigned key action from a key
	1. Select an application section as described in the previous section.
	2. Select the Undefine button.
	FIGURE 131. Undefine Key window

	3. Press the desired key and any combination of the modifier keys Shift, Ctrl, or Alt. The window...
	4. To exit from the Undefine Key window, select Cancel to return to the KeyBind main window.

	14.6 Verifying a key assignment
	1. Select an application section.
	2. Select the Verify button.
	FIGURE 132. Verify Key window

	3. Press the desired key and any combination of the modifier keys (Shift, Ctrl, Alt).
	4. To exit from the Verify Key window, select the Close button to return to the KeyBind main window.

	14.7 File menu options
	14.8 Utilities menu options
	14.8.1 Key macros
	14.8.1.1 Key macro guidelines
	14.8.1.2 Defining a key macro
	FIGURE 133. Key Macros selected in the Utilities menu
	FIGURE 134. Key Macro Configuration Screen
	1. Select an undefined (unnamed) macro from the Macros list box. In the above figure, #5 is the n...
	2. Select the section in which you want to place the key macro from the pulldown list in the Sect...
	3. Select the Macro Keys field and press the keys you wish to include. Alternatively, you can sel...
	4. Select Save. The macro will be listed in the selected empty space in the Macros list box.
	5. Select Done to return to the KeyBind main window, or return to step 1 to add another macro.

	14.8.1.3 Editing an existing key macro
	1. In the Macros list box, select the macro you wish to edit. The macro title and key actions dis...
	2. Use the backspace key to move about in the list of key actions. Each time you press the backsp...
	3. Make your changes, and select Save.

	14.8.1.4 Assigning a key macro

	14.8.2 Add Section
	FIGURE 135. Add Section window
	FIGURE 136. KeyBind add section verification window

	14.8.3 Delete Section
	FIGURE 137. Delete section choice and dialog box

	14.8.4 View Bindings
	FIGURE 138. View key bindings by Scan Code window
	FIGURE 139. View key bindings by key action window


	14.9 View
	14.9.1 Toolbar
	FIGURE 140. Toolbar display toggled on, status bar toggled off

	14.9.2 Status Bar
	FIGURE 141. Status bar display toggled on, toolbar display toggled off


	14.10 Help

	15.0 Revisions
	15.1 Release 17.0/17.1 revisions
	15.2 Release 15.2 revisions
	15.3 Release 15.0 revisions
	15.4 Release 14.0 revisions
	15.5 Release 13.0 revisions
	15.6 Release 12.0 revisions
	15.7 Release 11.0 revisions
	1. If already at the Windows 95 desktop, proceed to step 7. If the IWS base application is runnin...
	2. Use the down arrow key to highlight MPX BASE Application.
	3. Use the Tab key to highlight End Task. Press Enter to close the IWS base application.
	4. If the RAMP application is running, press Ctrl+Alt+Delete to obtain the Close Program window.
	5. Use the down arrow key to highlight Remote Access Maintenance Position.
	6. Use the Tab key to highlight the End Task button and then press Enter to end the RAMP applicat...
	7. To detect new hardware, the mouse must be plugged into the position. If the mouse is not alrea...
	8. Press Ctrl+Esc to open the Start menu.
	9. Select Shut Down by pressing U.
	10. In the Shut Down Windows dialog box, use the arrow keys to select Restart the computer and th...
	11. Upon restart, the IWS base application is running. Press Ctrl+Alt+Delete to obtain the Close ...
	12. Use the down arrow key to highlight MPX BASE Application.
	13. Use the Tab key to highlight End Task. Press Enter to close the IWS base application.
	14. Press Ctrl+Esc to open the Start menu.
	15. Select Run from the Start menu by pressing R.
	16. At the Open text box, type:
	17. Press Enter. The Finished–mouseins dialog box will appear. Ignore it and proceed to the next ...
	18. Modify the C:\AUTOEXEC.BAT file. Press Ctrl+Esc to open the Start menu.
	19. Select Program from the Start menu by pressing P.
	20. Use the arrow keys to select MS-DOS Prompt from the Program menu. Press Enter.
	21. From the C:\WINDOWS prompt type:
	22. Press Enter. In the AUTOEXEC.BAT file, locate the line that says “rem MOUSEON=1.” Remove “rem...
	23. Press ALT+F, then press X to exit the editor. A Save File dialog box will appear. To save the...
	24. Type EXIT to close the DOS shell window.
	25. Press Ctrl+Esc to open the Start menu.
	26. Select Settings from the Start menu by pressing S.
	27. Select Control Panel from the Settings menu by pressing C.
	28. Use the arrow keys to select Add New Hardware. Press Enter.
	29. The Add New Hardware Wizard will now run. Press Enter to continue.
	30. To allow the Wizard to search for new hardware, select Yes (Recommended) by pressing Y. Then ...
	31. At the next window, press Enter to continue with the new hardware detection. The Wizard now w...
	32. After Windows has finished detecting new hardware, press D to see what new hardware component...
	33. Tab to the Finish button and press Enter.
	34. The Windows mouse drivers will then be automatically installed. When complete, a System Setti...

	15.8 Release 10.0 revisions
	15.9 Release 9.0 revisions
	15.10 Release 8.0 revisions
	15.11 Release 7.0 revisions
	15.12 Release 6.0 revisions
	15.13 Release 5.0 revisions

	16.0 List of terms
	AMA
	American Standard Code for Information Interchange (ASCII)
	API
	ASCII
	application programmer’s interface (API)
	automatic message accounting (AMA)
	BSY
	Busy (BSY)
	calling card database (CCDB)
	call type for queueing (CT4Q)
	CBSY
	CCDB
	C-side busy (CBSY)
	CT4Q
	Digital Multiplex System (DMS)
	Disk Operating System (DOS)
	DMS
	domain name system (DNS)
	DNS
	DOS
	ECC
	enhanced calling card (ECC)
	file transfer protocol (FTP)
	FTP
	gateway (GTWY)
	graphical user interface (GUI)
	GTWY
	GUI
	HMI
	human machine interface (HMI)
	Intelligent Workstation (IWS)
	Internet Protocol (IP)
	IP
	IP address
	IWS
	LAN
	LIDB
	line information database (LIDB)
	local areal network (LAN)
	maintenance and administration position (MAP)
	MAP
	Nortel Networks Directory Assistance (NTDA)
	NTDA
	OIA
	Open Information Access (OIA)
	open position protocol (OPP)
	OPP
	personal computer (PC)
	PC
	personal identification number (PIN)
	PIN
	RAMP
	remote access maintenance position (RAMP)
	software distribution (SWD)
	special (SPL)
	service provider identification (SPID)
	SPID
	SPL
	SWD
	TCP
	TOPS
	TOPS position controller (TPC)
	TPC
	Traffic Operator Position System (TOPS)
	Traffic Operator Position System Intelligent Workstation (TOPS IWS)
	Transfer Control Protocol (TCP)

	17.0 Index
	A
	C
	D
	F
	G
	I
	K
	L
	M
	N
	P
	S
	U
	W



